Copyrights

© 2016, Becton, Dickinson and Company. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in retrieval systems, or translated into any language or computer language, in any form or by any means: electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without prior written permission from BD Biosciences.

The information in this guide is subject to change without notice. BD Biosciences reserves the right to change its products and services at any time to incorporate the latest technological developments. Although this guide has been prepared with every precaution to ensure accuracy, BD Biosciences assumes no liability for any errors or omissions, nor for any damages resulting from the application or use of this information. BD Biosciences welcomes customer input on corrections and suggestions for improvement.

Trademarks

Alexa Fluor® is a registered trademark of Life Technologies Corporation.

Cy™ is a trademark of GE Healthcare. Cy™ dyes are subject to proprietary rights of GE Healthcare and Carnegie Mellon University, and are made and sold under license from GE Healthcare only for research and in vitro diagnostic use. Any other use requires a commercial sublicense from GE Healthcare, 800 Centennial Avenue, Piscataway, NJ 08855-1327, USA.

Trademarks are the property of their respective owners.

© 2016 BD. BD, the BD Logo, and all other trademarks are property of Becton, Dickinson and Company.

Regulatory information

For Research Use Only. Not for use in diagnostic or therapeutic procedures.

Class 1 Laser Product.

FCC information

WARNING: Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

NOTICE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his or her own expense. Shielded cables must be used with this unit to ensure compliance with the Class A FCC limits. This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations. Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Change made</th>
</tr>
</thead>
<tbody>
<tr>
<td>23-18013-00</td>
<td>1/2016</td>
<td>Initial release</td>
</tr>
</tbody>
</table>
## Contents

### Chapter 1: Introduction
- About this guide .................................................. 8
- Additional documentation ........................................ 9
- Safety symbols ...................................................... 10
- Technical support .................................................... 11

### Chapter 2: About the system
- BD Accuri C6 Plus system overview .......................... 14
- BD Accuri C6 Plus cytometer overview ....................... 16
- BD CSampler Plus overview .................................... 24
- BD Accuri C6 Plus software overview ....................... 28

### Chapter 3: Startup and shutdown
- Startup workflow ................................................. 36
- Filling the fluid bottles ........................................... 36
- Emptying the waste bottle ....................................... 39
- Starting up the system ........................................... 41
- Shutting down the system ....................................... 43

### Chapter 4: Quality Control
- QC overview ....................................................... 48
- Running instrument QC .......................................... 49
- Adjusting the bead regions and markers ..................... 53
- Viewing QC results ............................................... 58
<table>
<thead>
<tr>
<th>Chapter 5: Manual data acquisition</th>
<th>67</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect tab</td>
<td>68</td>
</tr>
<tr>
<td>Setting acquisition parameters</td>
<td>72</td>
</tr>
<tr>
<td>Run settings</td>
<td>73</td>
</tr>
<tr>
<td>Fluidics rate</td>
<td>75</td>
</tr>
<tr>
<td>Threshold</td>
<td>79</td>
</tr>
<tr>
<td>Running samples using the Collect tab</td>
<td>81</td>
</tr>
<tr>
<td>Ending a data collection session</td>
<td>84</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6: CSampler Plus data acquisition</th>
<th>87</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Collect tab</td>
<td>88</td>
</tr>
<tr>
<td>Running samples using the Manual Collect tab</td>
<td>93</td>
</tr>
<tr>
<td>Auto Collect tab</td>
<td>99</td>
</tr>
<tr>
<td>Creating sample sets for Auto Collect experiments</td>
<td>103</td>
</tr>
<tr>
<td>Setting parameters for Auto Collect experiments</td>
<td>106</td>
</tr>
<tr>
<td>Running samples using the Auto Collect tab</td>
<td>112</td>
</tr>
<tr>
<td>Ending a data acquisition session</td>
<td>117</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7: Data analysis</th>
<th>119</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyzing sample data</td>
<td>120</td>
</tr>
<tr>
<td>Setting up analysis plots</td>
<td>124</td>
</tr>
<tr>
<td>Creating an overlay histogram</td>
<td>127</td>
</tr>
<tr>
<td>Statistics tab</td>
<td>130</td>
</tr>
<tr>
<td>Previewing a plot in the Statistics tab</td>
<td>132</td>
</tr>
<tr>
<td>Adjusting peak position with VirtualGain</td>
<td>134</td>
</tr>
<tr>
<td>Copying analysis data into other applications</td>
<td>142</td>
</tr>
<tr>
<td>Analyzing batches of samples</td>
<td>142</td>
</tr>
<tr>
<td>Compensation</td>
<td>146</td>
</tr>
</tbody>
</table>
## Chapter 8: Plots and gates
155
- Plots and gates ........................................... 156
- Creating a new plot .................................... 157
- Creating and applying gates .......................... 160
- Creating nested gates .................................. 167
- Modifying regions ....................................... 171
- Modifying plots ......................................... 175
- Zooming a plot .......................................... 179
- Copying and printing plot data ......................... 181

## Chapter 9: Managing data
183
- Managing files .......................................... 184
- Workspace files ........................................ 186
- Creating a workspace template ....................... 189
- Exporting and importing data ......................... 190

## Chapter 10: Maintenance
193
- Maintenance schedule .................................. 194
- Cleaning the outside of the instrument ............... 196
- Backflushing the SIP ................................... 197
- Performing a SIP clean ................................ 198
- Cleaning the fluidics .................................... 200
- Running an extended flow cell clean ................... 200
- Cleaning the fluid bottles .............................. 202
- Replacing the fluid bottle filters ....................... 203
- Replacing the in-line sheath filter ..................... 204
- Replacing the peristaltic pump tubing ................. 206
- Purging the fluid sensor lines ......................... 209
- Unclogging the SIP ..................................... 211
- Collecting precise volume measurements ............ 214
- Aligning the CSampler Plus after a collision ....... 217
Chapter 11: Troubleshooting

- Troubleshooting overview
- Hardware troubleshooting
- Software troubleshooting
- Acquisition troubleshooting
- QC troubleshooting

Chapter 12: Selectable Lasers Module

- Selectable lasers
- Annotating selected laser configuration
- Optical filter placement
- Selectable laser application examples

Chapter 13: User Tracking Module

- Tracking user activity
- Managing user accounts
- Monitoring user activity

Chapter 14: Remote Interfacing Module

- Remote Interfacing
- Implemented commands
- Example usage of remote interfacing commands

Chapter 15: FCS keywords

- FCS keywords

Chapter 16: Technical specifications

- System specifications

Index
1

Introduction

This chapter covers the following topics:

- About this guide (page 8)
- Additional documentation (page 9)
- Safety symbols (page 10)
- Technical support (page 11)
### About this guide

**Introduction**  
This topic describes the information that is available in this guide.

**In this guide**  
This guide provides information for setting up and running the BD Accuri\textsuperscript{TM} C6 Plus system during a typical workflow, whether you are acquiring samples manually or using a BD CSampler\textsuperscript{TM} Plus accessory.

The guide includes:

- An overview of the BD Accuri C6 Plus system
- Introductory information about system hardware and components
- Instructions on setting up and maintaining the system
- Instructions on performing daily instrument QC
- Information about BD Accuri C6 Plus software and BD CSampler Plus software features, and how to use the software to set up and run the cytometer
- Instructions on acquiring samples, with and without a BD CSampler Plus
- Information on analyzing data using the software
Additional documentation

Introduction
This topic describes additional documentation available for the BD Accuri C6 Plus system.

Documents
The following table lists the available documents for the BD Accuri C6 Plus system.

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BD Accuri™ C6 Plus System Site Preparation Guide</strong></td>
<td>Provides the site requirements. Read this guide before the system is installed.</td>
</tr>
<tr>
<td><strong>BD Accuri™ C6 Plus System Safety and Limitations Guide</strong></td>
<td>Provides safety guidance and system limitations. Read this guide before running the system.</td>
</tr>
<tr>
<td><strong>BD™ CS&amp;T RUO Beads data sheet</strong></td>
<td>Provides instructions on preparing the BD CS&amp;T RUO beads for quality control.</td>
</tr>
<tr>
<td><strong>BD Accuri™ C6 Plus Compensation Calculator</strong></td>
<td>A Microsoft Excel® file that provides instructions on calculating compensation values for any four-color experiment.</td>
</tr>
</tbody>
</table>

More information
- About this guide (page 8)
- Safety symbols (page 10)
- Technical support (page 11)
Safety symbols

Introduction

This topic describes the safety symbols used in this guide. For a complete description of all safety hazards, see the BD Accuri C6 Plus System Safety and Limitations Guide.

Safety symbols

The following table describes the symbols used in this guide.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Caution. Indicates the need for the user to consult the system user’s guide for important cautionary information such as warnings and precautions that cannot, for a variety of reasons, be presented on the device itself.</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Biological hazard</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Electrical hazard</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Laser hazard</td>
</tr>
</tbody>
</table>

More information

- Additional documentation (page 9)
## Technical support

### Introduction

This section describes how to get technical support.

### Contacting BD technical support

To contact BD technical support:

If assistance is required, contact your local BD Biosciences technical support representative or supplier. Visit our website, bdbiosciences.com, for up-to-date contact information.

When contacting BD Biosciences, have the following information available:

- Product name, part number, and serial number
- Software application and version number
- Any error messages
- Details of recent system performance

### Contacting Dell™ technical support

To contact Dell technical support:

If you purchased the Dell computer through BD Biosciences, it comes with a 3-year warranty. For technical assistance with your Dell computer, visit www.dell.com/supportcontacts/.

When contacting Dell, have the following information available:

- Your name and contact information
- Service tag number
- Summary of the problem
- Troubleshooting steps taken
- Any error codes from diagnostics
- System location

### More information

- About this guide (page 8)
About the system

This chapter covers the following topics:

- BD Accuri C6 Plus system overview (page 14)
- BD Accuri C6 Plus cytometer overview (page 16)
- BD CSampler Plus overview (page 24)
- BD Accuri C6 Plus software overview (page 28)
BD Accuri C6 Plus system overview

Introduction
This topic describes the BD Accuri C6 Plus system and components.

C6 Plus system
The C6 Plus system includes the BD Accuri C6 Plus flow cytometer, an all-in-one desktop workstation running BD Accuri C6 Plus software (or BD CSampler Plus software) for acquisition and analysis, and the optional BD CSampler Plus. The system also includes BD™ CS&T RUO beads for instrument QC. An optional barcode reader can be attached to a USB port on the computer.

C6 Plus cytometer
The two-laser, six-parameter flow cytometer is composed of fluidics, optics, and electronics systems.

- The fluidics system consists of peristaltic pumps providing a non-pressurized, “push/pull” fluid system.
- Clustered in a pie configuration around the flow cell, the optical detectors maximize light collection.
- The electronics system provides up to 7 decades of dynamic range, allowing for fixed detector voltages.
Chapter 2: About the system

Workstation and software
The system comes with a dedicated USB-compatible, all-in-one desktop workstation with keyboard and mouse. The workstation runs BD Accuri C6 Plus software (or BD CSampler Plus software), which is used to control the cytometer, acquire samples, and generate results.

Note: While BD Accuri software is running, the computer will not enter sleep mode. Do not change the power options or force the computer to go to sleep while the software is running.

Reagents
BD CS&T RUO beads are used to check and monitor the cytometer performance. We recommend running instrument QC daily, ensuring that the test passes before running samples.

The BD Accuri C6 Plus system works with many existing reagents and protocols. Use the pre-defined templates with the corresponding reagent kit. Template can be downloaded from bdbiosciences.com. For instructions on preparing samples, see the specific reagent kit package insert or data sheet.

CSampler Plus option
The BD CSampler Plus is an optional accessory that saves you time and effort by automating the sample loading step. Place a 24-tube rack of standard 12 x 75-mm tubes or a 48- or 96-well microplate on the CSampler Plus and select RUN. The CSampler Plus automatically agitates the tubes to keep the cells in suspension, then loads each tube for acquisition. Use the software to program sample injection probe (SIP) cleaning and rinsing during the run.

More information
- BD Accuri C6 Plus cytometer overview (page 16)
- BD Accuri C6 Plus system overview (page 14)
BD Accuri C6 Plus cytometer overview

**Introduction**
This topic describes the cytometer and its major components.

**Main components**
The C6 Plus cytometer is composed of fluidics, optics, and electronics subsystems that work together to analyze cells.

**Outside of cytometer**
The following figures show the front and back of the cytometer and locations of the indicator lights, power button, sample injection probe (SIP), and connectors.

**Front**

---

1.  
2.  
3.  
4.  
5.
The following table describes the components on the front of the cytometer.

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Event indicator</td>
<td>Blinks as events pass in front of the laser. The higher the event rate, the faster it blinks.</td>
</tr>
<tr>
<td>2</td>
<td>Power-on indicator</td>
<td>Illuminates solid blue to indicate that the cytometer is on and ready to use. Blinks during startup and shutdown.</td>
</tr>
<tr>
<td>3</td>
<td>Power button</td>
<td>Used to turn on and off the cytometer.</td>
</tr>
<tr>
<td>4</td>
<td>SIP</td>
<td>Sample injection probe. Used to pull sample from the sample tube to the flow cell.</td>
</tr>
<tr>
<td>5</td>
<td>Sample stage</td>
<td>Used to hold the sample tube in place. Height adjusts to accommodate 12 x 75-mm tubes and BD Trucount™ tubes.</td>
</tr>
</tbody>
</table>
The following table describes the components on the back of the cytometer.

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power connector</td>
<td>Connects the AC power cord to the instrument.</td>
</tr>
<tr>
<td>2</td>
<td>CSampler Plus connector</td>
<td>Used only to connect the BD CSampler Plus.</td>
</tr>
<tr>
<td>3</td>
<td>USB port</td>
<td>Used to connect the computer workstation.</td>
</tr>
</tbody>
</table>
| 4   | Fluidics harness          | Mesh outer tubing that contains fluid lines connecting four fluid bottles to the internal fluidics system. 
|     |                           | Do not disconnect the harness from the back of the instrument.             |
Optical components

The following figure shows the optical components.
The following table describes the optical components.

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Blue laser</td>
<td>488 nm</td>
</tr>
<tr>
<td>2</td>
<td>Red laser</td>
<td>640 nm</td>
</tr>
</tbody>
</table>
| 3   | Optical assembly (four filters surround the flow cell and are outlined in red) | • FL1 533/30 nm  
    |                               | • FL2 585/40 nm  
    |                               | • FL3 >670 nm  
    |                               | • FL4 675/25 nm  |
| 4   | Flow cell (in center of four filters)         | Capillary where the laser intersects the sample stream |

**Fluidics components**

The C6 Plus cytometer is a non-pressurized system. If necessary, any of the bottles can be opened while the cytometer is powered on. However, we recommend waiting to fill the fluid bottles until the instrument is idle.

During operation, the software will notify you if the fluid level for a fluid bottle is getting low or the waste bottle is getting full. Always attend to the fluid bottles when instructed.

The following figure shows the fluidics components. The plastic storage bin located inside the instrument is not shown.
The following table describes the fluidics components.

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sheath bottle (blue)</td>
<td>2-L bottle for 0.2-µm filtered deionized (DI) water with BD™ Sheath Additive</td>
</tr>
<tr>
<td>2</td>
<td>Waste bottle (red)</td>
<td>2-L bottle to collect waste</td>
</tr>
<tr>
<td>3</td>
<td>Detergent solution bottle (green)</td>
<td>250-mL bottle for BD™ Detergent Solution Concentrate</td>
</tr>
<tr>
<td>4</td>
<td>BD FACSClean bottle (yellow)</td>
<td>250-mL bottle for BD™ FACSClean solution</td>
</tr>
</tbody>
</table>
### No. | Component | Description
--- | --- | ---
5 | In-line sheath filter | In-line filter to filter the sheath fluid. Additionally, three disk filters (located in the fluid bottles) filter the fluid in each bottle (sheath, BD FACSClean, and detergent solution).
6 | Sheath pump | Peristaltic pump that moves sheath fluid from the sheath bottle through the system.
7 | Waste pump | Peristaltic pump that moves fluid to the waste bottle.
8 | SIP | Sample injection probe. Pulls sample from the sample tube to the flow cell. Shown in figure in *Outside of cytometer (page 16)*.

---

**Loading a tube**

To manually load a tube:

1. Grasp the bottom of the sample stage between your thumb and index finger and push it back.

2. Place the tube over the SIP.
3. While holding the tube, pull the sample stage forward to support the tube.

Note: This procedure applies to manual acquisition only. If you are using a CSampler Plus for acquisition, the sample stage was removed to accommodate for the CSampler Plus.

The bottom of the sample stage contains a metal platform that can be adjusted to two different positions. It can be raised or lowered to accommodate both standard 12 x 75-mm tubes and BD Trucount™ tubes, respectively.

When loading BD Trucount tubes you can lower the platform to prevent the SIP from hitting the retainer at the bottom of the tube. You can also run 12 x 75-mm tubes in the lowered position. Or, you can raise the sample stage platform when loading standard 12 x 75-mm tubes to allow the SIP to reach the bottom of the tube.

To adjust the height of the metal platform in the sample stage:
1. Push up on the underside of the metal platform in the sample stage to raise the platform. Then, using your other hand, swivel the platform 90° to raise/lower it.
Each 90° turn will raise or lower the platform.

---

**BD CSampler Plus overview**

**Introduction**

This topic describes the BD CSampler Plus and how to use it to automatically load samples.

**About the CSampler Plus**

The BD CSampler Plus is an optional sample loading accessory that agitates and delivers tubes to the C6 Plus cytometer for sample acquisition. The CSampler Plus can be included as an option on a new system, or it can be ordered and installed at a later time.

The CSampler Plus holds a custom rack of 24 standard 12 x 75-mm tubes, 48- or 96-well plates, or BD Trucount tubes. One rack is supplied with the CSampler Plus. Do not use any racks other than the one supplied for this CSampler Plus.

Three fixed tube locations at the back of the CSampler Plus tray allow you to load tubes for cleaning, rinsing, and backflushing the SIP.
Loading a rack/plate

Always use the Eject Plate/Rack and Load Plate/Rack buttons in the software to move the CSampler Plus. Never move the CSampler Plus by hand.

Caution: Moving parts! Keep your hands away from the CSampler Plus when it is moving. Never move the CSampler Plus by hand.

To load a rack:
1. If necessary, click Eject Plate on the Collect or Manual Collect tab, or click Eject Rack on the Instrument QC tab.
2. Place the 24-tube rack or plate on the CSampler Plus.
The rack or plate fits one way on the tray, ensuring that position A1 is in the upper-left corner.

3. Press RUN on the Collect tab or Instrument QC tab to load the rack or plate and begin acquisition.

Note: If you simply need to change the cleaning tubes, click Eject Plate and replace the tubes, followed by Load Plate.

The CSampler Plus positions the selected tube under the SIP for acquisition. A plate map on the screen allows you to see the tube that is being acquired. The location flashes blue and is outlined in red.

Cleaning tube locations

The CSampler Plus is equipped with three fixed tube locations to support the system cleaning functions. Check and replace these tubes after system startup, after every run, and as needed.
Each location is designated by a symbol. The following table describes the details of each location.

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triangle (△)</td>
<td>Place a tube containing 2 mL of BD FACSClean in this location. Used for the first tube in a SIP Clean.</td>
</tr>
<tr>
<td>Circle (○)</td>
<td>Place a tube containing 2 mL of DI water in this location. Used for the second tube in a SIP Clean.</td>
</tr>
<tr>
<td>Square (□)</td>
<td>Place a tube containing 2 mL of DI water in this location. Used at startup and shutdown, during a backflush, and for a SIP Rinse. Also used for parking the SIP at shutdown.</td>
</tr>
</tbody>
</table>

**Recommendations when using the CSampler Plus**

This list provides recommendations to follow when using a CSampler Plus:

- Keep fresh cleaning tubes in the three fixed locations during operation. For optimal performance, change the tubes after startup, after every run, and as needed. If left unattended, the tube in the square location could overflow.
- Sample tubes should not contain more than 2.5 mL of sample to avoid spillover during agitation. Cleaning tubes in the three fixed locations should not contain more than 2 mL of liquid.
- Use the software to move the CSampler Plus. Do not try to move it with your hands.
- Keep your hands and objects out of the path of the CSampler Plus.
- Ensure the SIP is parked in water at shutdown.

**More information**

- CSampler Plus data acquisition (page 87)
- Aligning the CSampler Plus after a collision (page 217)
# BD Accuri C6 Plus software overview

## Introduction

This topic describes BD Accuri C6 Plus software and BD CSampler Plus software.

## About the software

BD Accuri C6 Plus software allows you to control the BD Accuri C6 Plus flow cytometer system to acquire data, generate statistics, and analyze results.

The software provides the following features:

- Tabbed views for collection, analysis, and statistics
- Quality control (QC) module that allows you to check and monitor the instrument’s performance over time
- Plots that display more than six decades of dynamic range
- Color compensation at any time
- Drag and drop plots
- Batch analysis of sample data
- Export of files in FCS 3.1 format
- Seamless importation into FCS Express™ and other third-party software
- Color gating
- Live gating

## About BD CSampler Plus software

BD CSampler Plus software allows you to control the BD Accuri C6 Plus flow cytometer system and the BD CSampler Plus to acquire data, generate statistics, and analyze results.

The software provides all the same features as the non-CSampler Plus version. Additionally, it:

- Automatically acquires samples from a 48- or 96-well plate or 24-tube rack
- Ejects and loads the CSampler Plus tray
- Agitates the plate/tube rack and performs a SIP rinse between samples
The main C6 Plus software window is called the workspace. The workspace contains controls and displays that provide access to all the functions for acquiring and analyzing data.

The workspace is organized into four separate tabs. Additionally, the Instrument QC button opens a separate QC window.

- **Collect.** Contains controls for setting up data collection and acquiring data. See Collect tab (page 68) for more information.

- **Analyze.** Contains controls for analyzing data. See Analyzing sample data (page 120) for more information.

- **Statistics.** Displays statistical information. See Statistics tab (page 130) for more information.
- **Batch Analysis.** Contains controls for analyzing batches of sample data. See Analyzing batches of samples (page 142) for more information.

**CSampler Plus workspace**

The main BD CSampler Plus software window is called the workspace. The workspace contains controls and displays that provide access to all functions required for data acquisition and analysis.

The BD CSampler Plus software workspace is organized into five separate tabs. Additionally, the Instrument QC button opens a separate QC window.

- **Manual Collect.** Contains controls for setting up data collection and acquiring data in any order. See Manual Collect tab (page 88) for more information.
• **Auto Collect.** Contains controls for automatically collecting data from several wells in order (horizontally or vertically), starting at a designated well. See *Auto Collect tab (page 99)* for more information.

• **Analyze.** Contains controls for analyzing data. Allows you to analyze multiple samples simultaneously. See *Analyzing sample data (page 120)* for more information.

• **Statistics.** Displays statistical information. See *Statistics tab (page 130)* for more information.

• **Batch Analysis.** Contains controls for analyzing batches of sample data. See *Analyzing batches of samples (page 142)* for more information.

---

**Software menus and options**

This topic contains tables that list and describe the menu options for BD Accuri C6 Plus software and BD CSampler Plus software.

**File menu**

<table>
<thead>
<tr>
<th>Menu options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open workspace or template</td>
<td>Opens a previously saved workspace file or template. Only one workspace can be open at a time.</td>
</tr>
<tr>
<td>New workspace</td>
<td>Opens a new, blank workspace. Replaces any previously open workspace.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the open workspace under the current name. If the file has not already been named, you will be prompted to name the file.</td>
</tr>
<tr>
<td>Save workspace as</td>
<td>Saves the open workspace under a new name.</td>
</tr>
<tr>
<td>Save template as</td>
<td>Creates a template from the currently open workspace. Markers, regions, gates, parameter names, sample names, and user-defined compensation settings are saved without any data points.</td>
</tr>
<tr>
<td>Auto-save Data Settings</td>
<td>Allows you to enable or disable the auto-save feature.</td>
</tr>
<tr>
<td>Import FCS File</td>
<td>Imports an FCS file previously exported from another file to the currently open workspace. Only FCS files created using BD Accuri C6 Plus software and BD Accuri™ C6 software can be imported into the software.</td>
</tr>
</tbody>
</table>
## Edit menu

<table>
<thead>
<tr>
<th>Menu options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Undoes the last action that was performed in the software. You can undo up to the last five actions. Not all actions can be undone.</td>
</tr>
<tr>
<td>Redo</td>
<td>Reverses an Undo action.</td>
</tr>
</tbody>
</table>
### Chapter 2: About the system

#### Display menu

<table>
<thead>
<tr>
<th>Menu options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies a marker or region from a plot, or statistics from the tables to the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes copied markers and regions into new plots.</td>
</tr>
<tr>
<td>Rename Parameters/Color Compensation</td>
<td>Allows you to rename individual parameters for either the current sample or all samples at the same time. Also allows you to view and/or change the color compensation settings.</td>
</tr>
<tr>
<td>Events Display Settings</td>
<td>Opens a dialog that allows you to change the number of events displayed in all plots.</td>
</tr>
<tr>
<td>Auto-Select Next Well</td>
<td>Opens a dialog to configure whether the software automatically selects wells vertically or horizontally, or not at all at the completion of each sample acquisition.</td>
</tr>
<tr>
<td>Remove All VirtualGain™</td>
<td>Removes all VirtualGain settings from the entire workspace. VirtualGain settings are removed from all wells of data.</td>
</tr>
<tr>
<td>Hide/Show Median Statistics</td>
<td>Hides/shows the median statistics in the Statistics table.</td>
</tr>
</tbody>
</table>

#### Instrument menu

<table>
<thead>
<tr>
<th>Menu options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set threshold</td>
<td>Opens the Threshold dialog for selecting the trigger channel, setting the primary threshold value, and setting an optional secondary threshold.</td>
</tr>
<tr>
<td>Set compensation</td>
<td>Opens the Compensation Settings dialog for subtracting fluorescence spillover.</td>
</tr>
<tr>
<td>Run Clean Fluidics</td>
<td>Runs a cleaning fluid cycle.</td>
</tr>
<tr>
<td>Run Backflush cycle</td>
<td>Runs the backflush cycle to clean the SIP and remove clogs at the base of the SIP.</td>
</tr>
<tr>
<td>Extended Flow Cell Clean</td>
<td>Cleans the flow cell for an extended time.</td>
</tr>
</tbody>
</table>
### Menu options

<table>
<thead>
<tr>
<th>Menu options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align CSampler Plus</td>
<td>Aligns the BD CSampler Plus arm to the SIP. Available for BD CSampler Plus software only.</td>
</tr>
<tr>
<td>Auto-adjust volume settings</td>
<td>Adjusts the fluidics to ensure that the cytometer accurately reports the correct volume of sample.</td>
</tr>
<tr>
<td>Update firmware</td>
<td>Used to update the firmware. Use only when directed by a BD representative.</td>
</tr>
<tr>
<td>Remote Interfacing Module</td>
<td>Optional feature available with automation key. Allows control of the cytometer from a remote location.</td>
</tr>
</tbody>
</table>

### About menu

<table>
<thead>
<tr>
<th>Menu options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About BD Accuri C6 Plus software</td>
<td>Opens a dialog that displays the version of software and BD Technical Support contact information.</td>
</tr>
<tr>
<td>Technical Support Information</td>
<td>Opens a dialog that displays information about the current version of C6 Plus software (or CSampler Plus software) and the cytometer. Each time an activation key is used to install a new C6 Plus software component, the dialog is updated to reflect the change.</td>
</tr>
<tr>
<td>Users</td>
<td>Appears when the optional User Tracking option is installed. User tracking allows you to add, delete, or modify user accounts. See Tracking user activity (page 250) for more information.</td>
</tr>
<tr>
<td>Create Cytometer Log</td>
<td>Creates and opens a Microsoft Notepad document with cytometer- and software-specific information for use by a technical support representative. The file is saved to C:\Cytometer Support Files.</td>
</tr>
</tbody>
</table>
3

Startup and shutdown

This chapter covers the following topics:

- Startup workflow (page 36)
- Filling the fluid bottles (page 36)
- Emptying the waste bottle (page 39)
- Starting up the system (page 41)
- Shutting down the system (page 43)
Startup workflow

Introduction
This topic describes the workflow for daily system startup.

Workflow
The following table lists the tasks that should be performed each day to start up the system and prepare it for running samples.

<table>
<thead>
<tr>
<th>Step</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Filling the fluid bottles (page 36)</td>
</tr>
<tr>
<td>2</td>
<td>Emptying the waste bottle (page 39)</td>
</tr>
<tr>
<td>3</td>
<td>Starting up the system (page 41)</td>
</tr>
</tbody>
</table>

More information
- BD Accuri C6 Plus cytometer overview (page 16)

Filling the fluid bottles

Introduction
This topic describes how to fill the sheath, cleaning solution, and detergent solution bottles.

About the fluid bottles
Visually check all the bottles at the start of each day and fill the sheath, BD FACSClean, and detergent solution bottles, as needed.

The cytometer is a non-pressurized system. If necessary, any of the bottles can be opened while the cytometer is powered on. However, avoid filling the fluids during startup, shutdown, acquisition, and the cleaning cycles.
The software displays a message when a fluid bottle needs attention.

**Caution:** Always fill or empty the fluid bottle when the message appears. Allowing the bottle to run dry can introduce air in the lines and lead to problems with the fluidics system.

### Required materials
The following fluids are used with the system:

<table>
<thead>
<tr>
<th>Bottle name</th>
<th>Fluid solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheath</td>
<td>0.2-µm filtered DI water with BD Sheath Additive</td>
</tr>
<tr>
<td>BD FACSClean</td>
<td>BD FACSClean cleaning solution</td>
</tr>
<tr>
<td>Detergent Solution</td>
<td>BD Detergent Solution Concentrate</td>
</tr>
</tbody>
</table>

**Caution:** Corrosive! BD Sheath Additive and BD FACSClean contain chemicals which may be harmful and can cause skin and eye irritation. Use universal precautions when handling.

### Before you begin
Prepare the following solutions:

- **Working solution of the BD Detergent Solution Concentrate**
  Add 3 mL of BD Detergent Solution Concentrate to 197 mL of filtered DI water. Use the working solution within 2 weeks.

- **Sheath fluid**
  Add one bottle (5 mL) of BD Sheath Additive to 1 liter of 0.2-µm filtered DI water.
To fill the fluid bottles:

1. Disconnect each color-coded line from the top of the bottle by squeezing the quick-connect fitting and pulling the tubing connector out of the fitting.

2. Remove the cap from each bottle.

3. Fill each bottle with the appropriate fluid. Add:
   - 2 L of filtered DI water with BD Sheath Additive to the sheath fluid bottle (blue)
   - 250 mL of BD FACSClean solution to the BD FACSClean bottle (yellow)
   - 250 mL of BD Detergent Solution Concentrate working solution to the Detergent Solution bottle (green)

4. Replace the caps on the fluid bottles.

5. Snap the color-coded tubing back into place by pushing firmly until you hear a click.

Next step

Emptying the waste bottle (page 39)

More information

- Fluidics components (page 20)
- Startup workflow (page 36)
Emptying the waste bottle

**Introduction**
This topic describes how to safely empty the waste bottle.

**About the waste bottle**
Empty the waste bottle daily or when prompted by the software to prevent spillover and possible biological safety risk.

The cytometer is a non-pressurized system. If necessary, you can empty the waste while the cytometer is powered on.

**Caution: Biohazard!** Always use precautions when handling biological specimens or instruments that enter in contact with specimens. Wear suitable protective clothing, eyewear, and gloves. Dispose of waste using proper precautions and in accordance with local regulations.

**Required materials**
- 200 mL of undiluted bleach

**Procedure**
To empty the waste bottle:
1. Disconnect both connectors—waste tubing and fluid sensor—from the top of the waste bottle by squeezing the quick-
connect fittings and pulling the tubing connectors out of the fittings.

2. Carefully remove the cap.

3. Dispose of waste using proper precautions and according to local, state, and country biohazard handling regulations.

4. Add approximately 200 mL of undiluted bleach to the bottle.

5. Replace the cap.

6. Snap the tubing back into place by pushing each connector firmly into its color-coded fitting until you hear a click.

---

**Next step**

Starting up the system (page 41)

**More information**

- Fluidics components (page 20)
- Startup workflow (page 36)
- Filling the fluid bottles (page 36)
- Replacing the fluid bottle filters (page 203)
## Starting up the system

### Introduction
This topic describes how to turn on the cytometer and start BD Accuri C6 Plus software. You can turn on the cytometer and computer in any order.

### Before starting the cytometer
Check the fluid levels in all bottles.

- Check the sheath bottle to ensure there is enough sheath fluid for a run.
- Check the BD FACSClean and detergent solution bottles.
- Check the waste bottle to ensure there is adequate capacity.

If necessary, fill the fluid bottles and empty the waste. See Filling the fluid bottles (page 36) and Emptying the waste bottle (page 39) for information.

### About startup
During startup, the power indicator flashes blue and the traffic light turns yellow while the laser warms up and the cytometer flushes the fluid lines with fresh sheath fluid. This process takes approximately 15 minutes.

If the power and indicator lights both flash, see Hardware troubleshooting (page 222).

**Note:** Do not open the lid of the cytometer during the startup process. Opening the lid interrupts the laser warm-up and extends the time before samples can be acquired.

### Required materials
- For systems without a CSampler Plus. 2 mL of DI water
- For systems with a CSampler Plus. 2 mL of DI water (x2) and 2 mL of BD FACSClean solution
Opening BD Accuri C6 Plus software

To open the software:
1. Turn on the power to the computer.
2. Double-click the BD Accuri C6 Plus software icon (or BD CSampler Plus software icon) on the computer desktop. The software opens a new, blank workspace.

Starting the cytometer when running manually

To start up the cytometer when running manually:
1. Ensure a tube containing at least 2 mL of DI water is loaded on the SIP. If necessary:
   a. Push the sample stage back.
   b. Place the tube of water over the SIP.
   c. While holding the tube, pull the sample stage forward to support the tube.
2. Press the power button on the front of the cytometer to turn it on.

Once the fluid lines are flushed, the traffic light turns green and the software displays the message **Cytometer is connected and ready**. The power indicator on the front of the cytometer turns solid blue.

Starting the cytometer when using the CSampler Plus

To start up the cytometer when using the CSampler Plus:
1. Press the power button on the front of the cytometer to turn it on.

Once the lasers are warmed up and the fluid lines are flushed, the traffic light turns green and the software displays the message **Cytometer is connected and ready**. The power indicator on the front of the cytometer turns solid blue.
2. Click **Eject Plate** and load the following fresh cleaning tubes in the designated fixed locations on the CSampler Plus tray:

   - A tube with 2 mL of BD FACSClean in the triangle (△)
   - A tube with 2 mL of DI water in the circle (○)
   - A tube with 2 mL of DI water in the square (□)

3. Click **Load Plate**.

---

**More information**

- Filling the fluid bottles (page 36)
- Emptying the waste bottle (page 39)
- BD Accuri C6 Plus cytometer overview (page 16)
- BD CSampler Plus overview (page 24)
- Shutting down the system (page 43)
- Cleaning the fluidics (page 200)
- Performing a SIP clean (page 198)

---

**Shutting down the system**

**Introduction**

This topic describes how to exit the software and turn off the cytometer. You can turn off the cytometer and computer in any order.

**About shutdown**

When you turn off the power to the cytometer, the Clean Fluidics cycle is run automatically. The cycle takes about 13 minutes to complete. See [Cleaning the fluidics](page 200) for details. At the end of the cycle, leave the SIP in the tube of water to keep it from drying out.

Clean the sample stage at shutdown and whenever you see stains or spills on it.
Depressing the power button for 3 seconds or longer bypasses the automatic Clean Fluidics cycle. If you shut down the cytometer in this way, it does not get properly cleaned, and the software displays the following message the next time you turn on the cytometer:

Extra startup time needed due to cleaning or improper shutdown.

When this occurs, the cytometer takes additional time to run the Clean Fluidics cycle at startup. The startup time can take approximately 25 minutes.

To shut down the cytometer when running manually:
1. Use a disposable towel or wipe moistened with BD FACSClean or a 10% bleach solution to wipe down the sample stage. Follow with a wipe moistened with water.
2. Place a tube containing 2 mL of DI water on the SIP.
   a. Push the sample stage back.
   b. Place the tube of water over the SIP.
   c. While holding the tube, pull the sample stage forward to support the tube.
3. Press the power button on the front of the cytometer to turn it off. Leave the tube of water on the SIP.

The Clean Fluidics cycle runs for approximately 13 minutes, then the cytometer automatically powers off.

To shut down the cytometer when using the CSampler Plus:
1. Ensure the following cleaning tubes are loaded in the designated fixed locations on the CSampler Plus tray:
   - A tube with 2 mL of BD FACSClean in the triangle (△)
   - A tube with 2 mL of DI water in the circle (○)
   - A tube with 2 mL of DI water in the square (□)
2. Press the power button on the front of the cytometer to turn it off. The SIP is left in the tube of water in the square (□) location.

The Clean Fluidics cycle runs for approximately 13 minutes, then the cytometer automatically powers off.

### Exiting the software

**To exit the software:**

1. Select **File > Quit**.

2. When prompted to save changes to the workspace:
   - Click **Yes** to save changes.
   - Click **No** to close the software without saving changes.
   - Click **Cancel** to cancel the exit and keep the software open.

### More information

- **Cleaning the fluidics (page 200)**
This chapter covers the following topics:

- QC overview (page 48)
- Running instrument QC (page 49)
- Adjusting the bead regions and markers (page 53)
- Viewing QC results (page 58)
- Viewing Levey-Jennings plots (page 63)
QC overview

Introduction
This topic describes the quality control module and recommended workflow.

About quality control
The instrument QC module allows you to perform quality control on the system. Run quality control daily using the BD CS&T RUO beads to check and monitor the instrument’s performance. The CS&T RUO beads have a known median fluorescence intensity (MFI) and distribution (rCV), and allow you to characterize, track, and report measurements made by the cytometer.

During instrument QC, the software sets regions around the dim beads and the mid + bright beads. The locations of the regions are based on target values, not on the actual locations of the bead populations. The system measures the brightness and distribution of the bright beads and compares the results to expected values. Instrument sensitivity is also calculated. In addition, the compensation values are updated based on the CS&T RUO bead results. When the QC test is complete, a Passed or Failed result is displayed.

Daily workflow
The following table shows the recommended daily workflow for running QC and samples.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Prepare BD CS&amp;T RUO beads according to the BD CS&amp;T RUO Beads data sheet.</td>
</tr>
<tr>
<td>2</td>
<td>Run BD CS&amp;T RUO beads and optimize the regions and markers. See Running instrument QC (page 49) and Adjusting the bead regions and markers (page 53).</td>
</tr>
</tbody>
</table>
Running instrument QC

Introduction
This topic describes how to run the BD CS&T RUO beads to check the instrument performance.

Before you begin
Prepare BD CS&T RUO beads according to the instructions in the BD CS&T RUO Beads data sheet.

If you are using the Selectable Lasers Module, the laser will automatically switch to the standard 3 blue 1 red configuration for instrument QC. Ensure that the standard optical filters are installed when running instrument QC. When QC is complete and you close the QC module, the system will switch back to the configuration that was previously selected, if different from 3 blue 1 red.
Procedure

To run instrument QC:

1. Click **Instrument QC** in the upper-right corner of the workspace.

   The QC module opens.

2. Select the bead lot from the **BD CS&T Bead Lot** menu.

   The last bead lot run appears as the default.

   If you need to install a bead lot file for a new lot of beads, see Install a new bead lot (page 51).

3. Enter your operator ID and the lab director ID.

   Once the lab director ID is entered, it becomes the default until you change it.
4. Run the CS&T RUO beads.
   - If you are running bead samples manually, mix the tube of CS&T RUO beads and load it on the instrument. Click RUN.
   - If you are using a CSampler Plus, click Eject Rack. Mix the tube of CS&T RUO beads and place it in location A1. Place the tube rack on the CSampler Plus and click RUN.

5. Wait for acquisition to complete.
   The system starts by measuring the background instrument noise. During this step, the Instrument Noise Measurement plots are displayed.
   After assessing the noise, the system acquires 25,000 events and displays the BD CS&T Bead plots.
   If you want to abort the run, click ABORT QC.
   When acquisition is complete, the QC Report table is displayed, and the result appears at the top of the screen.

6. Rinse the SIP.
   If you are running manually, place a tube of DI water on the SIP. If you are using a CSampler Plus, the instrument automatically performs a SIP rinse.

7. Proceed to Adjusting the bead regions and markers (page 53).

---

**Install a new bead lot**

If this is the first time you are running a bead lot, you will need to install the BD CS&T RUO bead lot file. The bead lot file contains information specific to the given lot of beads, such as expiration date, rCV, target MFIs, and sensitivity specifications. Once installed, the bead lot number will be available to select from the BD CS&T Bead Lot menu for subsequent QC runs.

**To install the bead lot:**

1. Select Install from the BD CS&T Bead Lot menu.
The Install New Bead Lot dialog opens.

2. You can either locate a bead lot file on your computer or scan the bead lot barcode.
   - To browse for a file on your computer, first download the BD CS&T RUO bead lot file from the BD website. See the BD CS&T RUO Beads data sheet for instructions on downloading bead lot files. Once downloaded, select **Install bead lot**, then click **Choose file**. Navigate to the bead lot file and click **Open**.
   - To scan a bead lot, select **Scan bead lot bar code**, then scan the bar code on the box. The bead lot appears in the space provided.
3. Click **Install**.

**More information**
- Adjusting the bead regions and markers (page 53)
- Viewing QC results (page 58)
- Removing bead lots from the CS&T bead lot menu (page 185)
- QC troubleshooting (page 231)
Adjusting the bead regions and markers

Introduction

This topic describes how to adjust the regions and markers for the BD CS&T RUO beads.

The software sets the region and markers for the bright beads based on target values, not on the actual locations of the populations. Therefore, you will need to check and optimize the region and markers, as necessary.

About adjusting the regions and markers

Once the bead acquisition is complete and while the QC results are displayed, you can adjust the regions and markers to optimize them.

Note: Do not adjust the markers for the noise peaks.

Once you close the QC window or click on the History: Levey-Jennings tab, you can no longer return to the Instrument QC tab to edit the regions and markers. A dialog is displayed to remind you.

To adjust the regions and markers, scroll up to the bead plots, as shown.
Adjusting the regions in the dot plot

Adjust both the dim and mid + bright regions.

To adjust the bead regions:
1. Use the zoom tool to zoom in on the bead data before adjusting the regions. See Zooming plots (page 56).
2. Click the bead region to select it.
The region appears with a bold red outline and eight handles.

3. Adjust the region for the dim beads and the region for the mid + bright beads. Exclude the doublet population to the right of the mid + bright beads.
   - Place the cursor over a handle. A double-sided arrow appears. Click and drag to adjust the region in either direction. When you adjust a corner handle, the region automatically snaps to a rectangle.
   - Place the cursor over an area that is not a handle. A four-sided arrow appears. Click and drag to move the entire region in any direction.

If you want to revert to the original regions, click **Undo Manual Adjustments** in the upper-right corner of the screen.

---

**Adjusting the markers in the histogram plots**

To adjust the bright-bead peak markers in all four histograms:

1. Use the zoom tool to zoom in on the bead populations before adjusting the markers. See **Zooming plots (page 56)**.

2. Click the bright bead marker to select it.
The marker appears with a bold red outline and two handles.

![Unzoomed vs. Zoomed Plot]

3. Adjust the markers.
   - Place the cursor over a handle to drag it to the left or right.
   - Place the cursor over the horizontal line between the handles to move the entire marker in any direction.

4. Repeat as necessary to adjust the marker to encompass the bright bead population, while excluding the doublets.

If you want to revert to the original markers, click **Undo Manual Adjustments** in the upper-right corner.

**Zooming plots**

You can zoom in on data to make it easier to see where to set the markers. If the plots are zoomed when you close the QC report, the report will be saved with the zoomed plots.

**To zoom the plot:**

1. Click the zoom tool below the plot to zoom in on the data.
2. Click and drag over the area that you want to zoom in on. Repeat as necessary.
   - To zoom a dot plot, drag in any direction to encompass the population of interest.
   - To zoom a histogram, drag across the peak in either direction.

![Unzoomed and Zoomed Dot Plot](image)

3. Click the expand tool to zoom out once. Or, click the Default Zoom button to go back to the original data range.

Next step

- If the result passed, you are ready to run test samples. See Manual data acquisition (page 67) or CSampler Plus data acquisition (page 87).
- If the result failed, even after you adjusted the bead regions and markers, check the QC messages for additional help. See QC troubleshooting (page 231) for possible causes and solutions.
- To rerun the beads, mix the tube, click New QC, then click RUN.
# Viewing QC results

## Introduction
This topic describes the information that appears on the QC results screen.

## About instrument QC results
The instrument QC results are displayed as Passed or Failed. If the result fails, adjust the mid + bright bead region and the fluorescence markers. The QC messages that appear below the QC Report (results) table provide information on the conditions that the system encountered.

⚠️ **Caution!** Do not run process controls or test samples if instrument QC fails. A successful instrument QC is required to ensure accurate results.

## QC results screen
While the QC results window is open, you can make adjustments to the regions and markers to optimize them. See Adjusting the bead regions and markers (page 53). Once you close the window or click on the History: Levey-Jennings tab, the QC results are locked and no longer editable; however you can add comments. You can also open and view previous reports and enter comments.
Chapter 4: Quality Control

**Instrument noise measurement plots**
The system measures the background instrument noise and displays this in the Instrument Noise Measurement plots. Markers are automatically set in the lower channels around the target locations for noise peaks. *Do not* adjust the noise peak markers.

**BD CS&T Beads plots**
The system acquires 25,000 total events and displays the data in the BD CS&T Beads plots. Regions are set around the dim bead population and the mid + bright bead population in the dot plot based on target values. Markers are set around the bright bead target location in the histogram for each fluorescence parameter. You can adjust the regions and/or the histogram markers. See *Adjusting the bead regions and markers* (page 53) for information.

**QC Report table**
The QC Report table displays the values and Pass/Fail result for each parameter. If any of the results for an individual parameter
fails, the failed parameter result appears in red and the overall instrument QC result fails.

The QC Report table provides values for the following measurements for FSC, SSC, and FL1–FL4 parameters.

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bright Bead Median</td>
<td>Measured median value for the bright bead population</td>
</tr>
<tr>
<td>MFI Range</td>
<td>Target median scatter and fluorescence intensity range for the bright bead population</td>
</tr>
<tr>
<td>% Bright Bead rCV</td>
<td>rCV for the bright bead population</td>
</tr>
<tr>
<td>Instrument Sensitivity</td>
<td>Resolution between instrument noise and bright bead peak</td>
</tr>
<tr>
<td>Sensitivity Spec.</td>
<td>Minimum sensitivity required</td>
</tr>
<tr>
<td>Parameter Pass/Fail</td>
<td>Passed/Failed result for each parameter</td>
</tr>
</tbody>
</table>

**QC Messages**

QC messages, listed below the QC Report table, provide information about the run. The messages can be helpful in troubleshooting if instrument QC fails. If there are QC messages for the run, a QC Messages link appears below the Passed/Failed results at the top of the screen. Click the link to quickly scroll to the QC messages. See QC Messages in QC troubleshooting (page 231) for more information.
Chapter 4: Quality Control

Comments
The Comments section allows you to add comments about the run. You can also add comments before you run the beads or after the QC window is closed, by viewing previous QC results.

To add comments to the QC report:
1. Click in the Comments text box and type the comment(s).

Viewing previous QC results
You can view the QC report for any previous QC run.

To view QC results from a previous run:
1. Click View Previous QC in the upper-right corner of the Instrument QC tab.

A window opens showing all QC runs by date.
2. Select a run, then click OK to view the results for that run.

   **Note:** Results from previous runs are not editable. However, you can add comments to the report.

For information on deleting old QC runs from the View Previous QC window, see Removing QC report files from the previous QC list (page 184).

---

**Printing QC reports**

You can print QC reports after the run is complete. You can also print the reports from previous QC runs.

**To print the QC report:**

1. Click **Print** in the upper-right corner of the QC window.

---

**Next step**

- If instrument QC passed, you are ready to run controls and test samples. See Manual data acquisition (page 67) or CSampler Plus data acquisition (page 87). Prepare the control along with the test samples. See the appropriate reagent package insert or data sheet for use for sample preparation information.
- If instrument QC still fails after adjusting regions and markers, check the QC messages at the bottom of the screen for more information. Refer to QC messages (page 232) for possible causes and solutions.

---

**More information**

- Running instrument QC (page 49)
- Adjusting the bead regions and markers (page 53)
- Viewing Levey-Jennings plots (page 63)
- Removing QC report files from the previous QC list (page 184)
### Viewing Levey-Jennings plots

#### Introduction
This topic describes the History: Levey Jennings tab used to view a history of QC results and print Levey-Jennings reports.

#### About Levey-Jennings reports
Levey-Jennings reports track QC data over time, allowing you to view the system’s performance and ensure that the system is reproducing consistent results. The graphs in the report show you random errors or shifts and trends in the data for each parameter, and help you diagnose possible problems with the system.

The graphs show the bright bead median values, %rCV, and sensitivity with standard deviations for FSC, SSC, FL1, FL2, FL3, and FL4.

#### Reviewing the Levey-Jennings report
To view the Levey-Jennings report:

1. Click the History: Levey-Jennings tab from the QC window.

   The Levey-Jennings tab is displayed.
2. Select the number of days from the View menu in the upper-left corner of the tab.

You can view data for the last 30, 60, or 90 days. Use the scroll arrows to the right of the View menu to change the start date.

- Click the left arrow to select a date 1 month earlier.
- Click the right arrow to select a date 1 month later.

3. Scroll down to view all the graphs for FL1–FL4, FSC, and SSC median, FL1–FL4 rCVs, and sensitivity for each parameter.
The graphs show CS&T RUO bead data plotted over time. If multiple bead lots were used, a different symbol and different color line appear for each lot.

The horizontal lines above and below the median line represent ±1 SD and 2 SD. The top and bottom edges of the graph represent ±3 SD.

A legend in the lower-left corner displays the symbols used for invalid results, where a data point was collected but the value was not used in the SD calculation. The different symbol shapes correspond to the symbols used for different bead lots.

4. To close the QC window, click Close in the lower-right corner.

**Printing Levey-Jennings reports**

To print a Levey-Jennings report:
1. Select the number of days you want to plot from the View menu.
2. Click Print in the upper-right corner of the Levey-Jennings tab.

**More information**
- Viewing QC results (page 58)
- QC troubleshooting (page 231)
Manual data acquisition

This chapter covers the following topics:

- Collect tab (page 68)
- Setting acquisition parameters (page 72)
- Run settings (page 73)
- Fluidics rate (page 75)
- Threshold (page 79)
- Running samples using the Collect tab (page 81)
- Ending a data collection session (page 84)
Collect tab

Introduction
This topic describes the Collect tab in BD Accuri C6 Plus software.

About the Collect tab
The Collect tab allows you to set data collection criteria, start and stop data acquisition, and view data on collected samples. You can use pre-defined templates for acquisition or create your own workspace with custom acquisition criteria. The tab contains buttons and controls for performing the following functions:

- Acquiring samples
- Creating plots (histogram, dot, or density) for viewing data
- Setting stop criteria (run limits) and thresholds
- Controlling the fluidics
- Using regions and markers to create gates and obtain statistics
- Saving and print plots and data
- Accessing the following analytic functions:
  - Creating nested gates
  - Setting and/or adjusting fluorescence compensation
  - Generating statistics
Viewing the Collect tab

The Collect tab is displayed when the software opens. You can also view the tab by clicking on Collect from any of the other tabs (Analyze, Statistics, or Batch Analysis).

The Collect tab is organized into two major sections:

- **Instrument Control Panel.** Panel on the left side of the window that contains controls for collecting data.

- **Data display.** Area on the right that shows sample data in plots and in a statistics table.
The following table describes each of the controls and indicators in the Collect tab:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample naming field</td>
<td>Text box for naming the sample.</td>
</tr>
</tbody>
</table>
| Sample grid              | Matrix laid out in the configuration of a 96-well plate to help organize experiments and collect data from sample tubes. Each sample is acquired into its own well in the sample grid. The color-coded wells can be filled with data in any order.  
**White.** Does not contain data.  
**Blue.** Contains data.  
**Red outline.** Currently selected for viewing or collecting data. |
| Traffic light and message| Indicator that displays software readiness and system messages. Before data collection can begin, the software must display a green traffic light with the message *Cytometer is connected and ready.*  
The traffic light status is color-coded:  
**Green.** Software is ready to collect data or is collecting data.  
**Yellow.** Cytometer is preparing to perform an action or a non-critical error has occurred.  
**Red.** Critical error has occurred. |
| Run Settings             | Contains a set of controls that allow you to define criteria for automatically stopping data collection. See Run settings (page 73) for more information. |
| Backflush                | Performs a backflush to force sample out of the SIP.                                                                                         |
| SIP Clean                | Performs a SIP Clean to clean the inside of the SIP.                                                                                         |
| Fluidics                 | Contains a set of controls for defining flow rate and core size. See Fluidics rate (page 75) for more information.                           |
| Threshold                | Allows you to set the event threshold to eliminate debris and noise from sample data. The default value is 80,000 on FSC-H. See Threshold (page 79) for more information. |
## Chapter 5: Manual data acquisition

### RUN/PAUSE/ADD TO
- **Button that performs the following functions:**
  - **RUN.** Starts sample acquisition.
  - **PAUSE.** Pauses acquisition. Click ADD TO to resume acquisition.
  - **ADD TO.** Allows you to collect more sample data in a well that already contains data.

### Set Color Compensation
- Opens the Color Compensation dialog for correcting fluorescence spillover. See [Correcting fluorescence spillover](page 149) for more information.

### Acquisition counters
- Displays the following information about the most recent acquisition for the selected well (Last Run) and all acquisitions for the selected well (Cumulative) in real-time:
  - **Events.** Number of events acquired.
  - **Time.** Elapsed acquisition time.
  - **Microliters.** Volume of sample acquired.
  - **Events/Sec.** Events acquired per second. When the run is completed, this is the average value.
  - **Events/µL.** Events acquired per microliter. When the run is completed, this is the average value.

### Delete Events
- Permanently deletes all events from the current sample. Select the **show warning** checkbox to display a warning message before deleting sample data. Also contains a Data Capacity Used meter that displays the amount of data storage capacity currently used in the software.

### Plots pane
- Area displaying two rows of plot corrals for graphically viewing data for the selected sample. Scroll up or down to view additional plots. You can create multiple plots for each sample. Each plot corral contains buttons for creating histogram, dot, and density plots. See [Plots and gates](page 156) for more information on plots.

### Statistics table
- Table below the plots that displays statistical information on all plots.
Complete the following workflow steps to collect sample data.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>(Optional) Open a template. See Creating a workspace template (page 189).</td>
</tr>
<tr>
<td>2</td>
<td>Set the acquisition parameters—run limits, fluidics rate, and threshold. See Setting acquisition parameters (page 72).</td>
</tr>
<tr>
<td>3</td>
<td>Open plots, create and apply gates. See Creating a new plot (page 157) and Creating and applying gates (page 160).</td>
</tr>
<tr>
<td>4</td>
<td>Run the sample. See Running samples using the Collect tab (page 81).</td>
</tr>
<tr>
<td>5</td>
<td>(If needed) Apply fluorescence compensation values. See Correcting fluorescence spillover (page 149).</td>
</tr>
<tr>
<td>6</td>
<td>Save the data. See Workspace files (page 186).</td>
</tr>
</tbody>
</table>

**Setting acquisition parameters**

**Introduction**

This topic lists the different acquisition parameters. See the following sections for information on each parameter.

**Acquisition parameters**

You can set the following acquisition parameters:

- Run settings (page 73)
- Fluidics rate (page 75)
- Threshold (page 79)
Run settings

Introduction
This topic explains run settings and provides instructions for enabling and disabling run limits for data collection.

About run settings
Set a run limit to indicate when to stop collecting data. You can set a run limit based on any of the following criteria:

- After a specified number of events
- After a specified time
- After a specified volume
- For an unlimited time (until you manually stop the run)

You can choose multiple run limits (collection stops when the first limit is reached). You can also change the run limit once a gate has been set on the population of interest.

Disabling run limits
To collect samples without setting a run limit:
1. Select the Run Unlimited checkbox.
Setting an event run limit

To stop the run after a specified number of events have been collected:

1. Select Run with Limits.
2. Select the checkbox next to the events field.
3. In the associated text box, type the number of events at which to stop the run.
4. Do one of the following in the list below the text box:
   - Select Ungated Sample.
   - Select a gating strategy (if one exists) to stop the run when the assigned number of events have been collected in the gating region.
5. To set a live gate, select the Do not collect events outside checkbox. Then, select the gate from the menu. See Creating a live gate (page 166).

   This option is called Only collect events inside in the Auto Collect tab when using a CSampler Plus.

Setting a time run limit

To stop the run after a time has expired:

1. Select Run with Limits.
2. Select the checkbox next to the Min and Sec fields.
3. Type the number of minutes (min) and seconds (sec) at which to stop the run.

Setting a volume run limit

To stop the run after a specified volume has been collected:

1. Select Run with Limits.
2. Select the checkbox next to the µL field.
3. Type the volume in microliters (µL) at which to stop the run.
# Fluidics rate

## Introduction

This topic describes how to set the fluidics rate for data collection.

## About fluidics rates

The system can accommodate an upper limit of 10,000 events per second, but we recommend acquiring samples at a rate of 2,500 events per second or less to ensure the best data resolution.

Three preset rates are provided—Slow, Medium, and Fast. You can also customize the fluidics rate by selecting a rate outside the preset values.

## Setting the fluidics rate

To set the fluidics rate:

1. Select **Slow**, **Medium**, or **Fast** under Fluidics in the Instrument Control Panel.
   - Slow is 14 µL/min.
   - Medium is 35 µL/min.
   - Fast is 66 µL/min.

   **Note:** We recommend starting data collection on Slow and observing the event rate. You can then switch the setting to Medium or Fast, if necessary.

2. Observe the event rate. If the rate is near or greater than 10,000 total events per second on the Slow setting, consider the following options:
   - Increase the primary threshold value, taking care that the increase does not remove cells of interest from the data set.
   - Include a secondary threshold, taking care not to exclude cells of interest.
   - Dilute the sample.
Customizing the fluidics rate

Advanced users can set a custom fluidics rate.

To customize the fluidics rate:

1. Select Custom under Fluidics in the Instrument Control Panel.

2. Move the Custom slider to adjust the flow rate.

Adjusting the core size of the sample stream

Advanced users can adjust the core size of the sample stream for a range of cell sizes.

To customize the sample core size:

1. Click Set Core Size under Fluidics in the Instrument Control Panel.

2. Move the slider to adjust the core size.
3. Click **OK** to set the core size and close the dialog.

**Note:** Certain core sizes are not compatible with certain flow rates, and the software does not allow these combinations to be set. Use the following table to determine allowable combinations.

<table>
<thead>
<tr>
<th>Core size</th>
<th>Minimum flow rate</th>
<th>Maximum flow rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>10</td>
<td>11</td>
</tr>
<tr>
<td>6</td>
<td>10</td>
<td>16</td>
</tr>
<tr>
<td>7</td>
<td>10</td>
<td>22</td>
</tr>
<tr>
<td>8</td>
<td>10</td>
<td>29</td>
</tr>
<tr>
<td>9</td>
<td>10</td>
<td>36</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>45</td>
</tr>
<tr>
<td>11</td>
<td>10</td>
<td>54</td>
</tr>
<tr>
<td>12</td>
<td>10</td>
<td>65</td>
</tr>
<tr>
<td>13</td>
<td>10</td>
<td>76</td>
</tr>
<tr>
<td>14</td>
<td>12</td>
<td>88</td>
</tr>
<tr>
<td>15</td>
<td>14</td>
<td>100</td>
</tr>
<tr>
<td>16</td>
<td>15</td>
<td>100</td>
</tr>
<tr>
<td>17</td>
<td>17</td>
<td>100</td>
</tr>
<tr>
<td>18</td>
<td>19</td>
<td>100</td>
</tr>
<tr>
<td>19</td>
<td>22</td>
<td>100</td>
</tr>
<tr>
<td>20</td>
<td>24</td>
<td>100</td>
</tr>
<tr>
<td>21</td>
<td>26</td>
<td>100</td>
</tr>
<tr>
<td>22</td>
<td>29</td>
<td>100</td>
</tr>
<tr>
<td>23</td>
<td>32</td>
<td>100</td>
</tr>
<tr>
<td>24</td>
<td>35</td>
<td>100</td>
</tr>
<tr>
<td>Core size</td>
<td>Minimum flow rate</td>
<td>Maximum flow rate</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>25</td>
<td>38</td>
<td>100</td>
</tr>
<tr>
<td>26</td>
<td>41</td>
<td>100</td>
</tr>
<tr>
<td>27</td>
<td>44</td>
<td>100</td>
</tr>
<tr>
<td>28</td>
<td>47</td>
<td>100</td>
</tr>
<tr>
<td>29</td>
<td>50</td>
<td>100</td>
</tr>
<tr>
<td>30</td>
<td>54</td>
<td>100</td>
</tr>
<tr>
<td>31</td>
<td>58</td>
<td>100</td>
</tr>
<tr>
<td>32</td>
<td>61</td>
<td>100</td>
</tr>
<tr>
<td>33</td>
<td>65</td>
<td>100</td>
</tr>
<tr>
<td>34</td>
<td>69</td>
<td>100</td>
</tr>
<tr>
<td>35</td>
<td>74</td>
<td>100</td>
</tr>
<tr>
<td>36</td>
<td>78</td>
<td>100</td>
</tr>
<tr>
<td>37</td>
<td>82</td>
<td>100</td>
</tr>
<tr>
<td>38</td>
<td>87</td>
<td>100</td>
</tr>
<tr>
<td>39</td>
<td>91</td>
<td>100</td>
</tr>
<tr>
<td>40</td>
<td>96</td>
<td>100</td>
</tr>
</tbody>
</table>
# Threshold

## Introduction

This topic explains the threshold and provides instructions for setting a collection threshold.

## About thresholds

Thresholds eliminate debris and noise from cell samples so that sample data are not compromised by non-cellular events. By default, events lower than channel 80,000, for the selected parameter, are filtered out.

You can change the threshold settings at any time before, during, or after data acquisition. The primary threshold is the parameter that triggers data collection. FSC-H is the default primary threshold. You can optionally set a secondary threshold to filter out additional data.

The most consistent, predictable results will be obtained if threshold settings are chosen before final data collection for any given experiment.

All thresholds are set on the Height signal for any given parameter. For best results when setting or changing thresholds, create a plot that displays the Height signal for the threshold channel and observe the effect on the data as the threshold is raised or lowered.

**Caution** Take care when setting the thresholds before or during data collection. Any event not meeting the threshold criteria will be not be acquired or saved. When changes are made to the threshold values after data collection, the software displays a warning message if the new threshold value will result in permanent data loss.
Setting the threshold:

1. Click Set Threshold in the Instrument Control Panel.

2. Select the primary threshold parameter from the Primary Threshold list.

3. Type 80000 in the less than text box to set the threshold minimum to channel 80,000.

   You may need to set a lower or higher FSC-H threshold when working with small cells (such as platelets or bacteria) or large cells (such as cell lines), respectively.

4. If you want to apply a secondary threshold for filtering out more data, do the following:
   - Select the threshold parameter from the Optional Secondary Threshold list.
   - Type a value in the less than text box to set the threshold minimum.

5. Select one of the following Apply to:
   - Only this sample to apply settings to the current sample only.
   - All samples to apply the settings to all samples, including all previously collected data in other data wells.

6. Click Apply to apply the threshold settings.

7. Click Close to close the dialog.
Running samples using the Collect tab

**Introduction**

This topic describes how to run a sample after all acquisition parameters (run settings, fluidics rate, and threshold) are set.

**About collecting sample data**

- Before data collection can begin, the software must display a green traffic light with the message *Cytometer is connected and ready*.
- Each data well holds a maximum of 1 million events. You can add more events (up to a total of 1 million) to a well already containing data.
- When a well already contains data, the RUN button becomes ADD TO.
  
  **Note:** Run limits may need to be adjusted to accommodate additional data.

**Before you begin**

Set the acquisition parameters. See Setting acquisition parameters (page 72).

**Procedure**

To run a sample:

1. Select an empty sample well.
   
   A1 is selected by default.

2. Enter a sample name in the text box above the 96-well grid.
You can name samples at any time. If you do not type in a name, the sample is named according to the well location (for example, A01).

3. Resuspend the cells in the sample tube and place the tube on the SIP.

4. Click RUN to start the sample collection.

   If you have not yet saved the workspace, you will be prompted to do so.

   Fluidics initialization begins. During this time the traffic light turns yellow and the message *Preparing to analyze sample* is displayed.

   Once initialization is complete, the traffic light turns green and the message *Cytometer is running* is displayed.

   The well flashes blue during data collection. After the run limit is reached, the well stops flashing and remains blue, indicating that the well contains data.

5. If you are running unlimited, click PAUSE to stop acquisition.

   **Note:** If desired, you can collect more data in a well that contains data at any time by selecting the well and clicking ADD TO. See *Adding more sample data to a file* (page 83).

6. To run the next sample, click the next well in the sample grid.
   If necessary, adjust the acquisition parameters, then click RUN.

   To have the next sample well automatically selected, select Display > Auto-Select Next Well. Choose horizontally or vertically and click OK. When the run limit for a sample is reached, the next sample well is automatically selected. You
need only click RUN. If you are running unlimited, the collection will stop when 1 million events are acquired.

Adding more sample data to a file

You can collect new samples and add the data to a workspace file that already contains sample data, by adding data to a well that already contains data or to an empty well. If the well already contains data, you may need to increase the number of events defined for the run limit to allow for more events to be acquired.

To add data to a file:

1. Resuspend the sample and place the tube on the SIP.
2. Click a data well in the 96-well sample grid.
   
   If you select an empty well, any plots and gates you created earlier are still displayed, but they do not contain data.
3. Click RUN (or ADD TO) to start acquisition.
   
   The cytometer stops sampling from the tube when the run limit is reached.

   **Caution** If you click ADD TO, the software will collect data into a well that already contains data.
Pausing data collection

You can interrupt sample acquisition any time during a run.

To stop a run:
1. Click PAUSE.

To restart the run:
1. Click ADD TO. The software resumes data collection in the current well.

   If you want to delete the data that was already collected before you paused, click Delete Events at the bottom of the Instrument Control Panel, then click RUN to acquire new data.

Next step

Ending a data collection session (page 84)

More information

• Creating a live gate (page 166)

Ending a data collection session

Introduction

This topic describes how to save the workspace file and clean the SIP at the completion of a run.

Auto-save data feature

If you have the Auto-save Data Settings feature enabled, the software will automatically save the workspace file at the end of the run. If you make any changes to the workspace after the run is finished, the changes will not be automatically saved. You will need to manually save the file. See Saving the workspace file (page 85).

To enable the auto-save data feature:
1. Select File > Auto-save Data Settings.
2. Select the enabled option and click OK.

**Saving the workspace file**

To save the workspace file at the end of the run:

1. Select File > Save.

**Performing a SIP clean**

When you finish collecting samples, clean the SIP to ensure cells or other particles are not left in the SIP.

To clean the SIP:

1. Click SIP Clean in the instrument control panel.

   A dialog prompts you to load a tube containing 2 mL of BD™ FACSClean.

2. Load the tube of BD FACSClean and click SIP Clean.

   When step 1 is complete, a dialog prompts you to load a tube containing 2 mL of water.

3. Load the tube of water and click SIP Clean.
CSampler Plus data acquisition

This chapter covers the following topics:

- Manual Collect tab (page 88)
- Running samples using the Manual Collect tab (page 93)
- Auto Collect tab (page 99)
- Creating sample sets for Auto Collect experiments (page 103)
- Setting parameters for Auto Collect experiments (page 106)
- Running samples using the Auto Collect tab (page 112)
- Ending a data acquisition session (page 117)
**Manual Collect tab**

**Introduction**

This topic describes the Manual Collect tab in BD CSampler Plus software.

---

**About the Manual Collect tab**

The Manual Collect tab allows you to set the data collection criteria, start and stop data acquisition, and view data on collected samples. You can use pre-defined templates for acquisition or create your own workspace with custom acquisition criteria. The tab contains buttons and controls for performing the following functions:

- Run individual samples from a plate or tube rack. Settings such as thresholds and color compensation can be applied to either the current sample being viewed or to all the samples in the sample grid.

- Set up experiments to be collected in the Auto Collect tab. The following must be set up in the Manual Collect tab before switching to the Auto Collect tab:
  - plots (histogram, dot, or density) for viewing data
  - gating strategies
  - threshold values

  **Note:** Run Limit settings for auto collect runs must be set in the Auto Collect tab.

- Collect data from a plate if the plate has been interrupted or aborted in the Auto Collect tab.
- View sample data in plots and in the Statistics table.
- Print plots and statistics.
- Perform color compensation.
- Import and export data.
Viewing the Manual Collect tab

The Manual Collect tab is organized into two major sections:

- **Instrument Control Panel.** Panel on the left side of the window that contains controls for collecting data.

- **Data display.** Large area on the right side of the window that shows the sample data in plots and in a Statistics table.
**Manual Collect tab controls**  
The following table describes each of the controls and indicators in the Manual Collect tab.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Type</td>
<td>List for selecting the plate type.</td>
</tr>
<tr>
<td>Load Plate/Eject Plate</td>
<td>Moves the sample plate into position to be loaded onto or ejected from the flow cytometer.</td>
</tr>
<tr>
<td>Plate Name</td>
<td>Text box for naming the plate.</td>
</tr>
<tr>
<td>Sample naming field</td>
<td>Text box for naming the sample.</td>
</tr>
</tbody>
</table>
| Sample grid                 | Matrix laid out in the configuration of a 96-well plate or a 24-tube rack to correspond to the sample vessel. Each sample is acquired into its own well in the sample grid. The color-coded wells can be filled with data in any order.  
  **White.** Does not contain data.  
  **Blue.** Contains data.  
  **Red outline.** Currently selected for viewing or collecting data. |
| Traffic light and message   | Indicator that displays software readiness and system messages. Before data collection can begin, the software must display a green traffic light with the message *Cytometer is connected and ready.*  
  The traffic light status is color-coded:  
  **Green.** Software is ready to collect data or is collecting data.  
  **Yellow.** Cytometer is preparing to perform an action, performing an action other than data collection (such as clean or agitate), or a non-critical error has occurred.  
  **Red.** Critical error has occurred or the CSampler Plus has collided. |
| Run Settings                | Contains a set of controls that allow you to define criteria for automatically stopping data collection. See Run settings (page 73) for more information. |
### Chapter 6: CSampler Plus data acquisition

#### SIP Rinse
Rinses the outside of the SIP between samples.

#### Agitate
Agitates the plate/rack to keep cells in suspension.

#### Backflush
Forces sample out of the SIP.

#### SIP Clean
Performs a SIP Clean to clean the inside of the SIP.

#### Fluidics
Contains a set of controls for defining flow rate and core size. See Fluidics rate (page 75).

#### Threshold
Allows you to set the event threshold to eliminate debris and noise from sample data. The default value is 80,000 on FSC-H. See Setting the threshold (page 107).

#### RUN/PAUSE/ADD TO
Button that performs the following functions:
- **RUN.** Starts sample acquisition.
- **PAUSE.** Pauses acquisition. Click ADD TO to resume data collection.
- **ADD TO.** Allows you to collect more sample in a well that already contains data.

#### Set Color Compensation
Opens the Color Compensation dialog for correcting fluorescence spillover. See Correcting fluorescence spillover (page 149).

#### Acquisition counters
Displays the following information about the most recent acquisition for the selected well (Last Run) and all acquisitions for the selected well (Cumulative) in real-time:
- **Events.** Number of events acquired.
- **Time.** Elapsed acquisition time.
- **Microliters.** Volume of acquired sample.
- **Events/sec.** Events acquired per second. When the run is completed, this is the average value.
- **Events/µL.** Events acquired per microliter. When the run is completed, this is the average value.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIP Rinse</td>
<td>Rinses the outside of the SIP between samples.</td>
</tr>
<tr>
<td>Agitate</td>
<td>Agitates the plate/rack to keep cells in suspension.</td>
</tr>
<tr>
<td>Backflush</td>
<td>Foreses sample out of the SIP.</td>
</tr>
<tr>
<td>SIP Clean</td>
<td>Performs a SIP Clean to clean the inside of the SIP.</td>
</tr>
<tr>
<td>Fluidics</td>
<td>Contains a set of controls for defining flow rate and core size. See Fluidics rate (page 75).</td>
</tr>
<tr>
<td>Threshold</td>
<td>Allows you to set the event threshold to eliminate debris and noise from sample data. The default value is 80,000 on FSC-H. See Setting the threshold (page 107).</td>
</tr>
<tr>
<td>RUN/PAUSE/ADD TO</td>
<td>Button that performs the following functions:</td>
</tr>
<tr>
<td>Set Color Compensation</td>
<td>Opens the Color Compensation dialog for correcting fluorescence spillover. See Correcting fluorescence spillover (page 149).</td>
</tr>
<tr>
<td>Acquisition counters</td>
<td>Displays the following information about the most recent acquisition for the selected well (Last Run) and all acquisitions for the selected well (Cumulative) in real-time:</td>
</tr>
<tr>
<td></td>
<td><strong>Events.</strong> Number of events acquired.</td>
</tr>
<tr>
<td></td>
<td><strong>Time.</strong> Elapsed acquisition time.</td>
</tr>
<tr>
<td></td>
<td><strong>Microliters.</strong> Volume of acquired sample.</td>
</tr>
<tr>
<td></td>
<td><strong>Events/sec.</strong> Events acquired per second. When the run is completed, this is the average value.</td>
</tr>
<tr>
<td></td>
<td><strong>Events/µL.</strong> Events acquired per microliter. When the run is completed, this is the average value.</td>
</tr>
</tbody>
</table>
## Manual data collection workflow

Complete the following workflow stages to collect sample data with the BD CSampler Plus software.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1     | In the Manual Collect tab, do one of the following:  
  • Select a plate type. Name the plate (optional).  
  • Open a template. See Creating a workspace template (page 189). |
| 2     | Set the acquisition parameters—fluidics rate, threshold, and run limits.  
  See Setting acquisition parameters (page 72) for more information. |
| 3     | Open plots, create and apply gates. See Creating a new plot (page 157) and Creating and applying gates (page 160). |
| 4     | Run the sample. See Running samples using the Manual Collect tab (page 93). |
| 5     | (If needed) Apply fluorescence compensation values. See Correcting fluorescence spillover (page 149). |
| 6     | Save the data. See Workspace files (page 186). |

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Events</td>
<td>Permanently deletes all events from the current sample. Select the show warning checkbox to display a warning message before deleting sample data. Also contains a Data Capacity Used meter that displays the amount of data storage capacity currently used in software.</td>
</tr>
<tr>
<td>Plots pane</td>
<td>Area displaying two rows of plot corrals for graphically viewing data for the selected sample. Scroll up or down to view additional plots. You can create multiple plots for each sample. Each plot corral contains buttons for creating histogram, dot, and density plots. See Plots and gates (page 156).</td>
</tr>
<tr>
<td>Statistics table</td>
<td>Table below the plots that displays statistical information on all plots.</td>
</tr>
</tbody>
</table>
## Running samples using the Manual Collect tab

### Introduction
This topic describes how to run samples using the Manual Collect tab after all acquisition parameters are set.

### Before you begin
Set the acquisition parameters. See Setting acquisition parameters (page 72).

### About collecting sample data
- Before data collection can begin, the software must display a green traffic light with the message *Cytometer is connected and ready.*
- Each data well holds a maximum of 1 million events. You can add more events (up to a total of 1 million) to a well already containing data.
- When a well already contains data, the RUN button displays ADD TO.
  
  Note: Run limits may need to be adjusted to accommodate additional data.

### Procedure
To manually run the sample with the BD CSampler Plus software:

1. Select a plate type from the Plate Type list.
The software prompts you to save the workspace file.

The sample grid displays the available wells for data collection, based on the assigned plate type:

- **96-well plate.** Displays wells for rows A-H, columns 1-12
- **48-well plate.** Displays wells for rows A-F, columns 1-8
- **24-tube rack.** Displays wells for rows A-D, columns 1-6

Note: Changing the plate type automatically opens a new blank workspace.

2. (Optional) Name the plate by typing a label in the Plate Name field.

3. Type the sample name into the text box above the 96-well grid.
You can name samples at any time. If you do not type in a name, the sample is named according to the well location (for example, A01).

4. Resuspend the cells in the sample tube or plate, and load the tube rack or plate.

5. Select a well in the sample grid that corresponds to the sample location in the plate or tube rack.

6. Click **RUN** to start the sample collection.

   Fluidics initialization begins. During this time the traffic light turns yellow and the message *Preparing to analyze sample* is displayed.

   Once initialization is complete, the traffic light turns green and the message *Cytometer is running* is displayed.

   The well flashes blue during data collection. After the run limit is reached, the well stops flashing and remains blue, indicating that the well contains data.

7. If you are running unlimited, click **PAUSE** to stop acquisition.

   **Note:** If desired, you can collect more data in a well that contains data at any time by selecting the well and clicking **ADD TO**. See *Adding more sample data to a CSampler Plus file* (page 96).

8. To run the next sample, click the next well in the sample grid. If necessary, adjust the acquisition parameters, then click **RUN**.

   To have the next sample well automatically selected, select **Display > Auto-Select Next Well**. Choose horizontally or vertically and click **OK**. When the run limit for a sample is reached, the next sample well is automatically selected. You
need only click **RUN**. If you are running unlimited, the
collection will stop when 1 million events are acquired.

![Auto-select next well](image)

**Agitating samples**

**Note:** The agitate feature is designed to maintain a sample in
suspension, not to resuspend a completely settled sample.

**Caution**  Sample volume should not exceed 50% well
capacity to effectively maintain suspension while
avoiding spillover during agitation.

**To perform an agitate cycle:**

1. Click **Agitate**.

**Rinsing the SIP between samples**

A rinse cycle can be used to rinse the SIP between samples. The SIP
goes to the water tube in the square location of the CSampler Plus
tray and aspirates the contents of the SIP up then out of the SIP,
then rinses the SIP with clean fluid.

**To rinse the SIP:**

1. Click **SIP Rinse**.

**Adding more sample data to a CSampler Plus file**

You can collect new samples and add the data to a CSampler Plus
workspace file that already contains data, by adding data to a well
that already contains data or to an empty well.

**To add data to a CSampler Plus file:**

1. Resuspend the sample and load the plate or tube rack.
2. Click a data well in the sample grid.

   If you select an empty well, any plots and gates you created earlier are still displayed, but they do not contain data.

3. Click **RUN** (or **ADD TO**) to start acquisition.

   The flow cytometer stops sampling from the tube or well when the run limit is reached.

   **Caution** If you click **ADD TO**, the software will collect data into a well that already contains data.

---

### Pausing data acquisition

You can interrupt sample acquisition any time during a run.

**To pause a run:**

1. Click **PAUSE**.

**To restart the run:**

1. Click **ADD TO**. The software resumes data collection in the current well.

   If you want to delete the data that was already collected before you paused, click **Delete Events**, then click **RUN** to acquire new data.

---

### Ending a data acquisition session

When you finish collecting samples, clean the SIP to ensure cells or other particles are not left in the SIP.

**To clean the SIP:**

1. Click **SIP Clean**.
A dialog opens prompting you to load tubes of BD FACSClean and water.

2. Ensure the following tubes are in the designated locations on the CSampler Plus. If necessary, click Eject Rack/Plate and insert the tubes, then click Load Rack/Plate.
   - 2 mL of BD FACSClean in the triangle location.
   - 2 mL of DI water in the circle location.
3. Click SIP Clean.

More information
- Creating a live gate (page 166)
# Auto Collect tab

## Introduction

This topic describes the Auto Collect tab in the BD CSampler Plus software.

## About the Auto Collect tab

The Auto Collect tab allows automated sampling from a well plate or sample tube rack. The tab contains buttons and controls for performing the following functions:

- Loading and ejecting a plate
- Creating sets of samples with the same acquisition settings
- Acquiring data
- Setting thresholds and stop criteria
- Controlling the fluidics
- Rinsing the SIP between samples
- Agitating (resuspending) samples
- Viewing sample information

## Viewing the Auto Collect tab

The Auto Collect tab is organized into two major sections:

- **Instrument Control Panel.** Panel on the left side of the window that contains controls for collecting data.
- **Sample Annotation table.** Large table on the right side of the window used to name samples, rename parameters, and add a notation to each sample.
The following table describes each of the controls and indicators in the Auto Collect tab.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Type</td>
<td>List for selecting the plate type.</td>
</tr>
<tr>
<td>Load Plate/Eject Plate</td>
<td>Moves the sample plate into position to be loaded onto or ejected from the flow cytometer.</td>
</tr>
<tr>
<td>Plate Name</td>
<td>Text box for naming the plate.</td>
</tr>
</tbody>
</table>
## Chapter 6: CSampler Plus data acquisition

### Sample grid

Matrix laid out in the configuration of a multi-well plate to help organize experiments and collect data from sample tubes or wells. Each sample is acquired into its own well in the sample grid. The wells are color-coded:

- **White.** Does not contain data.
- **Colored fill.** Acquisition settings are applied. Each unique acquisition setting is indicated by a color change.
- **Small blue box.** Contains data.
- **Red outline.** Currently selected for viewing or collecting data.

### Traffic light and message

Indicator that displays software readiness and system messages. Before data collection can begin, the software must display a green traffic light with the message *Cytometer is connected and ready.*

The Traffic Light status is color-coded:

- **Green.** Software is ready to collect data or is collecting data.
- **Yellow.** Cytometer is preparing to perform an action, performing an action other than data collection (such as cleaning or agitating), or a non-critical error has occurred.
- **Red.** Critical error has occurred or the CSampler Plus has collided.

### Run Limits

Contains a set of controls that allow you to define criteria for automatically stopping data collection.

### SIP Rinse Settings

Allows you to select a SIP Rinse cycle to perform between each sample. See *Rinsing the SIP between samples* (page 96).

### Fluidics

Allows you to set the flow rate. See *Setting the fluidics rate* (page 107). Custom flow rates are not available in the Auto Collect tab.

### Set Threshold

Sets the event threshold to eliminate debris and noise from samples. The default value is 80,000 on FSC-H. You can also set a secondary threshold. See *Threshold* (page 79).

### Apply Settings/Remove Settings

To apply or remove sample settings, such as run limits, fluidics, threshold, and SIP rinse settings.

### Agitate Plate

Performs an agitate cycle to keep particles in suspension. See *Agitating samples* (page 108).
Use the following workflow to run samples using Auto Collect.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Creating plot displays and gates in the Manual Collect tab.</td>
</tr>
<tr>
<td>2</td>
<td>Display the Auto Collect tab and select the plate type.</td>
</tr>
<tr>
<td>3</td>
<td>Create sample sets with specified acquisition, agitation, wash settings, and run direction. See Creating sample sets for Auto Collect experiments (page 103). Agitate settings are applied to the entire plate, while acquisition parameters, wash settings and run limits can be applied to individual sample sets.</td>
</tr>
<tr>
<td>4</td>
<td>Create the Sample Annotation table. See Creating the Sample Annotation table (page 110).</td>
</tr>
<tr>
<td>5</td>
<td>Open the Run Display.</td>
</tr>
<tr>
<td>6</td>
<td>Select the plots to view during acquisition. Plots created in the Manual Collect tab are available for viewing. You can view two plots at a time in the Auto Collect Run Display.</td>
</tr>
<tr>
<td>7</td>
<td>Run the samples. See Running samples using the Auto Collect tab (page 112).</td>
</tr>
</tbody>
</table>
Creating sample sets for Auto Collect experiments

Introduction

This topic describes how to create sample sets to use with Auto Collect.

About sample sets

A sample set is a group of samples that use the same data acquisition criteria (such as number of events or threshold setting). Acquisition criteria include:

- Run limits (number of total or gated events, sample volume, or time)
- Fluidics settings
- Wash settings
- Threshold(s) (default is FSC-H 80,000)

Each sample set is highlighted in a different color. Twelve colors are available, but up to 96 sets can be created (colors are reused).

If you are not creating sample sets and all samples will have the same collection criteria, proceed to Setting parameters for Auto Collect experiments (page 106).

Caution  When a plate run is started, data will be collected in every well with settings applied, regardless of whether the well contains previously acquired data.

Procedure

To create sample sets:

1. Select one or more wells to include in the set by doing one of the following:
   - Click on individual wells.
   - Click a column (1-12) or row header labels (A-H) to select the entire column or row. Multiple rows and columns can be selected simultaneously.
   - Click Select All above the sample grid to select all the wells.
Selected wells contain a black check mark.

2. Enter settings for the following:
   - Run limits
   - (Optional) SIP Rinse Settings
   - Fluidics
   - Threshold – default is FSC-H 80,000

See Setting parameters for Auto Collect experiments (page 106) for more information.

If run limit or fluidics settings were modified in the Manual Collect tab, those settings do not carry over in the Auto Collect tab. Threshold settings and color compensation settings do carry over.

3. Click Apply Settings.

The selected samples are highlighted in one color. If you have not already saved the workspace file, you will be prompted to name the file and designate a location.
All sample settings are saved each time you click Apply Settings. Acquisition settings displayed in the Control Panel do not change. To see the actual settings for a specific set, press Ctrl and click a well of interest within the set.

4. If applicable, select the next set of samples, set the acquisition parameters, and click **Apply Settings**.

The selected samples are highlighted in a new color.

**Viewing sample settings**

To view data acquisition settings for a particular well:
1. Press Ctrl and click a well of interest.

**Modifying sample settings**

To modify a set after it is created:
1. Do one of the following:
   - Double-click on a well in the set to select the entire set.
   - Select one or more wells within the set.
2. Adjust the data acquisition settings.
3. Click **Apply Settings**. The selected wells change to a new color.

### Removing sample settings

To remove settings from a sample set:

1. Do one of the following:
   - Double-click on a well in the set to select the entire set.
   - Select one or more wells in the set.
2. Click **Remove Settings**.

Each selected sample well reverts to a white box and is removed from the set.

Acquisition settings displayed in the Control Panel do not change.

### Setting parameters for Auto Collect experiments

#### Introduction

This topic describes how to set the run limits, fluidics rate, threshold, agitate, and run direction settings for Auto Collect experiments.

#### Setting run limits

The run limit defines when data acquisition will stop. The following parameters can be used individually or in combination to set a run limit.

- Number of events (total or in a specified gate)
- Time
- Volume

If multiple run limits are set, data collection stops on whichever limit is reached first. If run limit settings were modified in the Manual Collect tab, they do not carry over in the Auto Collect tab.

See **Run settings (page 73)** for more information about setting run limits.
Chapter 6: CSampler Plus data acquisition

Setting the fluidics rate

The cytometer can accommodate an upper limit of 10,000 events per second, but it is recommended to acquire samples at a rate of 2,500 events per second or less to ensure the best data resolution.

If fluidics settings were modified in the Manual Collect tab, they do not carry over in the Auto Collect tab.

To set the fluidics rate:
1. Click the Slow, Medium, or Fast button in the Fluidics section of the Auto Collect tab.
   - Slow is 14 µL/min.
   - Medium is 35 µL/min.
   - Fast is 66 µL/min.
   You cannot customize the flow rate or the sample stream core size in Auto Collect experiments.

Setting the threshold

Use thresholds to eliminate light scatter and/or fluorescence signals caused by debris in cell samples and electronic noise inherent in the system.

To set the threshold:
1. Select the threshold parameter and enter the channel value in the less than text box.
2. (Optional) Select a secondary threshold parameter and enter the channel value in the text box.

Both thresholds are applied to every event.

See Threshold (page 79) for more information about setting thresholds.

Rinsing the SIP between samples

Multiple rinse cycles of the SIP can be specified in the Auto Collect tab. Up to three rinse cycles can be specified at a time.

- One wash cycle typically reduces carryover to < 1.0%.
- Two wash cycles typically reduce carryover to < 0.1%.
The specified SIP rinse cycles are performed after each sample acquisition, and can be applied to individual wells.

**To rinse the SIP:**
1. Select the number of cycles from the **SIP Rinse Settings** menu.

```
SIP Rinse Settings
None
None
1 Cycle
```

The number of SIP rinse cycles you select will be performed after every sample.

**Agitating samples**

The agitate feature is designed to keep samples in uniform suspension during data collection. Agitate gently shakes the sample plate/tube rack in 15-second cycles.

One, two, or three agitation cycles can be automatically performed from the Auto Collect tab during the plate run.

You can specify whether to agitate after a given number of samples or in intervals from 1 to 30 minutes. If the interval is reached during acquisition, the cytometer will complete data acquisition before performing the agitation.

Agitation is only performed when the SIP is clear of any well or tube and does not interrupt data collection.

**Caution**  Sample volume should not exceed 50% well capacity to effectively maintain suspension and avoid spillover during agitation. For best results, use 96-well U-bottom plates or standard 12x75-mm tubes.

Agitate settings are applied to the entire plate or tube rack and cannot be applied to individual wells.

**To set an agitate cycle:**
1. Select one of the following options:
• To agitate before a given number of wells, click the top button.
• To agitate after a given number of minutes, click the bottom button.

2. Select the number of 15-second agitate cycles (1, 2, or 3).

3. Do one of the following:
   • Type in the number of wells to increment between agitate cycles.
   • Type in the number of minutes to increment between agitate cycles.

**Setting the run direction**

Data can be collected from plates either horizontally (A1, A2, A3, etc) or vertically (A1, B1, C1, etc).

To set the run direction:

1. Do one of the following:
   • Click **Run Horizontally** to collect the samples horizontally.
   • Click **Run Vertically** to collect the samples vertically.
Creating the Sample Annotation table

Use the Sample Annotation table to name samples, rename parameters, and add a notation to each sample. Information can be entered manually for each sample or copied and pasted from a spreadsheet program.

<table>
<thead>
<tr>
<th>Well</th>
<th>Sample Name</th>
<th>Rename PL1</th>
<th>Rename PL2</th>
<th>Rename PL3</th>
<th>Rename PL4</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01</td>
<td>Unnamed</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A02</td>
<td>CD45 PE-Cy7</td>
<td></td>
<td></td>
<td>CD45 PE-Cy7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A03</td>
<td>CD3, CD45</td>
<td>CD3 FITC</td>
<td></td>
<td>CD45 PE-Cy7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A04</td>
<td>CD3, CD4, CD8, CD45</td>
<td>CD3 FITC</td>
<td>CD4 PE</td>
<td>CD45 PE-Cy7</td>
<td>CD8 APC</td>
<td></td>
</tr>
</tbody>
</table>

To manually create the Sample Annotation table:
1. For each sample well, click in each cell and type the appropriate information. The parameter names entered in the Sample Annotation table will also be applied to data plots.

To copy and paste information from a spreadsheet:
1. Highlight fields in the spreadsheet.
2. Press Ctrl + C to copy.
3. In the Sample Annotation table, click on Sample Name of well A1 (or other appropriate cell).
4. Press Ctrl + V to populate the Sample Annotation table with the highlighted data from the spreadsheet.

Opening the Run Display

The Run Display is used to begin, view, interrupt, and abort data collections in Auto Collect.

The Run Display contains the following elements:

- Status banner above the plots
- Two large plots
- Data acquisition counters
- Two pause options

To open the Run Display:
1. Apply settings to one or more wells (see Creating sample sets for Auto Collect experiments (page 103)).
2. Click **OPEN RUN DISPLAY**. The Run Display opens in the main panel of the Auto Collect tab.

To close the Run Display and return to the Sample Annotation table:

1. Click **CLOSE RUN DISPLAY**.
Running samples using the Auto Collect tab

Introduction
This topic describes how to acquire data in the Auto Collect tab.

Before you begin
- Set up plots and regions in the Manual Collect tab. You can display two plots in the Auto Collect tab. See Creating a new plot (page 157) and Creating and applying gates (page 160).

About collecting sample data
The BD CSampler Plus software begins data collection in the first well that has settings applied (most commonly A1) and progresses horizontally or vertically as defined in the settings.

As data is acquired and the CSampler Plus advances through the plate or tube rack, the software displays a small, blue square in the upper left corner of each completed well.

A red border around a well indicates the sample that is currently being acquired. The current well also flashes blue during data acquisition.

Caution Data is collected into all wells with settings applied, even if they already contain data.

Procedure
To begin data acquisition using the Auto Collect tab:
1. Click the Auto Collect tab.
2. Select a plate type from the Plate Type menu.
The software prompts you to save the workspace file.

The sample grid displays the available wells for data collection, based on the assigned plate type:

- **96-well plate.** Displays wells for rows A-H, columns 1-12
- **48-well plate.** Displays wells for rows A-F, columns 1-8
- **24-tube rack.** Displays wells for rows A-D, columns 1-6

**Note:** Changing the plate type automatically opens a new blank workspace.

3. Name the plate by typing a label in the **Plate Name** field.

4. Define acquisition settings and create sample sets. See Creating sample sets for Auto Collect experiments (page 103).

5. Create the Sample Annotation table. Creating the Sample Annotation table (page 110).

6. Click **OPEN RUN DISPLAY** and select the plots to display.

7. Click **AUTORUN.** The status banner displays the current well and the message *Cytometer is running.*

The Run Display also updates the acquisition counters and the sample data in the plots.
8. When data collection is complete, DONE! is displayed prominently across the Run Display.
9. When a plate is complete, click **CLOSE RUN DISPLAY** to close the Run Display and return to the Sample Annotation table.

**Stopping data collection**

To stop a run after it has started:

1. Click on one of the following buttons:
   - **INTERRUPT PLATE** completes acquisition for the current well, then stops.
   - **ABORT WELL** stops immediately before completing acquisition for the current well. Restarts acquisition with the next well.
To restart a run:

- To restart during an Interrupt plate state, click AUTORUN. The software continues acquiring data where it left off.

- To restart a run during an Abort well state, do one of the following:
  - To begin collecting the sample in the next well, click AUTORUN.
  - To continue collecting from the same well, close the run display on the Auto Collect tab, select the Manual Collect tab and run the sample manually.

### Viewing sample plots

All plots created in the Manual Collect tab are listed in the Select Plot list beneath the plot window. They can be selected at any time during data collection. Two plots can be viewed at a time.

Plots can only be added, modified, or deleted from the Manual Collect tab.

![Events are being recorded.](image)

**To view plots:**

1. Select plots to view from the Select Plot list under each plot corral.

### More information

- Creating a live gate (page 166)
Ending a data acquisition session

Introduction
This topic describes how to save the workspace file and clean the SIP at the completion of a run.

Saving the workspace file
To save the workspace file at the end of the run:
1. Select File > Save.

Performing a SIP clean
When you finish collecting samples, clean the SIP to ensure cells or other particles are not left in the SIP. If you select Run SIP Clean after samples at the bottom of the Control Panel, a SIP Clean will be performed automatically at the end of the run.

To clean the SIP if it is not performed automatically at the end of the run:
1. Click the Manual Collect tab.
2. Click SIP Clean.

A dialog opens prompting you to load tubes of BD FACSClean and water.

3. Ensure the following tubes are in the designated locations on the CSampler Plus. If necessary, click Eject Rack/Plate and insert the tubes, then click Load Rack/Plate.
   - 2 mL of BD FACSClean in the triangle location.
   - 2 mL of DI water in the circle location.
4. Click SIP Clean.

More information

- Creating a live gate (page 166)
Data analysis

This chapter includes the following topics:

- Analyzing sample data (page 120)
- Setting up analysis plots (page 124)
- Creating an overlay histogram (page 127)
- Viewing data in plots from the Plot List (page 125)
- Statistics tab (page 130)
- Previewing a plot in the Statistics tab (page 132)
- Adjusting peak position with VirtualGain (page 134)
- Copying analysis data into other applications (page 142)
- Analyzing batches of samples (page 142)
- Compensation (page 146)
Analyzing sample data

Introduction

This topic describes the Analyze tab and the controls and indicators within the workspace.

About the Analyze tab

The Analyze tab allows you to simultaneously view data from multiple samples using the same plots and gating.

Use the tab to do the following:

- View several plots and samples in any combination for easy analysis.
- Compare specific samples from the sample-well grid.
- Create new plots, hide or delete plots, and copy plots from the Collect (or Manual Collect) tab.
- View different samples with the same plots.
- Create regions and markers.
- Create color overlay histograms.
- Print plots.
- Adjust peak position.
- Calculate median statistics.

Viewing the Analyze tab

The Analyze tab is organized into two major sections:

- **Setup panel.** Panel on the left side of the window that contains controls for selecting samples and plots.
- **Data display.** Large area on the right side of the window that shows sample data in plots and in a statistics table.

When you open the Analyze tab for the first time, the workspace is empty. Plots can be copied from the Collect/Manual Collect tab or created from scratch. Gating strategies that were set up in the Collect (or Manual Collect) tab can be applied in Analyze, or new gates can be drawn and new gating strategies set up.
Analyze tab controls

The following table describes each of the controls and indicators in the Analyze tab:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Type</td>
<td>Disabled in the Analyze tab. For the BD CSampler Plus software only.</td>
</tr>
<tr>
<td>Plate Name</td>
<td>Text box for naming the plate. For the BD CSampler Plus software only.</td>
</tr>
<tr>
<td>Sample naming field</td>
<td>Text box for naming the current sample.</td>
</tr>
</tbody>
</table>
Sample grid Matrix laid out in the configuration of a 96-well plate to help organize sample data. Each sample has its own well in the sample grid.

The wells are color-coded:
White. Does not contain data.
Blue. Contains data.
Black check mark. Currently selected for viewing data.

Copy Plots from Collect Copies specified plots from the Collect (or Manual Collect) tab.
See Copying plots from the Collect or Manual Collect tab (page 124) for more information.

Make a new plot Buttons for creating new plots or overlaying histograms.
See Creating a new plot (page 157) for more information.

Plot List Lists the plots that are available in the Analyze tab. Available plots include plots copied from the Collect tab and plots created in the Analyze tab.

Set Color Compensation Opens the Color Compensation Matrix for correcting fluorescence spillover.
See Correcting fluorescence spillover (page 149) for more information.

Plot Corrals Area displaying two rows of plot corrals. Scroll up or down to view more plots.

Statistics table Table below the plots that displays statistical information for individual plots.
Statistics tables can be copied into most Microsoft Office compatible programs.
Example data file for analysis

An example data file of a four-color analysis of human peripheral blood (HPB 4 Color Tutorial.c6) can be found on the BD Accuri C6 Plus software installation disc. The data file can be used to explore the various software analysis tools.

The example file consists of data from four sample tubes used to assess the CD3+CD4+ and CD3+CD8+ cell populations. Samples were prepared by staining peripheral blood with directly conjugated antibodies, followed by red cell lysis, according to standard preparation methods. The following table describes the experimental design:

**Tube 1.** Background (unstained)

**Tube 2.** White blood cell gating control (CD45)

**Tube 3.** T-cell gating control

**Tube 4.** Experimental sample

<table>
<thead>
<tr>
<th>Fluorochrome</th>
<th>Tube 1</th>
<th>Tube 2</th>
<th>Tube 3</th>
<th>Tube 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>FITC</td>
<td>Isotype</td>
<td>Isotype</td>
<td>CD3</td>
<td>CD3</td>
</tr>
<tr>
<td>PE</td>
<td>Isotype</td>
<td>Isotype</td>
<td>Isotype</td>
<td>CD4</td>
</tr>
<tr>
<td>PE-Cy7</td>
<td>Isotype</td>
<td>CD45</td>
<td>CD45</td>
<td>CD45</td>
</tr>
<tr>
<td>APC</td>
<td>Isotype</td>
<td>Isotype</td>
<td>Isotype</td>
<td>CD8</td>
</tr>
</tbody>
</table>

This experimental design does not contain all single-stained fluorescence controls, but only those required for determining color compensation settings to correct fluorescence spillover. For details on correcting fluorescence spillover, see Correcting fluorescence spillover (page 149).
Setting up analysis plots

Introduction
This topic describes how to create plots for analysis in the Analysis tab.

Copying plots from the Collect or Manual Collect tab
In the Analyze workspace, you can copy plots from the Collect (or Manual Collect) tab or create new plots. Plots that are copied from the Collect (or Manual Collect) tab are appended with a “C” (for example, Plot 1C, Plot 2C).

If the plots you are copying contain regions and markers, the regions and markers will copy over. The gating strategy does not copy over.

To copy plots:
1. In the Analyze tab, click Copy Plots from Collect.
2. In the Copy Plots from Collect dialog, do one of the following:
   - Select the checkboxes of the plots you want to copy.
   - Select the All Plots checkbox to copy all of the plots from the Collect tab.
3. Click **OK**. The selected plots are added to the **Plot List**.

4. To display the copied plots in the data display area, click an empty plot corral, then click the plot from the **Plot List**.

5. Click the sample well that contains the data you want to view. For more information on viewing the data, see **Viewing data in plots from the Plot List** (page 125).

6. Repeat as necessary to display all plots.

---

**Viewing data in plots from the Plot List**

To view a plot in the Plot List:

1. Click on an empty plot corral in the Analyze tab.

2. Click a plot in the Plot List to open the plot. The plot is displayed without any sample data.

   Any gates copied from the Collect tab are renamed (for example, P1 in Collect is P2 in Analyze). These gates can be adjusted in the Analyze tab without changing the position of the gates in the Collect tab.

3. Click the well of the sample you want to view.
4. Apply a gating strategy, if desired. See Creating and applying gates (page 160).

5. To view data from another sample, open one or more plots from the Plot List (we recommend starting another row of plots). Click a plot, then choose the sample to be displayed in each plot. The gates that you applied above are automatically applied to the corresponding plots in the new row.

6. Compare data and statistics between samples.
Creating new plots

To create a new plot:

1. Click an empty plot corral.

2. Click one of the following Make a new plot icons:
   - Histogram
   - Dot
   - Density
   - Overlay Histogram

   An FSC-A histogram or FSC-A vs SSC-A dot or density plot is displayed.

3. Click the sample well that contains the data you want to view.

More information

- Creating and applying gates (page 160)

Creating an overlay histogram

Introduction

This topic describes how to create an overlay histogram. You can compare multiple distributions from different samples at the same time by creating an overlay histogram.

Procedure

To create an overlay histogram:

1. Click an empty plot corral.
2. Click the **Overlay Histogram** tool to open a blank single-parameter FSC-A plot.

![Overlay Histogram](image)

3. Click the x-axis label (FSC-A) and select a different parameter, if desired.

4. Click **GATE** and apply a gate, as appropriate.

5. Select the data wells to be overlaid from the 96-well grid.

![Gated Data Wells](image)
6. Click the Overlay Histogram Legend tool below the plot to view a legend for the overlay histogram.

7. (Optional) To change the color of one or more overlay plots, click the square in the Overlay Histogram Legend and select the desired color from the color palette. Click OK.
Statistics tab

Introduction

This topic describes the Statistics tab and how to create custom statistics.

About the Statistics tab

The Statistics tab provides a way of tabulating data from multiple samples in one master table. It also allows you to do the following:

- View statistics for some or all of your collected samples.
- Display statistics of collected or imported samples.
- List all plots created on the Collect (or Manual Collect) and Analyze tabs.
- Display all plot names, gates, and associated statistics.
- Cut and paste data into a spreadsheet.

Viewing the Statistics tab

The Statistics tab is organized into two major sections:

- Setup controls (Statistics Column Selector, Sample Selector, and Display Plot Preview) for the Master Statistics table
- Master Statistics table

When the Statistics tab is first opened, the workspace is empty.

To create a Master Statistics table, select statistics from the Statistics Column Selector and samples from the Sample Selector. See Creating the Master Statistics table (page 131) for more information on creating the Master Statistics table.
Statistics tab controls

The following table describes each of the controls and indicators in the Statistics tab:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot</td>
<td>Previews the selected plot.</td>
</tr>
<tr>
<td>Display Plot Preview</td>
<td>List of plots imported from the Collect and Analyze tabs that allows you to select the plot to preview.</td>
</tr>
<tr>
<td>Statistics Column Selector</td>
<td>Allows you to select the data to view in the Master Statistics table for each sample.</td>
</tr>
<tr>
<td>Sample Selector</td>
<td>Allows you to select the samples to view in the Master Statistics table.</td>
</tr>
<tr>
<td>Master Statistics table</td>
<td>Configurable table that displays data of selected samples. See Creating the Master Statistics table (page 131).</td>
</tr>
</tbody>
</table>

Creating the Master Statistics table

The Master Statistics table allows you to immediately view selected data across multiple samples. You can customize which data you want to view for each plot, and you can modify the table at any time.

To create the Master Statistics table:

1. In the Statistics Column Selector, select the checkboxes under the data items you want to view per plot. Use the Display Plot Preview to help decide which statistics to select.

   Stats are added in the order they are selected after they are grouped by plot and region.

   The software automatically adds the corresponding columns to the Master Statistics table.
2. In the Sample Selector list, select the checkbox of each sample you want to view. The software automatically adds rows of samples to the Master Statistics table and displays the sample data.

More information
- Previewing a plot in the Statistics tab (page 132)

Previewing a plot in the Statistics tab

Introduction
This topic describes how to preview a plot in the Statistics tab.
**Procedure**

To preview a plot in the Statistics tab:

1. In the Display Plot Preview list, click the plot you want to preview.

2. In the Sample Selector list, select the Preview button of a sample. The software displays the sample’s data in the plot.

   ![Sample Selector](image)

   ![Display Plot Preview](image)

   The plot preview is available for viewing only. You can modify the zoom level and other plot settings in the Analyze or Collect tab.
Adjusting peak position with VirtualGain

Introduction
This topic explains VirtualGain™ software and how it can be used to mimic voltage and amp gain adjustments to reposition data on the axis after the data has been collected.

About VirtualGain
In certain instances, a particular peak should have the same position across different samples or be located at a specific channel number, regardless of the staining. Instruments that have voltage and amp gain controls allow you to adjust peak position from sample to sample. BD CSampler Plus software uses VirtualGain instead of these controls.

VirtualGain is a software module that mimics voltage and amp gain adjustments to reposition data on the axis after the data has been collected. VirtualGain makes gross adjustments (approximate visual shifts of the data) of histogram plots. It is strictly an analysis tool and should not be used while collecting data.

For example, in the following figure, the negative peaks in the control sample and in sample 1 fall in similar channels (mean value = 28.2 and 29.7, respectively). However, the negative population in sample 2 is farther to the right (mean value = 73.4). You can use VirtualGain to align the negative peak of sample 2 with the control sample.
Applying VirtualGain

Only apply VirtualGain on a histogram plot, and only on one parameter at a time. After VirtualGain is applied, you can view data in any type of plot and toggle VirtualGain on and off.

VirtualGain is only applied to the displayed data and does not alter FCS data. The adjustment is recorded only in the data file.

To apply VirtualGain to plots:

1. In the Analyze tab, do one of the following:
   - Recreate the histogram to which you want to apply VirtualGain.
   - Copy plots from the Collect tab.
2. Apply the appropriate gating to the plots in the Analyze tab.

3. Do one of the following:
   - Select a histogram plot from the sample to which the other samples will be aligned. This sample is the standard sample.
   - Select an empty well if you want to align data to a specific channel instead of a collected sample.

4. Click the x-axis label on the standard sample and select VirtualGain.

5. In the VirtualGain dialog, do one of the following:
   - Move the peak definition marker (vertical line) in the standard sample plot to the center of the peak that will be the reference point. Other samples will be aligned to this position.
• If you selected an empty well in step 3, move the peak definition marker (vertical line) to the channel that you want to assign as the reference point.

6. If needed, use the Zoom tools in the Analyze tab to change the zoom level in the VirtualGain dialog.

7. Click the small sample grid icon in the center of the Sample to Align plot.

8. Open the sample to be aligned by clicking the corresponding blue well in the sample grid (the gray well indicates the
standard sample currently selected). Ensure that this plot has been zoomed to the required level before setting VirtualGain.
9. Move the peak definition marker in the Sample to Align plot to the center of the peak that you want to align.

10. Click **Preview** to view the aligned sample with VirtualGain applied.

    VirtualGain aligns the peak of interest in both plots.

11. Repeat steps 9 and 10 to make additional adjustments, if needed.

12. To align additional samples exactly as the first aligned sample, select **This sample** and then click the well(s) in the sample grid that you want to include.

    If the other samples need a different amount of VirtualGain, set VirtualGain separately for each one.

13. Click **Apply** to apply VirtualGain to the data.
The software displays a black asterisk under the Sample to Align plot to indicate that VirtualGain has been applied to the specified parameter for that sample.

14. Click Close to close the VirtualGain dialog.

**Viewing VirtualGain**

When VirtualGain is applied to a sample, an asterisk is displayed under the parameter label in the associated plot.

The asterisk is color-coded:

- **Black.** VirtualGain has been applied.
- **Gray.** The software is currently displaying the original data.

Overlays automatically display VirtualGain when it is applied. The asterisk is not displayed in overlays when VirtualGain is applied to some or all of the samples in the overlay.
Changing VirtualGain views

To toggle between views with VirtualGain applied and not applied:

1. Click the asterisk in the plot.
Removing VirtualGain

You cannot undo this action.

To permanently remove VirtualGain from every parameter in every sample in the data file:
1. Select Display > Remove All VirtualGain.

Copying analysis data into other applications

Introduction
This topic describes how to copy analysis data from the Master Statistics table into most Microsoft Office compatible applications.

Procedure
To copy data:
1. Use the mouse to highlight the fields you want to copy.
2. Press Ctrl+C to copy the data.
3. In the Microsoft application, press Ctrl+V to paste the data.

More information
- Copying and printing plot data (page 181)

Analyzing batches of samples

Introduction
This topic describes how to analyze batches of samples.

About batch analysis
The Batch Analysis tab allows an automated analysis to be performed on multiple samples at the same time. The plot types created during acquisition will appear at the top of the screen.

Statistics can be displayed for individual files or all selected files. The statistics displayed are default stats and can not be customized. After analysis, regions can be moved or resized on
plots for individual samples without affecting the plots for other samples.

**Viewing the Batch Analysis tab**

The Batch Analysis tab is organized into two major sections:

- **Setup panel.** Panel at the top that contains the sample grid and available plots for selecting samples and plots.

- **Data display.** Large area at the bottom that shows sample data in plots and in a Statistics table.

When the Batch Analysis tab is opened for the first time, the workspace is empty. To set up the tab, plots can be created or copied from the Collect (or Manual Collect) or Analyze tab.
The following table describes each of the controls and indicators in the Batch Analysis tab:

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample grid</td>
<td>Matrix laid out in the configuration of a 96-well plate for selecting the samples to analyze. The wells are color-coded:</td>
</tr>
<tr>
<td></td>
<td>White. Does not contain data.</td>
</tr>
<tr>
<td></td>
<td>Blue. Contains data.</td>
</tr>
<tr>
<td></td>
<td>Black check mark. Currently selected for batch analysis.</td>
</tr>
<tr>
<td>Available plots</td>
<td>Displays plots (without data) that can be included in the batch analysis. Available plots include plots copied from the Collect tab or created in the Analyze tab.</td>
</tr>
<tr>
<td>Analysis pane</td>
<td>Rows of analysis data in table and plot format, based on the plots that were selected for use in analysis. Statistics tables can be copied into most Microsoft Office compatible programs.</td>
</tr>
</tbody>
</table>

**Running a batch analysis**

To run a batch analysis:

1. At the completion of a sample run, click the Batch Analysis tab.

2. Do one or both of the following:
   - Select the Show Plots from Collect checkbox to make all of the plots from the Collect tab available for batch analysis.
   - Select the Show Plots from Analyze checkbox to make all of the plots from the Analyze tab available for batch analysis.

3. Select the specific plots to include in the batch analysis by selecting the checkboxes under those plots.
4. Select the samples to analyze in the sample grid by clicking on the wells. One row is created for each sample.

5. To show the statistics associated with samples, do one of the following:
   - Select the **Show Statistics with All Plots** checkbox to show statistics in every row.
   - Select the **Show Statistics** checkbox in individual rows to view statistics for specific samples. Regions can be moved and resized.

---

**Exporting data**

Plots and statistics can be exported in two ways, either as a Microsoft PowerPoint® file or as a Microsoft Excel® spreadsheet.

To export data:

1. Do one of the following in the lower right-hand corner of the Batch Analysis tab:
   - Click **Export to PowerPoint**.
   - Click **Export Stats to Excel**.

2. When exporting to PowerPoint, you can choose to export the statistics tables with the plots, then select where you want them to appear.
3. In the Save dialog, navigate to the destination folder, type a file name, and click Save.

More information
- Renaming plots (page 160)
- Renaming regions (page 174)
- Applying color gating (page 172)

Compensation

Introduction
This topic explains the concept of fluorescence spillover, how to recognize when spillover occurs, and how to correct it using compensation.

About fluorescence spillover
Fluorochromes typically emit light over a broad range of wavelengths, resulting in the fluorescence signal appearing not only in the expected, primary cytometer detector, but in other detectors as well.

This phenomenon is often called fluorescence spillover, and can be a source of confusion when interpreting multicolor flow cytometric data.

You can remove fluorescence spillover from plots by applying a mathematical algorithm to the data. This process is referred to as color compensation. The color compensation algorithm subtracts a percentage of fluorescence signal from every event, removing the fluorescence spillover. Because data collection on the cytometer is digital, color compensation can be applied or removed before, during, or after data collection.

Recognizing fluorescence spillover
The following figure shows data collected for a PE-Cy™7 single-stained control. Most of the fluorescence signal from PE-Cy7-positive cells was detected in FL3 (670 LP), as expected.
However, there is also PE-Cy7 signal detected in FL1 (533 BP) and FL2 (585 BP), so that data plots for those detectors appear to have positively fluorescing cells. No signal from PE-Cy7 appears in detector FL4.

Compensation window

The compensation controls in software either automatically remove (subtract) or allow you to manually remove the spillover from the non-primary detectors. You can use default settings obtained from Instrument QC, or manually enter the percentage of the signal you want to subtract from a detector. The compensation window works together with the compensation preferences. See Compensation preferences (page 148). The Well Preference at the top of the window, shows the compensation preference setting for the selected well when it was acquired.

The Reset to BD Defaults button appears when the compensation preference is set to From Instrument QC. If you modify the settings
for a well acquired using the default compensation from Instrument QC, you can use the Reset button to revert to the default QC compensation settings.

Use the **Apply to all samples** checkbox to apply the compensation settings for the selected well to all other wells, regardless of the collection status. Click the well, select **Apply to all samples**, then click **Apply**. If you wish to reset the compensation settings to the BD default values, only the selected sample will be set to the default settings; not all samples to which the settings were applied.

![Compensation Settings](image)

### Compensation preferences

The Preferences button in the compensation window allows you to select between using your own custom user-defined compensation settings or the compensation settings set by the software during Instrument QC using BD CS&T RUO beads. Instrument QC sets compensation for FITC, PE, PerCP, PerCP-Cy™5.5, and APC. If you choose to use the settings from Instrument QC, you can select to use FL3 compensation values for either PerCP or PerCP-Cy5.5. If you use fluorochromes other than those set by instrument QC, compensation will not be set for those fluorochromes. You will need to manually adjust compensation for other fluorochromes.
The option you select (either User Defined or From Instrument QC) becomes the default setting for all empty wells in the workspace. However, even if you select From Instrument QC as the default, you can still manually adjust compensation values for individual samples.

When saving a workspace template, if the compensation preference is set to User Defined, the user-defined compensation values will be saved with the template. If the preference is set to From Instrument QC, the software will use the QC values that are current when the sample is acquired.

**Correcting fluorescence spillover**

When color compensation has been properly applied to a data set, the median fluorescence channel value in non-primary detectors for any given single-stained control sample should be the same as that of an unstained control sample.

Whenever performing a multi-color experiment where manual compensation adjustment is required, prepare a set of control samples, each stained with one individual fluorochrome. These single-stained controls will allow you to determine the extent of fluorescence spillover from each fluorochrome.
To correct fluorescence spillover:

1. Add quadrant markers to the plot you want to correct by clicking the Quadrant tool then clicking inside the plot.

2. Adjust the quadrant marker position so that all positive populations are contained within individual quadrants.

   The median fluorescence channel value for the events in each quadrant is displayed in the Statistics table (shown below). No median is calculated for the first line named All or This Plot because this line contains summary data for the entire plot.

3. Compare the median values of the affected channel. If the median value of the UL or LR quadrant is not equal to the median value of the negative population (LL), you will need to adjust fluorescence compensation.

4. Click Set Color Compensation in the Collect or Manual Collect tab or select Instrument > Set compensation in the
Analyze tab to open the Compensation Settings window. The window contains four rows—one for each fluorescence channel.

**Note:** You cannot change the compensation setting for individual samples from the Auto Collect tab. However, you can change the compensation settings for any sample during analysis from the Analyze tab.

5. Do one of the following:
   - In the appropriate % text box, type an arbitrary percentage of the signal to subtract.
   - Use the Compensation Calculator to calculate the subtraction values. The Compensation Calculator is an Excel file that you can use to determine compensation values, especially for fluorochromes not calculated during instrument QC. Go to [bdbiosciences.com](http://bdbiosciences.com), navigate to the BD Accuri C6 Plus cell analyzer, and select Resources. The compensation calculator can be found under Tools.

6. Click **Preview** to update the **Statistics** table.

7. In the **Statistics** table, observe the values in the Median column of the FL channel you are correcting.
8. Repeat steps 5-8 until the median value for the UL or LR quadrant is equal (or nearly equal) to the median value of the negative population (LL).

This value is called the compensation value. The figure below shows the median values highlighted in blue.

<table>
<thead>
<tr>
<th>FL1-A</th>
<th>Mean CD45 PE-Cy7-A</th>
<th>CV FL1-A</th>
<th>CV CD45 PE-Cy7-A</th>
<th>Median FL1-A</th>
<th>Median CD45 PE-Cy7-A</th>
</tr>
</thead>
<tbody>
<tr>
<td>253.9</td>
<td>42,570.8</td>
<td>72.6%</td>
<td>NA</td>
<td>NA</td>
<td>239.0</td>
</tr>
<tr>
<td>252.9</td>
<td>11,700.5</td>
<td>70.2%</td>
<td>27.6%</td>
<td>239.0</td>
<td>15,391.0</td>
</tr>
<tr>
<td>0.0</td>
<td>0.0</td>
<td>0.0%</td>
<td>0.0%</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>269.9</td>
<td>897.2</td>
<td>87.6%</td>
<td>71.3%</td>
<td>238.0</td>
<td>771.0</td>
</tr>
<tr>
<td>7,972.8</td>
<td>1,145.5</td>
<td>27.8%</td>
<td>15.4%</td>
<td>10,188.0</td>
<td>1,322.0</td>
</tr>
</tbody>
</table>

The following figure shows the data after proper color compensation has been applied.
9. If you want to apply the fluorescence subtraction to all samples, select **Apply to all samples** in the **Compensation Settings** window, then click **Apply**.
This chapter covers the following topics:

- Plots and gates (page 156)
- Creating a new plot (page 157)
- Creating and applying gates (page 160)
- Creating nested gates (page 167)
- Modifying plots (page 175)
- Zooming a plot (page 179)
- Copying and printing plot data (page 181)
Plots and gates

Introduction
This topic describes plots and the tools used to create different types of plots, gates, and markers.

About plots
Plots allow you to view sample data in histogram, density, dot, and overlay histogram plots. You can view multiple plots for each sample you collect.

Plot tools
Each plot contains a set of gating and marking tools and a set of viewing tools.

Gating and marking tools include:

- **Gate button.** Opens the Change Gating dialog for applying gates to a plot.
- **Polygonal gating tool.** Allows you to draw a polygon around a population of events.
- **Rectangular gating tool.** Allows you to draw a rectangle around a population of events.
- **Elliptical gating tool.** Allows you to draw an ellipse around a population of events.
Chapter 8: Plots and gates

• **Quadrant markers tool.** Allows you to draw quadrants in a plot to partition the plot into four sections.

• **Hinged markers tool.** Allows you to draw hinged markers in a plot to partition the plot into four sections. Similar to quadrant markers but with more flexibility.

• **Vertical marker tool.** Used for gating histograms to the right or left of a vertical marker. Appears for histogram plots only.

• **Horizontal marker tool.** Used for gating histograms within a horizontal marker. Appears for histogram plots only.

Plot viewing tools include:

• **Plot Spec tool.** Opens the Set Plot Specs dialog for changing the x- and y-axis parameters, scaling the plot, and setting log or linear view.

• **Zoom tool.** Allows you to select a rectangular region in the plot to zoom in on.

• **Expand tool.** Zooms out one level with each click of the tool.

---

## Creating a new plot

**Introduction**

This topic describes how to create a new plot.

**Procedure**

To create a new plot:

1. Click on one of the following icons in an empty plot corral:
   - Histogram Plot
   - Dot Plot
   - Density Plot
Note: Overlay histogram plots are available from the Analyze tab during analysis. See Creating an overlay histogram (page 127).

The software displays an FSC-A vs SSC-A plot (or FSC-A, for histograms) by default.

2. Configure the plot specifications as needed.

Changing plot specifications

The Plot Spec tool allows you to change the way data are displayed in a plot. You can change the axis parameter, specify channel ranges, and toggle between linear and logarithmic scales. The Plot Spec tool is available in the Collect and Analyze tabs.

You can set up or modify plot specifications at any time before or after collecting data.
To change the plot specifications:

1. Click the Plot Spec tool.

![Set Plot Specs dialog](image)

2. In the Set Plot Specs dialog, do the following for each axis:
   - Select the parameter(s) to view from the X/Y-AXIS list(s).
   - Select linear or log to specify how data are displayed.
   - Type in the minimum and maximum channels to set the channel range you want to view.
   - Select or clear the Hide 1st decade checkbox to indicate whether you want the software to display the first decade of channels (channels 1–10) in the plot for log data.

3. Do one of the following:
   - Click Apply to apply the changes without closing the dialog.
   - Click OK to apply the changes and close the dialog.
   - Click Cancel to close the dialog without applying the changes.
Renaming plots

Plots can be renamed. By default, plots are named after the order in which the plot was created and the associate plate map well, for example *Plot 1: A01*.

**To rename a plot:**

1. Double-click the plot name.

2. In the text field, type in a new name.

3. Press Enter.

   The well number will remain in the new plot name, for example, *LWB: A01*. The new name will apply to the selected plot for all samples in the run, for example, *LWB: A02*.

   The plot name is also updated in the plot name column heading of the statistics table.

More information

- Creating an overlay histogram (page 127)

---

Creating and applying gates

Introduction

This topic describes how to create and apply gates, including a live gate used during acquisition.

About gates

A gate is a specified area that is used to designate a population of events to analyze. You can create any of the following types of gates.

- **Polygonal gate.** An irregularly shaped polygon area, with an unlimited number of segments, around a population of events.
• **Rectangular gate.** A rectangular area.

• **Elliptical gate.** An elliptical area.

• **Quadrant gate.** Quadrants to create four partitions within a plot.

• **Hinged quadrants.** Quadrant markers with a hinge at the intersection.

• **Vertical marker.** Gates a histogram plot to the right or left of a vertical marker.

• **Horizontal marker.** Gates a histogram plot within a horizontal marker.

---

**Creating a gate in a density or dot plot**

To create a gate in a density or dot plot:

1. Click on one of the following gating tools:
   - Polygon
   - Rectangle
   - Ellipse
   - Quadrants
   - Hinged quadrants

2. Use the mouse to draw a region (labeled P1 for polygon, R1 for rectangle, E1 for ellipse, Q1 for quadrants, and H1 for hinged quadrants).

   If you are drawing a polygon, click the mouse to anchor each vertex and double-click to close the polygon.
The software automatically displays the percentage of cells within the gate.

3. (Optional) You can change the gate labels by double-clicking on the label and typing a new gate name in the text box.

Creating a vertical marker in a histogram plot

You can create a single vertical marker per histogram to obtain statistics on the events to the left and right of the marker.

To create a vertical marker in a histogram plot:

1. Click the Vertical Marker tool.
2. Click the cursor at the point along the x-axis where you want to place the marker.
The percentage of cells is automatically displayed to the left (V1-L) and right (V1-R) of the marker.

You can create only one vertical marker per histogram. However, you can create one or more horizontal markers within the same histogram.

Creating a horizontal marker in a histogram plot

You can create a horizontal marker within a histogram to obtain statistics on the events within the boundaries of the marker.

To create a horizontal marker in a histogram plot:
1. Click the Horizontal Marker tool.
2. Drag the cursor horizontally across the area you want to gate.
The percentage of cells is automatically displayed within the boundaries of the marker (labeled M1).

You can create multiple horizontal markers in a histogram plot.

Deleting a gate

To delete a gate:
1. Click to select the gate.
2. Press the Backspace key on the keyboard.

If the gate is being used in other plots, a message appears warning you that the gating in other plots will be removed.

Applying a gate to a plot

To apply a gate to a plot:
1. Click GATE at the top of the plot for which you want the gate applied.

   The Change Gating dialog appears.

2. Only polygon (P), rectangular (R), elliptical (E), hinged quadrants (H), and marker (M) gates automatically appear in the Change Gating dialog list of options. If you want to view a
list of vertical markers (V) or quadrant markers (Q), select the associated checkbox(es).

If the plot to which you are applying a gate already has a gate, it will not appear in the list. Only gates in other plots appear.

3. Select one of the following gating icons to the left of the region in the list.
   - Include. To analyze the events within the region. You can choose more than one gate with Include to analyze events in either one or the other gate.
   - Exclude. To analyze the events outside of the region.
   - Intersection. To analyze the events within the intersection of two or more regions. Select this icon for each region you want to use.
4. Click **Apply**.

The software displays the type of gate that is applied next to the **GATE** button in the plot.

**Creating a live gate**

Live gating is used to exclude events outside a designated region from being displayed and stored as part of the workspace or FCS file. Any region may be used as a live gate. This selection can be remembered as part of the template if desired.

Once a live gate is used for data acquisition, there is no way of recapturing the excluded data that was not acquired.

**To create a live gate:**

1. Create a region around the population of interest (the population you want to collect).

2. Select the **Do not collect events outside** checkbox.

   **Note:** You can run unlimited or with limits.

3. Select the region from the list (for example, R1).
Only the events that appear in the selected region will be acquired.

![Run Settings](image)

More information
- Creating nested gates (page 167)
- Modifying regions (page 171)

Creating nested gates

Introduction
This topic explains nested gates and describes how to create and apply them within a plot.

About nested gates
You can create a series of nested gates in which each gate is a subset of the previous one. This allows you to fine tune your gating strategy for viewing and analyzing specific subsets of data.
Creating nested gates

To create nested gates:

1. Draw any region or marker around a population of events.

2. Click GATE in a second plot and apply the gate. See Applying a gate to a plot (page 164). This is the parent gate.
3. Close the dialog. The plot displays only the populations within the parent gate.

4. In the plot that is gated on the parent gate, draw a second region or marker around a subset of the population displayed in the plot.

5. Open a third plot and click GATE.
6. In the Change Gating dialog, select the option in which the second gate is “in” the parent gate (see the following figure). Do not select the on all events option.

![Change Gating dialog](image)

7. Apply the gate. This is the child gate.

![Child gate](image)

8. View the statistics in the Statistics table.

<table>
<thead>
<tr>
<th>Plot 1c: A03 A06</th>
<th>Count</th>
<th>Volume (µL)</th>
<th>% of This Plot</th>
<th>% of All</th>
<th>Mean FL2-A</th>
<th>CV FL2-A</th>
<th>Median FL2-A</th>
</tr>
</thead>
<tbody>
<tr>
<td>This Plot</td>
<td>62</td>
<td>36</td>
<td>100.00%</td>
<td>0.26%</td>
<td>38,990.98</td>
<td>34.66%</td>
<td></td>
</tr>
</tbody>
</table>

9. Close the dialog.
Modifying regions

Introduction

This topic describes how to modify regions by moving and resizing them and coloring the events in a region.

Moving and resizing regions

You can move or resize a region. You can also move a region label by clicking and dragging the label.

To move a region:

1. Click the border of the region. The outline appears in bold.
2. Position the cursor on the border, but not an anchor point until a four-sided arrow appears, then drag the region to the desired position.

![Diagram showing a region selection and rotation]

To resize a region:
1. Click the border of the region. The outline appears in bold.
2. Position the cursor on one of the anchor points until a two-sided arrow appears, then drag the region to resize it.

To rotate an ellipse region:
1. Click the border of the region. The outline appears in bold.
2. Position the cursor on one of the anchor points until a two-sided curved arrow appears, then drag the region to rotate it.

Applying color gating

All events within one or more regions can be designated to appear as a specified color within other histogram or dot plots. The event coloring will remain and automatically update during data acquisition.

Color will not appear in a density plot.
To assign a color to the events in a gate:

1. Create a region in a histogram, dot, or density plot.

2. Double-click the region name and click the small white square to display a color palette.

   The most commonly used colors appear on the top row.

3. Select a color.
Events that fall within the gate are now colored and displayed in the same color in other dot and histogram plots.

**Renaming regions**

Regions in a plot can be renamed.

**To rename a region:**

1. Double-click the region name.
2. In the text field, type in a new name and press Enter.
Modifying plots

Introduction

This topic describes how you can change the number of events in a plot and change the plot parameters and axes names.

Changing the number of events in a plot

You can change the number of events displayed in all plots across all samples to make it easier to view the data. This option allows you to visually remove a number of events from the plot without deleting data.

To change the number of events displayed in a plot:

1. Select Display > Events Display Settings.
2. Select the events to display:
   - To view all collected events, select Show all events.
   - To view the first N events of a sample, select Display first and type a number in the Events Collected field.
   - To view a specified percentage of the whole in a pseudo-random selection, select Display and type a percentage to
view (for example, if 20% is selected, every fifth event is displayed).

3. Click **Apply** to apply your settings without closing the dialog. Or, click **OK** to apply your settings and close the dialog.

The software displays the plot and shows a message in the plot that some events are not being displayed.

### Changing plot parameters

You can change the parameters that a plot displays for the x- and y-axes. By default, the software displays the area parameter (signified with a suffix of -A), but you can also choose a height, width, or time parameter.
To change a parameter:
1. Click the x- or y-axis label and select the option you want from the menu.

Note: The time parameter, which can be displayed on the x-axis only, starts counting when you click RUN and continues counting for 19 days (16 million tenths of a second), even if you add data to the sample at a later time. You cannot reset the parameter to zero, even by deleting data.

Renaming plot axes
You can rename the axis labels for a plot to identify the antibody staining or fluorochrome used in the sample.

To rename a plot axis:
1. Click on an axis label and select Rename Parameters/Color Compensation from the menu.
2. In the **Compensation Settings** dialog, type the new label in the text box for the parameter you want to rename.

![Compensation Settings dialog](image)

3. Do one of the following:
   - Click **Apply** to apply the label to the selected sample.
   - Select **Apply to all samples**, then click **Apply** to apply the label to all samples.
Zooming a plot

Introduction

This topic explains the zoom function you can use to zoom in on specific areas of a plot.

Zooming on a population

To zoom on a population:
1. Click the Zoom tool.
2. Drag the mouse in the plot to draw an area to zoom.
   
   The following figure shows a population before and after using the Zoom tool.

3. Repeat the zoom as needed to zoom in closer.

Zooming out

To zoom out:
1. Click the Expand tool to the right of the zoom tool.
2. Repeat as needed.
Zooming to a specified channel range

Sometimes it can be helpful to view the data within a specified channel range.

To view a specified channel range in a plot:

1. Click the Plot Spec tool in the plot you want to zoom.

2. Specify the x-axis channel range by typing a minimum (Min Value) and maximum (Max Value) value under X-AXIS in the Set Plot Specs dialog.

3. Specify the y-axis channel range by typing a minimum and maximum value under Y-AXIS.

4. Click Apply to apply the changes and click OK to close the Plot Spec dialog.
Copying and printing plot data

Introduction
This topic describes how to copy and paste plots into third-party software and how to print plot data.

Copying and pasting plots
To copy and paste plots from the Collect or Analyze tab:
1. Click anywhere on a plot and drag it to an open Microsoft® Office compatible application.

You cannot use Ctrl+C and Ctrl+V to copy and paste plots from the software into other applications.

For information on copying and pasting plots from the Collect tab to the Analyze tab, see Copying plots from the Collect or Manual Collect tab (page 124).

Selecting a drag and drop format
You can select one of two file formats for plots during drag and drop actions.

To select the file format to use:
1. Select File > Set Plot Drag and Drop Format.
2. Choose one of the following formats:
   - Select .png when lower resolution is sufficient. Drag and drop to Excel requires .png format.
   - Select .eps when higher resolution images are required for publication or posters.
The Drag and Drop Format selection is file-specific, and will always revert to the default of .png when a new C6 Plus file is created or if the current file is not saved with the .eps option selected.

3. Click OK to save the settings and return to the workspace.

**Printing plots and statistics**

You can print selected plots and their associated statistics from the Collect or Analyze tab.

**To print plot data:**
1. Select the checkbox in the upper-left corner of each plot that you want to print.

2. If you do not want to print the associated Statistics tables, clear the checkbox in the upper-left corner of each table.

3. Select File > Print Selected Items.

**More information**
- Copying plots from the Collect or Manual Collect tab (page 124)
- Copying analysis data into other applications (page 142)
Managing data

This chapter covers the following topics:

- Managing files (page 184)
- Workspace files (page 186)
- Creating a workspace template (page 189)
- Exporting and importing data (page 190)
## Managing files

### Introduction
This topic describes the files generated by BD Accuri C6 Plus software.

### About C6 Plus files
The BD Accuri C6 Plus system generates the following files.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCS</td>
<td>FCS 3.1 files are not saved by default, but can be exported at any time following acquisition. See Exporting and importing data (page 190) for information.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Workspace files contain the entire workspace and all elements associated with the workspace, including the sample data. See Workspace files (page 186) for more information. Workspace files are saved to the location you select when prompted to save the file.</td>
</tr>
<tr>
<td>Results CSV</td>
<td>CSV files are saved only if you select to save them. A single CSV file is saved for each sample. Files are saved to the location you choose. See Exporting and importing data (page 190) for more information.</td>
</tr>
<tr>
<td>QC reports</td>
<td>A QC report is saved for each instrument QC test. Reports are saved to C:Cytometer Support Files\Instrument QC reports.</td>
</tr>
</tbody>
</table>

**Note:** Levey-Jennings reports can be printed, but they cannot be saved or exported.

### Removing QC report files from the previous QC list
You can remove old QC runs that appear in the history file. See Viewing previous QC results (page 61).

1. Navigate to C:Cytometer Support Files\InstrumentPerformance.

    Each QC results file is listed as InstrumentPerformanceyyyy-mm-dd-hh_mm.ipr.
2. Delete the QC results files you no longer need.

The QC results for the dates you deleted will no longer appear in the history file list. However, the results will still appear in the Levey-Jennings plots.

Removing bead lots from the CS&T bead lot menu

You can remove old CS&T RUO bead lots so that they no longer appear in the bead lot menu on the QC workspace.

1. Navigate to C:\Cytometer Support Files\InstrumentPerformance\BeadLots.

   Bead lot files have the extension .bls.

2. Delete the bead lot files you no longer need.

   The deleted bead lots will no longer appear in the BD CS&T Bead Lot menu on the QC workspace. If you need to replace a deleted bead lot, do not copy the file into this folder. You must reinstall bead lots using the software. See Install a new bead lot (page 60).
Workspace files

Introduction

This topic describes how to save the data to a workspace file.

About saving workspace files

Always save data as a workspace file (.ci). A workspace file is a comprehensive (and often large) file that contains instrument settings, FCS files, and plot layouts.

The file contains the entire workspace, including the following elements:

- Sample data
- Plot layouts
- Parameter names
- Zoom levels
- Gating
- Color compensation
- Threshold settings
- Collect (or Manual Collect) tab settings
- Changes made in the Analysis or Statistics tab

When a file is saved, the software displays the file name in the upper-left corner of the workspace.

Auto-saving data

By default, the software automatically saves the event data any time the cytometer reaches a run limit or if you click Pause during a run. Auto-save does not save changes to acquisition settings, plots, or gating strategies that occur after the initial save when naming the file.
Chapter 9: Managing data

To save the entire workspace file, save the file manually.

Caution  If you make changes after a run or after pausing a run, the software does not automatically save the file. Save these changes manually.

To enable or disable auto-save:
1. Select File > Auto-save Data Settings.
2. Do one of the following in the Auto-save Data Settings dialog:
   - Select Auto-save Data Enabled to enable auto-save.
   - Select Auto-save Data Disabled to disable auto-save.
3. Click OK.
4. If prompted to save the workspace before closing, do one of the following:
   - Click Yes to save the entire workspace.
   - Click No to exit the dialog without saving the most recent changes.

Manually saving files

You can manually save a workspace file at any time.

Note: For BD CSampler Plus software, you will be prompted to save the workspace file after you select the plate type.

To manually save a workspace file:
1. Select File > Save.
If this is the first time the file is being saved, a save dialog appears. Enter a file name and click **Save**.

**To save a workspace file with a new name:**

1. Select **File > Save workspace as**.

2. Navigate to the location where you want to save the file, enter the file name, and click **Save**. The file is saved with the extension `.ci`.

---

**Opening a new workspace**

A new workspace displays a single FSC-A versus SSC-A density plot that is pre-zoomed to channel values of 1,600,000 and 800,000, respectively. Run settings are set to **Run Unlimited**, the primary threshold is set to channel 80,000 on the FSC-H signal. Compensation is set to the values defined by the last Instrument QC run performed, unless user defined compensation is selected.

**To open a new workspace:**

1. Do one of the following:

   - If the software is not already open, double-click the BD Accuri C6 Plus software icon (or BD CSampler Plus software icon) on the desktop. The software opens with a new workspace.

   - If the software is already open, select **File > New workspace**. Only one workspace can be open at a time. If desired, save any unsaved changes to the previous workspace when prompted.

A new workspace can be used to collect a new data set and create an analysis template.
## Creating a workspace template

### Introduction
This topic describes the workspace template and provides instructions for creating a new template.

### About templates
A workspace template contains a predefined workspace for quick and easy setup and analysis.

All markers, regions, gates, parameter names, and sample names are saved without any data points. Acquisition settings are saved based on the currently selected sample. If you selected User Defined compensation settings, those settings will also be saved.

Several templates are available at bdbiosciences.com. You can also create your own customized templates. Templates created in BD Accuri C6 software are compatible with BD Accuri C6 Plus software.

### Creating a workspace template
To create a template:

1. Define the plots, gating, and acquisition settings in a blank workspace, or use the current .ci file.
2. Select File > Save template as.
3. Navigate to the location to save the file, enter the file name, and click Save. The file is saved with the extension .cit.
Exporting and importing data

Introduction

This topic describes how to export or import files.

Exporting data

You can export sample data, including compensation settings, from all or individual sample wells as FCS 3.1 files. No gates or analysis settings are exported with the data. You can also export plot data and sample settings.

Note: Exported files are not compatible with BD CellQuest Pro or BD FACSDiva™ software.

To export data:

1. Do one of the following:
   - Select File > Export FCS File to export and save the data from the currently selected well as an FCS 3.1 file. Enter a file name and click Save.
   - Select File > Export ALL Samples as FCS to export and save the data for all wells as individual FCS 3.1 files. A default folder is created on the desktop. Click Ok.
   - Select File > Export Plot Data as CSV to save an individual file in CSV format with the information for each event in the well. Enter a file name and click Save.
   - Select File > Export Sample Settings to export acquisition criteria, sample names, parameter names, and compensation values to a CSV file. This option is available only for BD CSampler Plus software.
Importing data

Only FCS files created using BD Accuri C6 Plus software or BD Accuri C6 software can be imported into a workspace file or template.

To import an FCS data file into the software:

1. Select an empty data well in a workspace file or template. If the currently selected data well contains data, the software will start FCS file import in the first empty data well.

2. Select File > Import FCS File.

3. Navigate to the file(s), select it, and click Open.

   Multiple FCS files from within a folder can be selected and imported as a group using Shift + click. Files begin importing into the selected data well and proceed in succession, horizontally, from left to right, wrapping to the following row once the current row is filled.
This chapter covers the following topics:

- Maintenance schedule (page 194)
- Cleaning the outside of the instrument (page 196)
- Backflushing the SIP (page 197)
- Performing a SIP clean (page 198)
- Cleaning the fluidics (page 200)
- Running an extended flow cell clean (page 200)
- Cleaning the fluid bottles (page 202)
- Replacing the fluid bottle filters (page 203)
- Replacing the in-line sheath filter (page 204)
- Replacing the peristaltic pump tubing (page 206)
- Collecting precise volume measurements (page 214)
- Purging the fluid sensor lines (page 209)
- Unclogging the SIP (page 211)
- Collecting precise volume measurements (page 214)
- Aligning the CSampler Plus after a collision (page 217)
- Restarting the system after storage (page 219)
Maintenance schedule

Introduction
This topic provides a list of daily, scheduled, and unscheduled maintenance procedures.

Daily maintenance
Daily maintenance is part of the startup and shutdown procedures. See Starting up the system (page 41) and Shutting down the system (page 43). Additionally, the following procedures can be performed as needed.

<table>
<thead>
<tr>
<th>Task</th>
<th>When to perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backflushing the SIP (page 197)</td>
<td>When you suspect a clog in the SIP</td>
</tr>
<tr>
<td>Performing a SIP clean (page 198)</td>
<td>At the completion of every run or more often if desired</td>
</tr>
<tr>
<td>Cleaning the fluidics (page 200)</td>
<td>Occurs automatically during shutdown</td>
</tr>
</tbody>
</table>

Scheduled maintenance
A dialog is displayed every 60 days (or when 35 L of sheath fluid has been used) to remind you to perform scheduled maintenance. When the dialog appears, complete the maintenance, select the maintenance complete option, and click OK. If you select Remind me later, the message will appear again in 5 days.
Scheduled maintenance should be performed as described in the following table.

<table>
<thead>
<tr>
<th>Task</th>
<th>When to perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replacing the fluid bottle filters (page 203)</td>
<td>Every 2 months</td>
</tr>
<tr>
<td>Replacing the in-line sheath filter (page 204)</td>
<td>Every 2 months</td>
</tr>
<tr>
<td>Replacing the peristaltic pump tubing (page 206)</td>
<td>Every 2 months</td>
</tr>
<tr>
<td>Cleaning the fluid bottles (page 202)</td>
<td>Once a month</td>
</tr>
</tbody>
</table>

Perform the following procedures as needed.

<table>
<thead>
<tr>
<th>Task</th>
<th>When to perform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleaning the outside of the instrument (page 196)</td>
<td>At the end of each day or as needed</td>
</tr>
<tr>
<td>Filling the fluid bottles (page 36)</td>
<td>As needed or when prompted by the software</td>
</tr>
<tr>
<td>Emptying the waste bottle (page 39)</td>
<td>As needed or when prompted by the software</td>
</tr>
<tr>
<td>Running an extended flow cell clean (page 200)</td>
<td>When instructed by tech support or if you notice a decrease in instrument sensitivity</td>
</tr>
</tbody>
</table>

Unscheduled maintenance
## Cleaning the outside of the instrument

### Introduction
This topic describes how to wipe down the instrument.

### Required materials
- DI water
- 10% bleach solution, BD FACSClean solution, or 70% ethanol
- Paper towels or disposable wipes

### Procedure
To wipe down the outside of the instrument:
1. Moisten a paper towel with the cleaning solution.
2. Wipe down the outside panels and the sample stage. If you have a CSampler Plus, wipe down the CSampler Plus tray and mat.
3. Moisten a clean paper towel with DI water and wipe the areas you wiped with the cleaning solution.
4. Dispose of the paper towels as biohazard waste.

**Caution: Biohazard!** Dispose of the paper towels as biohazard waste.
**Backflushing the SIP**

<table>
<thead>
<tr>
<th>Introduction</th>
<th>This topic describes how to run the backflush cycle to remove clogs at the base of the SIP.</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the backflush cycle</td>
<td>The backflush cycle forces fluid out of the flow cell and out the SIP to remove bubbles in the flow cell and/or clogs in the SIP. Perform a backflush if you notice the event rate slowing or stopping and you suspect a clog.</td>
</tr>
<tr>
<td>Backflushing when running manually</td>
<td>To perform a backflush when running manually:</td>
</tr>
<tr>
<td></td>
<td>1. Place an empty tube on the SIP.</td>
</tr>
<tr>
<td></td>
<td>2. Select Instrument &gt; Run Backflush cycle.</td>
</tr>
<tr>
<td></td>
<td>You can also click Backflush from the control panel of the Collect or Manual Collect tab.</td>
</tr>
<tr>
<td></td>
<td>3. Click Backflush in the dialog prompting you to load an empty tube.</td>
</tr>
<tr>
<td></td>
<td>4. When the backflush is complete, discard the tube in the same way as you would any biohazardous sample to ensure no possible safety risk.</td>
</tr>
<tr>
<td>Backflushing when using a CSampler Plus</td>
<td>To perform a backflush using the CSampler Plus:</td>
</tr>
<tr>
<td></td>
<td>1. Ensure a tube containing 2 mL of DI water is located in the square location (□).</td>
</tr>
<tr>
<td></td>
<td>2. Select Instrument &gt; Run Backflush cycle.</td>
</tr>
<tr>
<td></td>
<td>You can also click Backflush from the control panel of the Collect or Manual Collect tab.</td>
</tr>
</tbody>
</table>
Performing a SIP clean

Introduction
This topic describes how to clean the SIP with BD FACSClean.

About SIP cleans
The SIP clean runs BD FACSClean through the SIP for approximately 5 minutes followed by water for approximately 5 minutes. Regular SIP cleans are vital for keeping your fluidics system clear and free of clogs.

When to run a SIP clean
We recommend always running a SIP clean at the end of each run. You can also run a SIP clean as often as you like to prevent SIP clogs.

Caution: If you leave the instrument idle for 15 minutes or longer when running samples, run a SIP clean before resuming operation to clear the SIP and prevent clogs.

Required materials
- 2 mL of BD FACSClean
- 2 mL of fresh DI water

Performing a SIP clean when running manually
To perform a SIP clean when running manually:
1. Click SIP Clean on the control panel of the Collect or Manual Collect tab.
   A dialog prompts you to load a tube containing 2 mL of BD FACSClean.
2. Load the tube of BD FACSClean and click Clean.
   When step 1 is complete, a dialog prompts you to load a tube containing 2 mL of water.
3. Load the tube of water and click Clean.
Performing a SIP clean when using a CSampler Plus

To perform a SIP clean using the CSampler Plus:

1. Click SIP Clean in the control panel of the Collect or Manual Collect tab.

A dialog opens prompting you to load tubes of BD FACSClean and water.

2. Ensure the following tubes are in the designated locations on the CSampler Plus. If necessary, click Eject Rack and insert the tubes, then click Load Rack.
   - 2 mL of BD FACSClean in the triangle location (∆)
   - 2 mL of DI water in the circle location (○)
   - Also ensure the square (□) location has a tube containing 2 mL of DI water, as the SIP is left in this tube after a SIP clean.

3. Click SIP Clean.
Cleaning the fluidics

Introduction
This topic describes how to clean the fluidics lines using the Clean Fluidics cycle.

About cleaning the fluidics
The fluidics cleaning cycle is automatically run when you shut down the instrument. You can also run it at any time, if necessary. During the fluidics cleaning cycle, BD FACSClean is run through the fluid lines, followed by sheath. A second cycle runs detergent solution through the fluid lines, followed by sheath.

The fluidics cleaning takes about 13 minutes.

Required materials
- 2 mL of DI water

Cleaning the fluidics when running manually
To clean the fluidics when running manually:
1. Place a tube containing 2 mL of DI water on the SIP.
2. Select Instrument > Run Clean Fluidics.

Cleaning the fluidics when using a CSampler Plus
To clean the fluidics when using a CSampler Plus:
1. Ensure that a tube containing 2 mL of DI water is located in the square location (□)
2. Select Instrument > Run Clean Fluidics.

Running an extended flow cell clean

Introduction
This topic describes how to run an extended flow cell clean cycle.

About an extended flow cell clean
An extended flow cell clean cycle provides a way to thoroughly clean the flow cell. Run an extended flow cell clean cycle if you notice excessive debris or high CVs during instrument QC. During
extended flow cell cleaning, the flow cell fills completely with cleaning solution from a sample tube on the SIP. The cycle automatically shuts down the cytometer, allowing the flow cell to soak with the cleaning solution.

**Required materials**
- 2 mL of BD Extended Flow Cell Clean Solution

**Procedure**

**To run an extended flow cell clean:**

1. Place a tube with at least 500 µL of Extended Flow Cell Clean Solution on the SIP.

   **Caution!** Never run an extended flow cell clean cycle without a tube containing at least 500 µL of fluid.

2. Select **Instrument > Extended Flow Cell Clean**.

   A dialog opens prompting you to install a tube of Flow Cell Cleaner on the SIP if running manually, or load a rack with the solution in position A01 if using a CSampler Plus.

3. Load the tube of Extended Flow Cell Clean Solution and click **Proceed**.

4. After the cytometer is shut down, leave it off for at least 2 hours (or overnight, for a more thorough cleaning).

5. Restart the cytometer.

   To thoroughly rinse the flow cell, the cytometer performs a full fluidics cleaning cycle at startup and the software displays the message *Extra startup time needed due to cleaning or improper shutdown*.

   **Note:** This message also appears after a power outage if the instrument was forced to shut down.

6. Discard the tube once startup is complete.
## Cleaning the fluid bottles

**Introduction**
This topic describes how to clean the sheath, waste, detergent solution, and FACSClean bottles.

**About cleaning the bottles**
Clean the bottles every month to ensure that residue and contaminants do not build up inside the bottles. Do not allow the bottle filters to dry out while you clean the bottles.

**Required materials**
- 10% bleach solution
- DI water

**Procedure**
To clean the fluid bottles:

1. Disconnect and empty all the bottles.
2. Rinse the bottles with DI water.
3. Rinse the bottles with a 10% bleach solution.
4. Thoroughly rinse the bottles with DI water 2–3 times to remove the bleach residue.
5. Refill each bottle with the appropriate fluid. See Filling the fluid bottles (page 36).
6. Replace the caps on the fluid bottles.
7. Snap the color-coded tubing back into the fittings by pushing firmly until you hear a click.
Replacing the fluid bottle filters

Introduction
This topic describes how to replace the fluid bottle filters.

About fluid bottle filters
The sheath, BD FACSClean, and detergent bottles each contain a disk filter. We recommend replacing these filters every 2 months.

Caution: Biohazard! Contact with biological specimens and materials can transmit a potentially fatal disease. Wear suitable protective clothing, eyewear, and gloves.

Required materials
- Three fluid filters (one for each bottle)

Procedure
To replace the fluidic bottle filters:
1. Disconnect the quick-connect lines from the top of each bottle.
2. Carefully remove the lid from each bottle.
3. Disconnect the filter Luer connector at the end of the fluidic tubing. Discard the filter as you would a biological sample.
The following table describes the components of the bottle cap assembly.

<table>
<thead>
<tr>
<th>No.</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fluid sensing line</td>
<td>Detects fluid in the bottle.</td>
</tr>
<tr>
<td>2</td>
<td>Disk filter</td>
<td>Filters the fluid from the bottle.</td>
</tr>
</tbody>
</table>

4. Replace the filter with the same filter type.

5. Reassemble the bottles and reconnect the quick-connect lines.

---

**Replacing the in-line sheath filter**

**Introduction**

This topic describes how to replace the in-line sheath filter.

**When to replace the in-line sheath filter**

We recommend replacing the in-line sheath filter every 2 months. If you notice a yellow discoloration, fluid leaking, or if the filter is less than 50% full, change the filter immediately.

**Required materials**

- In-line sheath filter

**Before you begin**

Write today’s date on the new in-line sheath filter to help you keep track of unscheduled filter replacements.

**Procedure**

To replace the in-line sheath filter:

1. Turn off the cytometer.

   The Clean Fluidics cycle runs for approximately 13 minutes, then the cytometer powers off automatically.

2. Lift the cytometer lid and remove the plastic storage bin.
3. Each time you change the in-line sheath filter, visually inspect all tubing and connectors for fluid leaks.

Look for liquid, dried residue, or discoloration of the metal surfaces anywhere near the tubing. If you notice any evidence of a leak, contact BD Biosciences Technical Support.

**Caution: Biohazard!** Any evidence of fluid coming from, or near, a red or clear line should be considered a biological hazard.

**Caution: Biohazard!** Wear suitable protective clothing, eyewear, and gloves. Dispose of waste using proper precautions and in accordance with local regulations.

4. Twist the Luer locks on both ends of the in-line sheath filter to disconnect the locks. Do not pull on the tubing.

5. Discard the filter.

Although sample material does not pass through this filter, we recommend discarding it in the same way as any biohazardous sample to ensure no possible safety risk.

6. Install a new in-line sheath filter by reconnecting the Luer fittings.

This filter has a male and female end to ensure that it can only be installed in the correct orientation.
7. Replace the plastic storage bin and close the cytometer lid.

8. Place a sample tube with DI water on the SIP, or if using a CSampler Plus, make sure there is a tube with 2 mL of water in the square location (□).

9. Turn on the cytometer.

**Note:** Upon startup you may see an error message indicating that a fluidics system error was detected. This error is normal after replacing the in-line sheath filter. See Hardware fault errors (page 225) for information.

---

### Replacing the peristaltic pump tubing

**Introduction**

This topic describes how to replace the tubing for the peristaltic pumps. The cytometer includes two peristaltic pumps—a sheath pump and a waste pump.

**About this procedure**

Replace the pump tubing every 2 months. We recommend replacing both pieces of tubing at the same time.

**Caution: Moving parts!** Turn off the cytometer before changing the tubing.

Tubing comes in contact with biological samples and therefore should be considered hazardous.

**Caution: Biohazard!** Contact with biological specimens and materials can transmit a potentially fatal disease. Wear suitable protective clothing, eyewear, and gloves.

**Required materials**

- Peristaltic pump tubing
Procedure

To replace the pump tubing:

1. Turn off the cytometer.
   
   The Clean Fluidics cycle runs for approximately 13 minutes, then the cytometer powers off automatically.

2. Lift the cytometer lid.

3. Squeeze the grip marks on the pump retainer clip to remove the clip.

4. Carefully pull the Luer connectors outward, sliding the fittings off the pump head.
5. Disconnect the tubing by unscrewing the plastic Luer connectors (a total of four connectors—two for each pump).

Blue tubing is connected to the sheath pump and red tubing to the waste pump.

6. Remove the pump tubing from the pump head and discard it as you would a biological sample according to standard laboratory protocols and regulations.

Sample passes through this pump tubing. Consider it biologically hazardous.

7. Install new peristaltic pump tubing by sliding the Luer fittings on the pump head and snapping the fitting in place.

8. Replace the pump retainer clip.

9. Reconnect the tubing to the Luer connectors.

   **Caution!** Ensure that the Luer fittings are connected to the correct tubing elements. Also ensure that when you tighten the fittings, the tubing does not twist or kink. If it does twist, unscrew the Luer fitting, turn it counter-clockwise, then retighten it.

10. Gently close the cytometer lid.

11. Place a sample tube with DI water on the SIP, or if using a CSampler Plus, make sure there is a tube with 2 mL of water in the square location (□).

12. Turn on the cytometer.
Note: Upon startup you may see an error message indicating that a fluidics system error was detected. This error is normal after replacing the peristaltic pump tubing. See Hardware fault errors (page 225) for information.

---

### Purging the fluid sensor lines

<table>
<thead>
<tr>
<th>Introduction</th>
<th>This topic describes how to purge the fluid sensing lines. See Replacing the fluid bottle filters (page 203) for information on the fluid sensing lines.</th>
</tr>
</thead>
<tbody>
<tr>
<td>About this procedure</td>
<td>Perform this procedure if the traffic light message indicates that the sheath is empty or the waste is full, when in fact all fluid levels are as they should be. Fluid in the sensing lines can lead to erroneous tank level messages.</td>
</tr>
<tr>
<td>Before you begin</td>
<td>Start with the instrument turned off. Ensure the sheath bottle is full and the waste bottle is empty, except for bleach. Place the sheath bottle on the benchtop where you can monitor the fluid level.</td>
</tr>
</tbody>
</table>
| Procedure | 1. Lift the cytometer lid and remove the plastic storage bin.  
2. Locate the round, finger-size access hole near the in-line sheath filter. |
3. Place your finger over the pin hole inside the access hole.

4. With your finger sealing the pin hole, turn on the cytometer.

5. Keep your finger over the hole for 30 seconds. You should see continuous bubbling in the sheath bottle.

6. After 30 seconds, remove your finger.

7. Replace the storage bin and close the lid to allow the cytometer to complete the normal fluidics startup.
# Unclogging the SIP

## Introduction
This topic describes how to use a syringe to unclog and rinse the SIP.

## About this procedure
Perform the syringe SIP unclog if the SIP is clogged and performing backflushes and SIP cleans have not fixed the problem.

## Required materials
- Two 3-mL syringe tools (assembled)
- BD FACSClean
- DI water

## Before you begin
Before using the syringe to unclog the SIP, try unclogging the SIP by performing several backflushes followed by several SIP cleans.

## Assembling the syringes
Assemble two syringe tools as follows:

1. Connect the female Luer connector, tubing, and quick-connect coupling.
2. Connect the tubing assembly to a 3-mL syringe, as shown.

![Syringe Assembly](image)

## Unclogging the SIP
To unclog the SIP:

1. Turn off the cytometer.

   The Clean Fluidics cycle runs for approximately 13 minutes, then the cytometer powers off automatically.

2. Lift the cytometer lid.
3. Disconnect the three flow cell fluid lines (blue sheath, red waste, clear purge) from the chassis by turning each connector approximately 1/8 turn counter-clockwise.

The waste and purge lines come in contact with biological samples and therefore should be considered hazardous.

**Caution!** Contact with biological specimens and materials can transmit a potentially fatal disease. Wear suitable protective clothing, eyewear, and gloves.

4. Connect the blue (sheath) and red (waste) lines to each other by aligning the connectors together and twisting slightly.

5. Fill the first syringe with BD FACSClean.

6. Ensure an empty tube is installed on the SIP.
7. Connect the syringe to the clear (purge) line by aligning the connectors and twisting slightly.

8. Slowly depress the plunger on the syringe, pushing the cleaning solution into the flow cell and out the SIP.

9. Slowly pull the plunger to pull the cleaning solution back into the syringe.

10. Repeat the push/pull cycle a few more times to ensure the clog is cleared. Finish by pushing the BD FACSClean into the tube.

---

Rinsing the SIP

**To rinse the SIP:**

1. Fill the second syringe with DI water.

2. Install an empty tube on the SIP.

   **Note:** If performing this procedure with a CSampler Plus, ensure that the tube in the quare (☐) location, in which the SIP is parked, does not overflow.

3. Slowly depress the plunger on the syringe, pushing water into the flow cell and out the SIP.

4. Slowly pull the plunger to pull the water back into the syringe.
5. Repeat the push/pull cycle a few more times to ensure the SIP is thoroughly rinsed. Finish by pushing the water into the tube.

6. Disconnect the syringe from the clear (purge) line.

7. Disconnect the blue (sheath) and red (waste) lines from each other.

8. Reconnect the three lines to the connectors in the chassis by turning each connector approximately 1/8 turn clockwise until they click into place.

---

### Collecting precise volume measurements

**Introduction**

This topic describes how to use the BD Accuri C6 Plus flow cytometer for precise volume measurements.

**About precise volume measurements**

Each BD Accuri C6 Plus flow cytometer is calibrated at the factory for accurate volume measurement. This enables the system to provide absolute cell counts per sample volume. The system displays the volume in µL and automatically calculates counts per µL for any gated population. Follow this procedure when accurate volume measurement is required during sample acquisition. For more detailed information, refer to the Technical Bulletin, A Guide to Absolute Cell Counting on the BD Accuri C6 Flow Cytometer, which can be found at bdbiosciences.com.

**Before you begin**

Ensure that the peristaltic pump tubing and in-line sheath filter have been replaced within the last 60 days.

**General guidelines**

Follow these general guidelines:

- Use 12 x 75-mm tubes (any type of plastic).
- Use Medium or Fast flow rate to measure direct volume. Do not use the Slow flow rate.
• Use sample volumes between 300 µL and 2 mL. Never acquire more than 750 µL from a single tube on the Medium fluidics setting or 1,500 µL on the Fast fluidics setting.

• Adjust sample concentrations to fall approximately within the range of $1 \times 10^3$ and $5 \times 10^6$ cells or particles/mL.

• Acquire data on the Medium or Fast fluidics setting only. Custom fluidics settings above 15 µL and 16 µm may be used, but must be validated by an independent control/count bead.

• Only acquire once from any sample tube. Sample height within the tube is critical. Replicate measurements must be obtained from separate sample tubes made by aliquoting sample into the appropriate number of equal volumes.

• Always compare the same stop limit types. Do not compare concentrations collected with volume stop counts to those collected with event stop counts.

• Always validate accurate counting by using a reference count bead in the experimental buffer, using the same sample volume and tube as in the experiment. If bead counts are within 20% of the expected value (based on information provided by the bead manufacturer), proceed with sample collection. If bead counts are not within 20% of expected values, proceed with auto-adjusting the volume settings as described below.

To auto-adjust the volume settings:

1. Ensure that the fluid levels in the sheath, BD FACSClean, and detergent solution bottles are filled and that there are no kinked fluidic lines.

2. Restart the cytometer to flush the fluid lines. When startup is complete the traffic light turns green and the software displays the message *Cytometer is connected and ready*.

3. Within 5 minutes of the completion of the startup cycle, place a 12 x 75-mm tube containing 750 µL of 70% ethanol on the SIP. Acquire 400 µL on the Fast fluidics setting.

4. Within 5 minutes of completion of the ethanol run, place a 12 x 75-mm tube containing 1,500 µL of filtered DI water on the SIP. Acquire 400 µL on the Fast fluidics setting.
5. Within 5 minutes of completion of the water run, place a sample on the SIP. See the following bullets for sample requirements. Select Instrument > Auto-adjust volume settings.

- The volume setting adjustment should be performed in the same tube as the experimental sample.
- The volume setting adjustment should be performed using a sample of the same or similar viscosity as the samples to be analyzed. For example, if lysed human peripheral blood samples are to be acquired, then lysed human peripheral blood should be used during the volume setting adjustment.
- The volume in the control sample tube should be 110 µL more than the volume used with subsequent test samples. For example, if using 1,000-µL samples, perform auto-adjust volume settings with 1,110 µL in the tube. The adjustment procedure consumes approximately 220 µL. The values determined by the cytometer are based on the average sample height in the tube during the auto-adjust volume procedure.
- If sample volumes >50 µL are to be acquired from the sample tube, the auto-adjust volume should take this into account and the average volume in the sample tube during the acquisition should be used. For example, if 100 µL are to be acquired from a 1,000-µL sample, the auto-adjust volume would be 950 µL. The average volume \[\frac{(\text{Starting Volume} + \text{Ending Volume})}{2}\] during the acquisition is \[\frac{(1,000+900)}{2}\] or 950 µL.

6. The cytometer will perform an auto-adjust volume cycle, taking approximately 13 minutes. Once completed, the traffic light will revert to green and display the Cytometer is connected and ready message. Repeat fluidics validation using a reference count bead as described above.

7. If the status message indicates the auto-adjust volume procedure was successful, repeat the performance validation. If the status message indicates that procedure failed, see Auto-adjust volume settings procedure failed (page 231).

The cytometer will operate normally after a failed auto-adjust volume procedure. However, volume measurements for the
samples might be incorrect, since the cytometer reverts to the factory-set default fluidics volume settings. All other aspects of the data will be normal.

Aligning the CSampler Plus after a collision

Introduction

This topic describes how to perform a manual alignment of the rack to the SIP if the CSampler Plus arm collides with an object in its path.

About alignment

The CSampler Plus performs an alignment to verify that the tube rack is aligned to the SIP every time the flow cytometer is powered up or if the CSampler Plus arm collides into an object. A manual alignment can be performed using the software at any time.

If there is an obstruction in the path of the CSampler Plus, the software displays a red traffic light and opens a dialog indicating that a collision has occurred.

Procedure

To perform an alignment:

1. Remove any objects from the CSampler Plus mat.

2. Do one of the following:
   • If a collision has occurred, click Align in the Collision Detected dialog.
   • If a collision did not occur, select Instrument > Align CSampler Plus.
If a second collision occurs, the software automatically performs a second alignment. If the second alignment fails, contact BD Biosciences Technical Support.

Samples left in the tube rack can be recovered by turning off the cytometer and gently pushing down on the white cylindrical motor housing.
## Restarting the system after storage

**Introduction**

This topic explains how to prepare the BD Accuri C6 Plus flow cytometer for use after it has been stored for a period of time.

**Procedure**

1. Replace all fluid bottle filters—sheath, BD FACSClean, and detergent. See Replacing the fluid bottle filters (page 203).

2. Replace the in-line sheath filter. See Replacing the in-line sheath filter (page 204).

3. Fill the fluid bottles with fresh fluid and ensure the waste bottle is empty except for 200 mL of bleach. See Filling the fluid bottles (page 36).

4. Turn on the cytometer. See Starting up the system (page 41). Allow the startup fluid cycle to complete. It takes about 15 minutes.

5. Turn off the cytometer. See Shutting down the system (page 43). Allow the shutdown fluid cycle to complete. It takes about 13 minutes.

6. Turn on and off the cytometer two more times, allowing the fluid cycles to complete before cycling the power.
Troubleshooting

This chapter covers the following topics:

- Troubleshooting overview (page 222)
- Hardware troubleshooting (page 222)
- Software troubleshooting (page 227)
- Acquisition troubleshooting (page 229)
- QC troubleshooting (page 231)
Troubleshooting overview

Introduction

This topic describes troubleshooting for the BD Accuri C6 Plus system.

The Troubleshooting chapter lists problems you may encounter during normal operation. It includes:

- Hardware troubleshooting (page 222)
- Software troubleshooting (page 227)
- Acquisition troubleshooting (page 229)
- QC troubleshooting (page 231)

Additional help

If, after reading through the possible problems and recommended solutions, you still have questions or are experiencing problems, contact BD Technical Support. See Technical support (page 11) for information.

Hardware troubleshooting

Introduction

This topic describes how to troubleshoot hardware problems with the cytometer or CSampler Plus.

<table>
<thead>
<tr>
<th>Cytometer and/or computer does not power on</th>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Power supply not plugged in</td>
<td>Make sure the power supplies and cords are plugged into an appropriate outlet.</td>
</tr>
<tr>
<td></td>
<td>Power outlet malfunction</td>
<td>Check the outlet to make sure it is functioning properly.</td>
</tr>
</tbody>
</table>
### Power and event indicator lights flash on startup

#### Power and event indicator lights flash simultaneously

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waste tank full</td>
<td>Turn off the power to the cytometer. Empty the waste bottle, then restart the cytometer.</td>
</tr>
</tbody>
</table>

#### Power and event indicator lights flash alternately

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSampler Plus failed to align properly</td>
<td>Turn off the power to the cytometer. Check for obstructions, then restart the cytometer.</td>
</tr>
</tbody>
</table>

### Message “Extra startup time needed due to cleaning or improper shutdown”

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extended flow cell clean cycle was run. Fluidics error occurred during shutdown. Instrument forcibly shut down, for example power outage.</td>
<td>Allow the extended startup to run. It will take approximately 25 minutes.</td>
</tr>
</tbody>
</table>

### USB port not active or lost connection

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using a USB port on the same hub as the cytometer</td>
<td>Do not use a USB port on the same hub as the cytometer. For example, use USB ports on the front of the computer for flash drives.</td>
</tr>
<tr>
<td></td>
<td>If the USB port is not on the same hub as the cytometer, unplug the drive, wait 5 seconds, then plug it back in. If that doesn’t work, restart the computer.</td>
</tr>
</tbody>
</table>
### CSampler Plus collision

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collision message appears but no collision occurred</td>
<td>Time-out occurred because the CSampler Plus did not reach its designation in the time permitted. Select Instrument &gt; Align CSampler Plus. See Aligning the CSampler Plus after a collision (page 217)</td>
</tr>
</tbody>
</table>

### Fluid leak under storage bin

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>In-line sheath filter leaking</td>
<td>Check the Luer locks on both ends of the filter to ensure they are tight. If the filter appears yellow or is less than 50% filled with fluid, change it immediately. The filter should be submerged in fluid.</td>
</tr>
<tr>
<td>Peristaltic pump tubing not properly installed</td>
<td>Check the peristaltic pump tubing on both pumps to ensure it is properly connected to the Luer connectors.</td>
</tr>
</tbody>
</table>

### Traffic light displays message that waste is full or sheath is empty when they are not

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fluid bottle sensing lines have fluid in them</td>
<td>Purge the fluid bottle sensing lines. See Purging the fluid sensor lines (page 209).</td>
</tr>
</tbody>
</table>

### Message “Your print job failed”

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer not connected or not turned on</td>
<td>Ensure a printer is connected, either locally or through a network, and turned on.</td>
</tr>
<tr>
<td>Network down</td>
<td>If the printer is connected to a network, ensure that the network is up and running.</td>
</tr>
</tbody>
</table>
If any of the following errors occur, click Close this window, then follow the steps listed.

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The cytometer stopped because a Fluidic Stability Error occurred.</td>
<td>1. Check the fluid levels in sheath, detergent solution, and BD FACSClean bottles.</td>
</tr>
<tr>
<td></td>
<td>2. Check the retainer clips on the fluid pumps to ensure they are properly installed.</td>
</tr>
<tr>
<td></td>
<td>3. Perform a backflush, followed by a SIP clean.</td>
</tr>
<tr>
<td></td>
<td>4. Check the system’s performance by running instrument QC.</td>
</tr>
<tr>
<td></td>
<td>5. If you are running a sample, check the sample tube to ensure adequate sample, then rerun the sample.</td>
</tr>
<tr>
<td></td>
<td>6. If the problem persists, contact BD Technical Support.</td>
</tr>
</tbody>
</table>

| The cytometer stopped because a Red/Blue Laser Error occurred.         | 1. Check the system’s performance by running instrument QC.                             |
|                                                                        | 2. Rerun the sample.                                                                     |
|                                                                        | 3. If the problem persists, contact BD Technical Support.                                |

| The cytometer stopped because a Signal Processing Error occurred.      | 1. Rerun the sample.                                                                     |
|                                                                        | 2. If the problem persists, contact BD Technical Support.                                |
The cytometer stopped because an Electronic System Error occurred.

- Contact BD Technical Support.

A Fluidics System Error was detected.

If the in-line sheath filter or peristaltic pump tubing was changed, this message is normal.
1. Perform two to three backflush cycles.
2. Turn off the cytometer, then restart it.
3. If the error appears again, restart the cytometer a second time.
4. If the problem persists after two shutdown and startup cycles, contact BD Technical Support.

If the in-line sheath filter was not just changed:
1. Check the fluid bottles—fill the sheath and cleaning bottles and/or empty the waste.
2. Check the BD FACSClean (circle) and DI water (triangle) tubes on the CSampler Plus tray, if using a CSampler Plus, to ensure they contain fluid.
3. If running samples, ensure there is fluid in the sample tube.
4. Check the connections to the fluid bottles, filter, and pumps.
5. Turn off the cytometer, then restart it.
6. If the problem persists, contact BD Technical Support.
Software troubleshooting

Introduction

This topic describes problems related to the software.

Software hangs at startup and will not launch

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software launching slowly</td>
<td>Software requires more time to launch. Give the application time to launch.</td>
</tr>
</tbody>
</table>
| USB flash drive plugged into same hub as cytometer, disrupting communication | Do not use a USB port on the same hub as the cytometer. For example, use USB ports on the front of the computer for external flash drives.  
  • Disconnect flash drive.  
  • Disconnect the USB cable between the cytometer and computer, then reconnect it. |
| Javaw.exe process interfering                        | Use the task manager to end the javaw.exe process.  
  1. Press Ctrl + Alt + Delete.  
  2. Click Start Task Manager.  
  3. Click the Processes tab.  
  4. Select javaw.exe and click End Process.  
  If the process still won’t quit, unplug the USB cable from the cytometer, then plug it back in. |

The traffic light does not turn green

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
</table>
| USB cable not properly connecting the cytometer to the computer | 1. Make sure the USB cable is properly connected between the cytometer and computer. It may take several seconds for the port to recognize the cytometer.  
  2. If necessary, restart the computer.                        |
| Switch the USB cable to a different port on the computer. |                                                                                       |
### Software not responding

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
</table>
| USB flash drive plugged into same hub as cytometer, disrupting communication | Do not use a USB port on the same hub as the cytometer. For example, use USB ports on the front of the computer for external flash drives.  
- Disconnect the flash drive.  
- Disconnect either end of the USB cable between the cytometer and computer, then reconnect it. |
| Javaw.exe process interfering                        | Use the task manager to end the javaw.exe process.  
1. Press Ctrl + Alt + Delete.  
2. Click Start Task Manager.  
3. Click the Processes tab.  
4. Select javaw.exe and click End Process.  
If the process still won’t quit, unplug the USB cable from the cytometer, then plug it back in. |
| USB cable disconnected                              | Ensure the USB cable between the cytometer and the computer workstation is connected.                                                                    |

### Software appears to shut down but is still running in the background

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
</table>
| Javaw.exe process interfering                        | Use the task manager to end the javaw.exe process.  
1. Press Ctrl + Alt + Delete.  
2. Click Start Task Manager.  
3. Click the Processes tab.  
4. Select javaw.exe and click End Process.  
If the process still won’t quit, unplug the USB cable from the cytometer, then plug it back in. |
Acquisition troubleshooting

**Introduction**

This topic describes how to troubleshoot problems you encounter during acquisition, including the data displayed in the plots.

**Data does not look as expected**

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample needs to be restarted</td>
<td>Abort and restart run. Or, rerun sample at completion of run.</td>
</tr>
<tr>
<td>Fluidics dirty or clogged</td>
<td>1. Perform a backflush.</td>
</tr>
<tr>
<td></td>
<td>2. Perform a SIP clean.</td>
</tr>
<tr>
<td>Air bubbles in flow cell or in-line sheath filter</td>
<td>1. Perform a backflush.</td>
</tr>
<tr>
<td></td>
<td>2. Perform a SIP clean.</td>
</tr>
</tbody>
</table>

**Event rate drops during acquisition**

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cells settled in bottom of tube</td>
<td>Pause acquisition and mix the tube. If using a CSampler Plus, eject the rack and manually mix the tubes.</td>
</tr>
<tr>
<td>Fluidics dirty or clogged</td>
<td>1. Perform a backflush.</td>
</tr>
<tr>
<td></td>
<td>2. Perform a SIP clean.</td>
</tr>
<tr>
<td></td>
<td>3. If the problem persists, perform an extended flow cell clean cycle.</td>
</tr>
</tbody>
</table>
### Pumps are running normally, but data is not being acquired

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheath too low and/or waste too high</td>
<td>Check the levels in the sheath and waste bottles.</td>
</tr>
<tr>
<td>Fluidics lines crimped</td>
<td>Check all fluidics lines, at bottles, harness, and peristaltic pumps, to see if any are crimped.</td>
</tr>
<tr>
<td>SIP clogged</td>
<td>1. Perform a backflush.</td>
</tr>
<tr>
<td></td>
<td>2. Perform a SIP clean.</td>
</tr>
<tr>
<td></td>
<td>3. If the problem persists, contact BD Technical Support.</td>
</tr>
<tr>
<td>Peristaltic pump tubing not attached properly</td>
<td>Make sure peristaltic pump tubing and retainer clip are properly attached.</td>
</tr>
</tbody>
</table>

### Pumps are running continually

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air in the in-line sheath filter</td>
<td>• If the filter is less than 50% filled with fluid, replace it.</td>
</tr>
<tr>
<td></td>
<td>• If the filter contains an air pocket, perform a backflush, followed by a SIP clean.</td>
</tr>
<tr>
<td>Fluidics lines clogged</td>
<td>1. Perform a backflush.</td>
</tr>
<tr>
<td></td>
<td>2. Perform a SIP clean.</td>
</tr>
<tr>
<td>Peristaltic pump tubing damaged</td>
<td>Replace peristaltic pump tubing.</td>
</tr>
</tbody>
</table>
Auto-adjust volume settings procedure failed

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>System fluidics not clean</td>
<td>Perform a Clean Fluidics cycle, then repeat the procedure.</td>
</tr>
<tr>
<td>Sample type or volume incorrect</td>
<td>Repeat the procedure with a new sample. Make sure the tube did not run dry during the procedure.</td>
</tr>
<tr>
<td>Peristaltic pump tubing needs replaced</td>
<td>If after performing the solutions above, the procedure continues to fail, replace the peristaltic pump tubing and repeat the procedure.</td>
</tr>
</tbody>
</table>

QC troubleshooting

Introduction

This topic describes how to troubleshoot problems with instrument QC.

No beads were detected

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>No beads in sample</td>
<td>Make sure you are running the correct sample tube.</td>
</tr>
<tr>
<td>Beads not properly mixed</td>
<td>• Vortex bead vial before preparing bead suspension.</td>
</tr>
<tr>
<td></td>
<td>• Vortex bead suspension before running beads.</td>
</tr>
</tbody>
</table>
### QC result failed

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regions and/or markers not set correctly</td>
<td>Adjust regions and markers, as necessary. See Adjusting the bead regions and markers (page 53).</td>
</tr>
<tr>
<td>Expired beads</td>
<td>Check bead expiration date. If necessary, rerun QC with new beads.</td>
</tr>
<tr>
<td>Old bead suspension</td>
<td>Once prepared, beads are stable for 8 hours if stored at 2–8°C and protected from light. After this period, prepare a fresh bead suspension.</td>
</tr>
<tr>
<td>High CVs caused by bubbles</td>
<td>1. Perform a backflush.</td>
</tr>
<tr>
<td></td>
<td>2. Perform a SIP clean.</td>
</tr>
</tbody>
</table>

### QC messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event count for Mid + Bright too low</td>
<td>• Beads settled in bottom of tube. Resuspend the beads and rerun the sample.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the region is encompassing the mid + bright bead population in the FSC vs SSC plot. Adjust the region, if necessary.</td>
</tr>
<tr>
<td>Percentage of events for Mid + Bright too low</td>
<td>• Beads settled in bottom of tube. Resuspend the beads and rerun the sample.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the region is encompassing the mid + bright bead population in the FSC vs SSC plot. Adjust the region, if necessary.</td>
</tr>
<tr>
<td></td>
<td>• Beads are no longer stable. Prepare a fresh bead solution.</td>
</tr>
</tbody>
</table>
Chapter 11: Troubleshooting

Bright bead median and/or %rCV drift over time

As seen in the Levey-Jennings plots.

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage of events in FSC/SSC/FL1/FL2/FL3/FL4 Noise too low</td>
<td>Rerun the beads. If the message appears again, prepare a new bead suspension. Do not adjust the noise gates. If the problem persists, contact BD Technical Support.</td>
</tr>
<tr>
<td>Event count for FL1/FL2/FL3/FL4 Bright too low</td>
<td>Make sure the bead peak in the corresponding plot is located within the markers. Adjust the marker, if necessary. If the message still appears, prepare a new bead suspension.</td>
</tr>
<tr>
<td>Percentage of events in FL1/FL2/FL3/FL4 Bright too low</td>
<td>Make sure the bead peak in the corresponding plot is located within the markers. Adjust the marker, if necessary. If the message still appears, prepare a new bead suspension.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peristaltic pump tubing worn</td>
<td>Change the peristaltic pump tubing.</td>
</tr>
</tbody>
</table>
This chapter covers the following topics:

- Selectable lasers (page 236)
- Annotating selected laser configuration (page 238)
- Optical filter placement (page 240)
- Selectable laser application examples (page 243)
Selectable lasers

Introduction

This topic describes the Selectable Lasers Module option and how to install, validate, and configure the lasers and optical filters.

The Selectable Lasers upgrade requires prior installation of C6 Plus software or CSampler Plus software.

About selectable lasers

The detectors and lasers of the BD Accuri C6 Plus flow cytometer operate in a predefined standard configuration: FL1, FL2, and FL3 detect blue laser-excited fluorescence emissions and FL4 detects red laser-excited emissions. This configuration is referred to as 3 blue 1 red.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Detector</th>
<th>Laser emissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 blue 1 red</td>
<td>FL1, FL2, and FL3</td>
<td>blue laser-excited emissions</td>
</tr>
<tr>
<td></td>
<td>FL4</td>
<td>red laser-excited emissions</td>
</tr>
</tbody>
</table>

The Selectable Lasers Module allows you to operate the cytometer in two other configurations to significantly expand the fluorochrome combinations that can be analyzed. See Optical filter placement (page 240) for examples.

The two configurations include:

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Detector</th>
<th>Laser emissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 blue 2 red</td>
<td>FL1 and FL2</td>
<td>blue laser-excited emissions</td>
</tr>
<tr>
<td></td>
<td>FL3 and FL4</td>
<td>red laser-excited emissions</td>
</tr>
<tr>
<td>4 blue</td>
<td>FL1, FL2, FL3, FL4</td>
<td>blue-laser emissions</td>
</tr>
</tbody>
</table>

Components supplied

The standard optical filters supplied with the instrument are 533/30 nm (FL1), 585/40 nm (FL2), 670 LP nm (FL3), and 675/25 nm (FL4).
The Selectable Lasers option comes with the following:

- Selectable Lasers Activation Key (software)
- Three optical filters:
  - 780/60
  - 610/20
  - 630/30

**Before you begin**

- Perform instrument QC and ensure that it passes.

*Note:* For Instrument QC the laser configuration will automatically switch to 3 blue 1 red. Ensure that the standard optical filters are installed when running Instrument QC. When instrument QC is complete and you close the QC module, the system will switch back to the configuration that was previously selected, if different from 3 blue 1 red.

**Installing the Selectable Lasers Module**

1. Verify that C6 Plus software or CSampler Plus software is loaded on the computer.

2. Copy the Selectable Lasers Activation Key from the USB drive to the desktop.

3. Double-click on the **Selectable Lasers Activation Key** icon.

4. In the installation wizard, choose the correct directory to install the Activation Key.

   The location depends on where C6 Plus software or CSampler Plus software has been installed. In most cases, the location will be in one of the following places:

   - C:\Program Files\BD Accuri\BD Accuri C6 Plus\ActivationKeys
   - C:\Program Files\BD Accuri\BD CSampler Plus\ActivationKeys

   If you have both C6 Plus software and CSampler Plus software on the same computer, install the Selectable Lasers Activation Key twice: once in the C6 Plus software directory, and again in
the CSampler Plus software directory.

5. Click **Browse** to navigate to the correct location.

6. Click **Install**.

7. After installation, click **Close**.

8. Start C6 Plus software or CSampler Plus software. The Selectable Lasers controls are displayed next to the traffic light message.

9. Depending on the laser configuration you are going to use, you may need to replace the standard optical filters with one or more of the filters that are supplied with the Selectable Lasers Module.

More information
- Annotating selected laser configuration (page 238)
- Optical filter placement (page 240)
- Selectable laser application examples (page 243)

**Annotating selected laser configuration**

**Introduction**
This topic describes how to properly identify the data wells to indicate the laser configuration you are using.

**About the selected laser configuration**
The selectable laser buttons show the most recently selected configuration only. They do not change if you select another data well with a different configuration. Therefore, we recommend annotating your data wells in the sample naming field to indicate the laser configuration used during data collection of each well, especially when not using the default 3 blue 1 red option. (For
example, name a sample “HPB 4b” to indicate that the 4 blue option was selected during data collection.)

Laser configurations are not saved in the C6 Plus data file or with a C6 Plus template. Any previously saved C6 Plus file will default back to the 3 blue 1 red option when it is opened.

The last laser configuration used to collect a given well of data is written in the FCS file header using the custom keyword #LASERCONFIGURATION. FCS file headers can be viewed by opening an exported FCS file in a text editor (such as Microsoft Notepad).

More information

- Selectable lasers (page 236)
- Optical filter placement (page 240)
- Selectable laser application examples (page 243)
Optical filter placement

**Introduction**
This topic describes the different optical filter configurations.

**About filter placement**
Due to the unique optical layout of the cytometer, it is critical that any optional filters used with the Selectable Lasers Module are placed in the proper positions for optimal performance.

Always use the standard configuration (3 blue 1 red) when running instrument QC.

**Caution!** The 630/30 bandpass filter provided with the Selectable Lasers Kit should only be used when operating in the 4 blue configuration. Using the 630/30 filter when operating in any other configuration may damage the corresponding detector due to unfiltered red laser signal.

**Configurations**
Use the tables below as a guide to optical filter placement for various fluorochrome combinations.

### 3 blue 1 red: Configuration 1 (standard filters)

<table>
<thead>
<tr>
<th>Detector</th>
<th>Filter</th>
<th>Fluorochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL1</td>
<td>533/30</td>
<td>FITC, GFP, CFSE</td>
</tr>
<tr>
<td>FL2</td>
<td>585/40</td>
<td>PE, PI</td>
</tr>
<tr>
<td>FL3</td>
<td>670 LP</td>
<td>PerCP-Cy5.5, PE-Cy™5, PE-Cy7</td>
</tr>
<tr>
<td>FL4</td>
<td>675/25</td>
<td>APC, Alexa-647</td>
</tr>
</tbody>
</table>

### 3 blue 1 red: Configuration 2

<table>
<thead>
<tr>
<th>Detector</th>
<th>Filter</th>
<th>Fluorochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL1</td>
<td>533/30</td>
<td>FITC, GFP, CFSE</td>
</tr>
</tbody>
</table>
When operating in the 3 blue 1 red configuration, place either the 610/20 bandpass or the 670 LP filter in the FL3 position. For best results when analyzing PE and PE-Texas Red® (PE-TR) simultaneously, select the filters with the following signal-intensity considerations in mind:

- PE – bright, PE-TR-moderate to bright: FL3 = 670 LP
- PE – dim to moderate, PE-TR any level: FL3 = 610/20
- PE – bright, PE-TR dim: may be difficult to separate; consider using the 4 blue configuration with a 630/30 in FL4 to detect PE-TR.

### 2 blue 2 red Configuration

<table>
<thead>
<tr>
<th>Detector</th>
<th>Filter</th>
<th>Fluorochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL1</td>
<td>533/30</td>
<td>FITC, GFP, CFSE</td>
</tr>
<tr>
<td>FL2</td>
<td>585/40</td>
<td>PE, PI, PE-Texas Red</td>
</tr>
<tr>
<td>FL3</td>
<td>780/60</td>
<td>APC-Cy7</td>
</tr>
<tr>
<td>FL4</td>
<td>675/25</td>
<td>APC, Alexa-647</td>
</tr>
</tbody>
</table>

### 4 blue: Configuration 1

<table>
<thead>
<tr>
<th>Detector</th>
<th>Filter</th>
<th>Fluorochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL1</td>
<td>533/30</td>
<td>FITC, GFP, CFSE</td>
</tr>
<tr>
<td>FL2</td>
<td>585/40</td>
<td>PE, PI, PE-Texas Red</td>
</tr>
<tr>
<td>FL3</td>
<td>780/60</td>
<td>PE-Cy7</td>
</tr>
<tr>
<td>FL4</td>
<td>675/25</td>
<td>PerCP-Cy5.5, PE-Cy5</td>
</tr>
</tbody>
</table>
4 blue: Configuration 2

<table>
<thead>
<tr>
<th>Detector</th>
<th>Filter</th>
<th>Fluorochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL1</td>
<td>533/30</td>
<td>FITC, GFP, CFSE</td>
</tr>
<tr>
<td>FL2</td>
<td>585/40</td>
<td>PE</td>
</tr>
<tr>
<td>FL3</td>
<td>780/60</td>
<td>PE-Cy7</td>
</tr>
<tr>
<td>FL4</td>
<td>610/20</td>
<td>PI</td>
</tr>
<tr>
<td></td>
<td>630/30</td>
<td>PE-Texas Red</td>
</tr>
</tbody>
</table>

4 blue: Configuration 3

<table>
<thead>
<tr>
<th>Detector</th>
<th>Filter</th>
<th>Fluorochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL1</td>
<td>533/30</td>
<td>FITC, GFP, CFSE</td>
</tr>
<tr>
<td>FL2</td>
<td>585/40</td>
<td>PE</td>
</tr>
<tr>
<td>FL3</td>
<td>675/25</td>
<td>PerCP-Cy5.5, PE-Cy5</td>
</tr>
<tr>
<td>FL4</td>
<td>610/20</td>
<td>PI</td>
</tr>
<tr>
<td></td>
<td>630/30</td>
<td>PE-Texas Red</td>
</tr>
</tbody>
</table>

More information

- Selectable lasers (page 236)
- Annotating selected laser configuration (page 238)
- Selectable laser application examples (page 243)
Selectable laser application examples

Introduction

This topic provides examples of different selectable laser configurations.

Note: The following examples are from data collected on a BD Accuri™ C6 flow cytometer.

<table>
<thead>
<tr>
<th>2 blue 2 red configuration examples</th>
</tr>
</thead>
</table>

Configuration

<table>
<thead>
<tr>
<th>Detector</th>
<th>Filter</th>
<th>Fluorochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL1</td>
<td>533/30</td>
<td>FITC</td>
</tr>
<tr>
<td>FL2</td>
<td>585/40</td>
<td>PE</td>
</tr>
<tr>
<td>FL3</td>
<td>780/60</td>
<td>APC-Cy7</td>
</tr>
<tr>
<td>FL4</td>
<td>675/25</td>
<td>APC</td>
</tr>
</tbody>
</table>

Example 1: 2 blue 2 red

FITC, PE, APC and APC-Cy7: Human Peripheral Blood Subsets

The following images show the results for a 4-color analysis of CD3⁺CD4⁺ cells. Human peripheral blood was stained with CD3-APC-Cy7, CD4-APC, CD45RA-FITC, and CD45RO-PE.
Example 2: 2 blue 2 red
BD™ CBA Flex Set

The following images show the results from a BD Cytometric Bead Array (CBA) 30 Plex bead mixture.

![Unzoomed area](image1.png) ![Zoomed height](image2.png)

Example 1: 4 blue
FITC, PE, PE-Cy5, PE-Cy7: Human Peripheral Blood Subsets

<table>
<thead>
<tr>
<th>Detector</th>
<th>Filter</th>
<th>Fluorochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL1</td>
<td>533/30</td>
<td>FITC</td>
</tr>
<tr>
<td>FL2</td>
<td>585/40</td>
<td>PE</td>
</tr>
<tr>
<td>FL3</td>
<td>780/60</td>
<td>PE-Cy7</td>
</tr>
<tr>
<td>FL4</td>
<td>675/25</td>
<td>PE-Cy5</td>
</tr>
</tbody>
</table>

The following images show CD45-FITC vs SSC gating of lymphocytes. Human peripheral blood was stained with CD45-FITC, CD8-PE, CD3-PE-Cy5, and CD4-PE-Cy7.
Example 2: 4 blue
FITC, PE, PE-Cy5, PE-Texas Red: Human Peripheral Blood Subsets

<table>
<thead>
<tr>
<th>Detector</th>
<th>Filter</th>
<th>Fluorochrome</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL1</td>
<td>533/30</td>
<td>FITC</td>
</tr>
<tr>
<td>FL2</td>
<td>585/40</td>
<td>PE</td>
</tr>
<tr>
<td>FL3</td>
<td>675/25</td>
<td>PE-Cy5</td>
</tr>
<tr>
<td>FL4</td>
<td>630/30</td>
<td>PE-Texas Red</td>
</tr>
</tbody>
</table>

The following images show the results of human peripheral blood stained with CD45-FITC, CD4-PE, CD3-PE-Cy5, and CD8-PE-TexasRed. The color compensation value to correct the spillover of PE (FL2) into the PE-Texas Red (FL4) detector may be in the range of 70% to 90%.
More information

- Selectable lasers (page 236)
- Annotating selected laser configuration (page 238)
- Optical filter placement (page 240)
User Tracking Module

This chapter covers the following topics:

- Tracking user activity (page 250)
- Managing user accounts (page 253)
- Monitoring user activity (page 256)
## Tracking user activity

### Introduction
This topic describes how to install and start the User Tracking option.

### About user tracking
User tracking is an optional upgrade that allows laboratory administrators to track the activities of cytometer operators by assigning a user name and password to each individual. The user name and password are required to log into the software. The passwords are unrelated to any Windows passwords used on the host computer or network. You must be the administrator to use the user tracking features.

### Installing the User Tracking module
To install user tracking on your computer:

1. Copy the user tracking activation key (User Tracking Installer.exe) from the USB drive to the computer desktop.

2. Double-click the User Tracking Installer icon on the desktop.

3. In the installation wizard, select the correct directory to install the activation key.

   The location depends on where the C6 Plus software was installed. In most cases, the location is in one of two places:

   - `C:\Program Files\BD Accuri\BD Accuri C6 Plus\ActivationKeys`
   - `C:\Program Files\BD Accuri\BD CSampler Plus\ActivationKeys`
If necessary, use the browse button to navigate to the correct folder.

4. Click **Install**.

   The software displays a confirmation message after successful installation.
Signing in to the software

Once the tracking software is installed, users must now sign in each time they want to use the C6 Plus software. To use the tracking feature, sign in to the software as the administrator.

To sign in to the software:
1. Launch the software.
2. When the Sign In dialog is displayed, enter the user name and password provided to you during installation.
3. Click OK.
4. Use the software as usual.
5. To access the feature, select About > Users.

Signing out of the software

Be sure you sign out of the software when you are finished using it. If you do not sign out, software will continue to log your time.

To sign out of the software:
1. Select File > Quit.

More information
- Managing user accounts (page 253)
- Monitoring user activity (page 256)
Managing user accounts

Introduction
This topic describes how the administrator can add new users, delete existing users, and change the administrator password.

Adding user accounts
The Users menu option is only visible to the administrator, and only after the User Tracking software has been installed.

To add new user accounts:
1. Sign in as the administrator.
2. Select About > Users.
3. In the Users dialog, click Add New User.
4. Type a user name and password for the user in the blank fields.
5. Type any notes you want to add in the Notes field.
This information is only visible in the Users dialog and the userUsage log. See Monitoring user activity (page 256).

6. Click Save.

Deleting user accounts

You cannot delete the administrator account.

To delete a user account:
1. Select About > Users.
2. Click Delete next to the user account you want to remove.

3. Click Save.
Chapter 13: User Tracking Module

Changing a password

The administrator can change their password or any user password at any time.

Note: If you are the administrator changing your password, be sure you write down your new password and save it in a secure place.

To change a user password:
1. Select About > Users.
2. Delete the text in the Password field and type a new password.
3. Click Save.

Restoring an administrator password

The password file is encrypted and contains all user name and password information created in the User Logging feature. If you forget your administrator password, you can delete the password file and recreate your administrator account.

Caution! This procedure deletes all user names and passwords; you must manually recreate each account.

To restore the administrator password:
1. If the C6 Plus software is running, exit the software.
2. Navigate to C:\Cytometer Support Files.
3. Locate the Password file and delete the file.
4. See Signing in to the software (page 252) and Adding user accounts (page 253) for information about logging in and creating a new user account.

The administrator user name and password will revert back to their default settings.

More information

- Tracking user activity (page 250)
- Monitoring user activity (page 256)
Monitoring user activity

Introduction
This topic describes how the administrator can monitor user activity using the userUsage log.

About the userUsage log
Each time a user signs into or out of the software, an entry is made in the userUsage Log. The userUsage log is a CSV file that you can open using Microsoft Excel or similar spreadsheet program.

The userUsage log contains the following information:

- Date and time of a sign in/sign out
- Username of the operator
- Serial number of the cytometer
- Type of activity (sign in or sign out)
- Notes entered in the User dialog when the user was added
To view the userUsage log:

1. Navigate to the C:\Cytometer Support Files folder and open the folder.

2. Locate userUsage.csv and double-click it to open it.

More information

- Tracking user activity (page 250)
- Managing user accounts (page 253)
This chapter covers the following topics:

- Remote Interfacing (page 260)
- Implemented commands (page 262)
- Example usage of remote interfacing commands (page 265)
Remote Interfacing

**Introduction**
This topic describes the Remote Interfacing Module option and how to install and use it.

**About the Remote Interfacing Module**
The Remote Interfacing Module is an optional module that enables the BD Accuri C6 Plus software and BD CSampler Plus software to receive commands from other software applications via a TCP/IP connection. Remote Interfacing is designed for advanced users only.

Once in remote interfacing mode, BD Accuri C6 Plus software listens through the TCP/IP connection to the XML formatted commands. Most of these commands execute the same functionality that you would manually initiate by choosing a menu item or a button. See Example usage of remote interfacing commands (page 265) for an example.

**Note:** The remote interfacing capability is an optional add-on feature that requires an installed activation key.

**Installing the Remote Interfacing Module**

To install the Remote Interfacing Module:

1. Copy the remote interfacing activation key (Remote Interfacing Installer.exe) from the USB drive to the computer desktop.

2. Double-click the **Remote Interfacing Installer** icon on the desktop.

3. In the installation wizard, select the correct directory to install the activation key.

   The location depends on where the C6 Plus software was installed. In most cases, the location is in one of two places:

   - `C:\Program Files\BD Accuri\BD Accuri C6 Plus\ActivationKeys`
   - `C:\Program Files\BD Accuri\BD CSampler Plus\ActivationKeys`
If necessary, use the browse button to navigate to the correct folder.

4. Click **Install**.

The software displays a confirmation message after successful installation.

---

### Setting up remote interfacing

To set up remote interfacing:

1. From BD Accuri C6 Plus software or BD CSampler Plus software, select **Instrument > Remote Interfacing Module**. The C6 software opens a Remote Control dialog box.

   The Remote Control dialog box displays a connection string, which might be needed by the application controlling the C6 Plus or CSampler Plus software. This connection string is the computer’s IP address with the port number on which the software will set up a connection and listen for commands.

2. Follow the connection procedure of the third-party software application that will control the C6 Plus or CSampler Plus software.

   **Note:** C6 Plus or CSampler software does not queue commands. The software ignores commands sent to it while it is busy completing the previous command. Some commands begin a process that continues even after the software finishes the command, for example, `<CollectSample/>`.

---

### Confirming remote connection

To confirm that C6 Plus software or CSampler Plus software is connected to the third-party application:

1. Select **Instrument > Remote Interfacing Module**. The Remote Interfacing dialog box appears displaying a connection string to C6 Plus software or CSampler Plus software (for example, 192.168.0.170:9876). The IP address precedes a colon and the port number.

2. Use a Telnet client to connect to C6 Plus software or CSampler Plus software with the connection string. When the connection is successful, C6 Plus or CSampler Plus software responds with
3. Enter a command such as &lt;ChangeWell wellCode="B1"/&gt;.

### Implemented commands

**Introduction**
This section describes the available remote interfacing commands to C6 Plus or CSampler Plus software and the return values from the software.

**Commands**

**&lt;AutomaticWellAdvance/&gt;**

<table>
<thead>
<tr>
<th>Description</th>
<th>After this command has been sent, whenever the cytometer is collecting and the 1 million event limit is reached, collection will spill over into the next well without loss of data. Close the current C6 Plus software session and reopen the software to exit this mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>&lt;OK/&gt;</td>
</tr>
</tbody>
</table>

**&lt;ChangeWell wellCode="A1"/&gt;**

<table>
<thead>
<tr>
<th>Description</th>
<th>Changes the currently selected well to the well indicated in the command.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>&lt;OK/&gt;</td>
</tr>
</tbody>
</table>

**Possible Error Messages**
&lt;Error&gt;Well does not exist.&lt;/Error&gt;
&lt;Error&gt;Cannot change well while collecting.&lt;/Error&gt;

**&lt;CollectSample/&gt;**

<table>
<thead>
<tr>
<th>Description</th>
<th>Collects data in the currently selected well.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>&lt;OK/&gt;</td>
</tr>
</tbody>
</table>

**Possible Error Messages**
&lt;Error&gt;The software is currently busy.&lt;/Error&gt;
(Software is busy during backflushing and cleaning.)
### `<NewWorkspace/>`

<table>
<thead>
<tr>
<th>Description</th>
<th>Opens a new software workspace.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Return</strong></td>
<td><code>&lt;OK/&gt;</code></td>
</tr>
<tr>
<td><strong>Possible Error Messages</strong></td>
<td><code>&lt;Error&gt;</code>The software is currently busy. <code>&lt;Error&gt;</code> (Occurs during acquisition.)</td>
</tr>
</tbody>
</table>

### `<ExportAllAsFCS path="C:\NewDirectory"/>`

<table>
<thead>
<tr>
<th>Description</th>
<th>Exports all FCS files to the specified location. (This command only requires a file location. The file name is generated by BD Accuri C6 Plus software.)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Return</strong></td>
<td><code>&lt;OK/&gt;</code></td>
</tr>
<tr>
<td><strong>Possible Error Messages</strong></td>
<td><code>&lt;Error&gt;</code>The software is currently busy. <code>&lt;Error&gt;</code> (Occurs during acquisition.)</td>
</tr>
<tr>
<td></td>
<td><code>&lt;Error&gt;</code>Files did not save. <code>&lt;Error&gt;</code> (Occurs if specified root location does not exist; however, if folder does not exist, it will be created.)</td>
</tr>
</tbody>
</table>

### `<OpenWorkspace path="C:\NewDirectory\Filename"/>`

<table>
<thead>
<tr>
<th>Description</th>
<th>Opens a new software workspace (requires both a file location and a file name).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Return</strong></td>
<td><code>&lt;OK/&gt;</code></td>
</tr>
<tr>
<td><strong>Possible Error Messages</strong></td>
<td><code>&lt;Error&gt;</code>The software is currently busy. <code>&lt;Error&gt;</code> (Occurs during acquisition.)</td>
</tr>
<tr>
<td></td>
<td><code>&lt;Error&gt;</code>File did not open. <code>&lt;Error&gt;</code> (Occurs if specified file name/location does not exist)</td>
</tr>
<tr>
<td></td>
<td><code>&lt;Error&gt;</code>File name location does not exist. <code>&lt;Error&gt;</code></td>
</tr>
<tr>
<td></td>
<td><code>&lt;Error&gt;</code>File format not supported. <code>&lt;Error&gt;</code></td>
</tr>
<tr>
<td></td>
<td><code>&lt;Error&gt;</code>Successfully loaded the event data from your file, however there were problems loading your analysis. <code>&lt;Error&gt;</code></td>
</tr>
</tbody>
</table>
**<Pause/>**

<table>
<thead>
<tr>
<th>Description</th>
<th>Pauses acquisition in the currently selected well.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>&lt;OK/&gt;</td>
</tr>
<tr>
<td>Possible Error Messages</td>
<td>&lt;Error&gt;The software is currently busy.&lt;Error&gt; (Software is busy during backflushing and cleaning.)</td>
</tr>
</tbody>
</table>

**<ReportStatus/>**

<table>
<thead>
<tr>
<th>Description</th>
<th>Whenever this command is sent, C6 Plus or CSampler Plus software returns a snapshot of the status at the time the status was requested. This status includes the current time, hardware status, total event count, and the status message.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>&lt;Status&gt;&lt;Time&gt;14:28:22.640&lt;/Time&gt;&lt;HardwareStatus&gt;Running&lt;/HardwareStatus&gt;&lt;TotalEventCount&gt;445785&lt;/TotalEventCount&gt;&lt;UserMessage&gt;Events are being recorded.&lt;/UserMessage&gt;&lt;/Status&gt;</td>
</tr>
</tbody>
</table>

**<SaveFile path="C:\NewDirectory\Filename"/>**

<table>
<thead>
<tr>
<th>Description</th>
<th>Saves the file to the specified location and name. This command requires both a file location and file name. The extension must be included in the file name. To save the file as a template, the extension is .cit, to save as a C6 Plus software or CSampler Plus software workspace file, the extension is .ci.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return</td>
<td>&lt;OK/&gt;</td>
</tr>
<tr>
<td>Possible Error Messages</td>
<td>&lt;Error&gt;The software is currently busy.&lt;Error&gt; (Occurs during acquisition.)&lt;Error&gt;File did not save.&lt;Error&gt; (Occurs if you do not enter a file location and name.)</td>
</tr>
</tbody>
</table>
**Example usage of remote interfacing commands**

**Introduction**
This topic provides an example of remote interfacing commands and responses.

**Example**
For each command sent, a response is sent back.

<table>
<thead>
<tr>
<th>Command</th>
<th>Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Connected/&gt;</td>
<td>&lt;OK/&gt;</td>
</tr>
<tr>
<td>&lt;OpenWorkspace path=&quot;C:\ExampleFolder\Examplefile.ci&quot;/&gt;</td>
<td>&lt;OK/&gt;</td>
</tr>
<tr>
<td>&lt;AutomaticWellAdvance/&gt;</td>
<td>&lt;OK/&gt;</td>
</tr>
<tr>
<td>&lt;CollectSample/&gt;</td>
<td>&lt;OK/&gt;</td>
</tr>
<tr>
<td>&lt;ReportStatus/&gt;</td>
<td>&lt;Status&gt; &lt;Time&gt;09:28:06.488&lt;/Time&gt; &lt;HardwareStatus&gt;Running&lt;/HardwareStatus&gt; &lt;TotalEventCount&gt;180223&lt;/TotalEventCount&gt; &lt;UserMessage&gt;Events are being recorded.&lt;/UserMessage&gt; &lt;/Status&gt;</td>
</tr>
<tr>
<td>Continue using the &lt;ReportStatus/&gt; command until you reach 2,400,000 events. &lt;Pause/&gt;</td>
<td>&lt;OK/&gt;</td>
</tr>
<tr>
<td>&lt;SaveFile path=&quot;C:\NewDirectory\NewFilename.ci&quot;/&gt;</td>
<td>&lt;OK/&gt;</td>
</tr>
</tbody>
</table>
This chapter covers the following topics:

- FCS keywords (page 268)
## FCS keywords

### Introduction

The following tables list the standard and custom keywords used in FCS files generated by BD Accuri C6 Plus software and BD CSampler Plus software.

### Standard keywords

The following table describes the FCS keywords found in FCS files that are exported by BD Accuri C6 Plus software and BD CSampler Plus software.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$FIL</td>
<td>Filename including FCS extension.</td>
</tr>
<tr>
<td>$WELLID</td>
<td>Three-character string representing sample identifier.</td>
</tr>
<tr>
<td>$SMNO</td>
<td>Sample name.</td>
</tr>
<tr>
<td>$DATATYPE</td>
<td>The data type of the actual values for each event. It is always “I” for unsigned binary integers.</td>
</tr>
<tr>
<td>$MODE</td>
<td>The mode of the data. It is always “L” for list mode where the data is in the order described by the $Pn keywords.</td>
</tr>
<tr>
<td>$BYTEORD</td>
<td>Order in which data bytes are written, least to most significant. It is always 4,3,2,1.</td>
</tr>
<tr>
<td>$NEXTDATA</td>
<td>The byte offset for an additional data set in the file. BD C6 Plus files always specify 0 since the files only contain 1 data set.</td>
</tr>
<tr>
<td>$PAR</td>
<td>Total number of parameters stored in the data set. All data sets have 14 parameters.</td>
</tr>
<tr>
<td>$PnB</td>
<td>For parameter n, the number of bits for each binary value. The number is always 32 since integers are stored in 32 bits in Java®.</td>
</tr>
<tr>
<td>$PnR</td>
<td>The range of parameter n. The range for all parameters is always 16777216.</td>
</tr>
</tbody>
</table>
### Keyword Description

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$PnN</td>
<td>The name of parameter n. Parameters are the default values from the software.</td>
</tr>
<tr>
<td>$PnE</td>
<td>For parameter n, this denotes if linear or logarithmic amplifiers are used. It is always 0,0 because linear values for data are always saved. This is an optional tag.</td>
</tr>
<tr>
<td>$PnS</td>
<td>The name of the fluorescence stain used for parameter n. This tag is used for the custom parameter name.</td>
</tr>
<tr>
<td>$TOT</td>
<td>Number of objects stored in the data list. The cumulative event total for the sample.</td>
</tr>
<tr>
<td>$DATE</td>
<td>The date the represented sample was last acquired into DD-MMMYYYY.</td>
</tr>
<tr>
<td>$CYT</td>
<td>The name of the cytometer used for the measurement. It is always BD Accuri C6 Plus flow cytometer.</td>
</tr>
<tr>
<td>$CYTSN</td>
<td>The serial number of the cytometer used for the measurement.</td>
</tr>
<tr>
<td>$SPILLOVER</td>
<td>The standard tag for color compensation. Refer to the FCS 3.1 specs for a description of the format.</td>
</tr>
<tr>
<td>$TIMESTEP</td>
<td>Hard-coded value of 0.1, which is in seconds.</td>
</tr>
<tr>
<td>$PROJ</td>
<td>Represents the name of the workspace, which is also the name of the .ci file (before the .ci extension). If exporting an FCS file, this value is the name of the file before the FCS extension.</td>
</tr>
<tr>
<td>$BTIM</td>
<td>The beginning time of acquisition of the first event.</td>
</tr>
<tr>
<td>$ETIM</td>
<td>The end time of acquisition of the last event.</td>
</tr>
<tr>
<td>$VOL</td>
<td>Total volume in nanoliters.</td>
</tr>
</tbody>
</table>
Custom keywords

The following table describes custom keywords found in FCS files that are exported by C6 Plus software and CSampler Plus software. Custom keywords are not required as part of the FCS 3.1 standard.

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#BDACCURIDECADESn</td>
<td>The number of decades for parameter n. It is always 7.224719870049579.</td>
</tr>
<tr>
<td>#BDACCURICAPTUREDDATE</td>
<td>The date of the most recent acquisition of the represented sample, expressed in milliseconds as a thirteen-character string with leading zeros.</td>
</tr>
</tbody>
</table>

### Custom keywords

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$BEGINSTEXT</td>
<td>Default FCS 3.1 tag to mark the beginning of the text section.</td>
</tr>
<tr>
<td>$ENDSTEXT</td>
<td>Default FCS 3.1 tag to mark the end of the text section.</td>
</tr>
<tr>
<td>$BEGINANALYSIS</td>
<td>Default FCS 3.1 tag to mark the beginning of the analysis section. Always 0.</td>
</tr>
<tr>
<td>$ENDANALYSIS</td>
<td>Default FCS 3.1 tag to mark the end of the analysis section. Always 0.</td>
</tr>
<tr>
<td>$BEGINDATA</td>
<td>Default FCS 3.1 tag to mark the beginning of the data section.</td>
</tr>
<tr>
<td>$ENDDATA</td>
<td>Default FCS 3.1 tag to mark the end of the data section.</td>
</tr>
<tr>
<td>$TR</td>
<td>The primary threshold name and value, separated by a comma.</td>
</tr>
<tr>
<td>$PnL</td>
<td>Describes the wavelength at which to operate the parameter’s detector.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>#ACQUISITIONTIMEMILLI</td>
<td>The cumulative run data’s acquisition time in milliseconds.</td>
</tr>
<tr>
<td>#PnVirtualGain</td>
<td>The VirtualGain set for parameter n, where 1.0 means no VirtualGain.</td>
</tr>
<tr>
<td>#SECONDARYTHRESHOLD</td>
<td>The secondary threshold name and value, separated by a comma.</td>
</tr>
<tr>
<td>#SAMPLE</td>
<td>Value is either the well code or the sample rename (if one exists).</td>
</tr>
<tr>
<td>#ATIM</td>
<td>Cumulative acquisition time.</td>
</tr>
<tr>
<td>#SPACERS</td>
<td>Used to pad the text, analysis, and data sections of the FCS file. It is</td>
</tr>
<tr>
<td></td>
<td>not read and contains no meaningful data.</td>
</tr>
<tr>
<td>#SoftwareVersion</td>
<td>A string consisting of SoftwareFCSName, a space, and software version.</td>
</tr>
<tr>
<td>#PnMaxUsefulDataChannel</td>
<td>Only applies when FCS file is exported. Data value for parameter n that is</td>
</tr>
<tr>
<td></td>
<td>the 95th percentile.</td>
</tr>
<tr>
<td>#PnDetectorName</td>
<td>Name of parameter’s detector.</td>
</tr>
<tr>
<td>#PnDimension</td>
<td>AREA or HEIGHT, depending on which attribute was measured.</td>
</tr>
<tr>
<td>#PnIsFluorescent</td>
<td>True/False value indicating whether or not parameter measures fluorescent</td>
</tr>
<tr>
<td></td>
<td>light.</td>
</tr>
<tr>
<td>#PnDetectorNumber</td>
<td>Describes the identifying number of parameter’s detector.</td>
</tr>
<tr>
<td>#LASERCONFIGURATION</td>
<td>Represents the sample’s laser settings.</td>
</tr>
</tbody>
</table>
This chapter covers the following topics:

- System specifications (page 274)
# System specifications

**Introduction**

This topic describes the system specification.

## Cytometer specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimensions</strong></td>
<td></td>
</tr>
<tr>
<td>Height:</td>
<td>27.9 cm (11 in.)</td>
</tr>
<tr>
<td>Width:</td>
<td>37.5 cm (14.8 in.)</td>
</tr>
<tr>
<td>Depth:</td>
<td>41.9 cm (16.5 in.)</td>
</tr>
<tr>
<td><strong>With fluid bottles:</strong></td>
<td></td>
</tr>
<tr>
<td>Height:</td>
<td>27.9 cm (11 in.)</td>
</tr>
<tr>
<td>Width:</td>
<td>54.6 cm (21.5 in.)</td>
</tr>
<tr>
<td>Depth:</td>
<td>41.9 cm (16.5 in.)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>13.6 kg (30 lb)</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td></td>
</tr>
<tr>
<td>Power input requirement:</td>
<td>100–240 VAC, 50/60 Hz</td>
</tr>
<tr>
<td>Power supply output:</td>
<td>12 VDC, 11.5 A</td>
</tr>
<tr>
<td>Cytometer power:</td>
<td>12 VDC, 120 W (Max)</td>
</tr>
<tr>
<td><strong>Heat output</strong></td>
<td>240 BTU/hr maximum output</td>
</tr>
<tr>
<td><strong>Operating temperature/humidity</strong></td>
<td>15–30°C; 15–80% relative humidity</td>
</tr>
<tr>
<td><strong>Laser excitation</strong></td>
<td>488 nm</td>
</tr>
<tr>
<td></td>
<td>640 nm</td>
</tr>
<tr>
<td><strong>Laser profile</strong></td>
<td>Blue laser beam: 9 x 94 µm</td>
</tr>
<tr>
<td></td>
<td>Red laser beam: 11 x 104 µm</td>
</tr>
<tr>
<td><strong>Laser power</strong></td>
<td>488 nm solid-state blue laser: 20 mW</td>
</tr>
<tr>
<td></td>
<td>640 nm diode red laser: 12.5 mW</td>
</tr>
</tbody>
</table>
### Chapter 16: Technical specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Emission detection</strong></td>
<td>4 colors, standard optical filters</td>
</tr>
<tr>
<td></td>
<td>• FL1 533/30 nm</td>
</tr>
<tr>
<td></td>
<td>• FL2 585/40 nm</td>
</tr>
<tr>
<td></td>
<td>• FL3 &gt;670 nm</td>
</tr>
<tr>
<td></td>
<td>• FL4 675/25 nm</td>
</tr>
<tr>
<td><strong>Optical alignment</strong></td>
<td>Fixed alignment</td>
</tr>
<tr>
<td><strong>Flow cell</strong></td>
<td>200-µm ID quartz capillary</td>
</tr>
<tr>
<td><strong>Minimum detectable particle size</strong></td>
<td>0.5 µm</td>
</tr>
<tr>
<td><strong>Minimum sample volume</strong></td>
<td>50 µL (12 x 75-mm tubes)</td>
</tr>
<tr>
<td></td>
<td>150 µL (BD Trucount tubes)</td>
</tr>
<tr>
<td></td>
<td>100 µL (CSampler Plus, 12 x 75-mm tubes)</td>
</tr>
<tr>
<td><strong>Flow rate</strong></td>
<td>14–66 µL/min, depending on the test</td>
</tr>
<tr>
<td><strong>Maximum events/sample</strong></td>
<td>1 million events</td>
</tr>
<tr>
<td><strong>Fluorescence sensitivity MESF</strong></td>
<td>FITC &lt;75</td>
</tr>
<tr>
<td></td>
<td>PE &lt;50</td>
</tr>
<tr>
<td><strong>Fluorescence linearity</strong></td>
<td>2 ±0.05% for chicken erythrocyte nuclei (CEN)</td>
</tr>
<tr>
<td><strong>Fluorescence precision</strong></td>
<td>≤3% CV for CEN</td>
</tr>
<tr>
<td><strong>Data acquisition rate</strong></td>
<td>10,000 events/s, maximum</td>
</tr>
<tr>
<td><strong>Fluid bottle capacity</strong></td>
<td>2 L sheath, 2 L waste</td>
</tr>
<tr>
<td></td>
<td>250 mL BD FACSClean</td>
</tr>
<tr>
<td></td>
<td>250 mL Detergent Solution</td>
</tr>
</tbody>
</table>
## Computer specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Signal processing</strong></td>
<td>24-bit datapath</td>
</tr>
<tr>
<td><strong>Computer interface</strong></td>
<td>USB 2.0 or higher</td>
</tr>
<tr>
<td></td>
<td>* MESF values determined using Thermo Scientific Cyto-Cal™ Multifluor Plus Violet Beads.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td>PC desktop workstation with removable SD card</td>
</tr>
<tr>
<td><strong>Dimensions (without stand)</strong></td>
<td>Height: 38.1 cm (15 in.)&lt;br&gt;Width: 56.8 cm (22.3 in.)&lt;br&gt;Depth: 6.0 cm (2.4 in.)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>9.1 kg (20.1 lb)</td>
</tr>
<tr>
<td><strong>Processor</strong></td>
<td>64-bit multi-core processor</td>
</tr>
<tr>
<td><strong>Operating system</strong></td>
<td>Microsoft Windows® 7</td>
</tr>
<tr>
<td><strong>Software</strong></td>
<td>Windows 7 Professional and BD Accuri C6 Plus software or BD CSampler Plus software</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>26 GB free hard disk space after operating system and software application installation</td>
</tr>
<tr>
<td><strong>RAM</strong></td>
<td>8 GB</td>
</tr>
<tr>
<td><strong>USB ports</strong></td>
<td>USB 3.0 - 2 side/4 rear&lt;br&gt;USB 2.0 - 2 rear</td>
</tr>
<tr>
<td><strong>Accessories</strong></td>
<td>Windows-ready mouse and keyboard</td>
</tr>
</tbody>
</table>
## Optional CSampler Plus

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
</table>
| **Dimensions**  | Length: 50.8 cm (20 in.)  
                    Width: 35.6 cm (14 in.)  
                    Height: 20.3 cm (8 in.) |
| **Weight**      | 3.63 kg (8 lb)                                                               |
| **Connection**  | Serial                                                                        |
| **Tray**        | Includes three fixed tube locations for cleaning solutions                     |
| **Compatible racks** | Custom 24-tube capacity                                                      |
| **Compatible plates** | • 96-well U-bottom  
                        • 96-well flat bottom  
                        • 96-well V-bottom  
                        • 96 deep well  
                        • 48 well              |
The optional 2D barcode reader, a Motorola® DS6707-HC handheld imager, connects to computer through a USB connection, and reads the following barcode standards.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standards</td>
<td>• Code 39</td>
</tr>
<tr>
<td></td>
<td>• Codabar</td>
</tr>
<tr>
<td></td>
<td>• Code 128</td>
</tr>
<tr>
<td></td>
<td>• Interleaved 2 or 5</td>
</tr>
<tr>
<td></td>
<td>• Universal Product Code (UPC)</td>
</tr>
<tr>
<td></td>
<td>• Maxicode</td>
</tr>
<tr>
<td></td>
<td>• DataMatrix</td>
</tr>
<tr>
<td></td>
<td>• PDF417</td>
</tr>
</tbody>
</table>
A
acquisition
  auto collect  112–115
  collecting precise volumes  214–217
  CSampler Plus  93–96
  manual  81–83
  parameters, setting  72
  troubleshooting  229
  workflow, auto collect  102
  workflow, CSampler Plus  92
  workflow, manual  72
adjusting
  height of sample stage  23
  peak position with VirtualGain  134
  QC markers  54–56
  sample stream core  76
  volume settings  215
agitating samples  96, 108
analysis
  batch  142–144
  sample data file  123
  setting up plots  124–125
  statistics  130
  using VirtualGain  135–140
  viewing data  125
auto-adjust volume settings  215
auto-saving data  186

B
backflushing SIP  197
bar code reader  14, 278
batch analysis  142–144
BD Accuri C6 Plus system
  See also cytometer
    overview  14, 16–22
BD FACS
  clean  21
  bottle  21
  filling  38
beads
  See CS&T RUO beads
  bottle
    BD FACS
      clean  21
      detergent solution  21
      filling  38
      filters, replacing  203–204
      sheath  21
      waste  21
C
C6 Plus system
  See also cytometer
    overview  14, 16–22
Clean Fluidics cycle  200
cleaning
  backflushing SIP  197
  Clean Fluidics cycle  200
  extended flow cell clean  200–201
  outside of instrument  196
  sample stage  43
  SIP clean  198–199
tubes, in CSampler Plus rack  26
color gating 172–174
compensation
  adjusting 149–153
  controls 147
  preferences 148
computer
  overview 15
  specifications 276
connector
  CSampler Plus 18
  power 18
CS&T RUO beads
  deleting old lots 185
  installing new lot 51
  running 49–51
CSampler Plus
  aligning after collision 217–218
  cleaning tube locations 26
  connector 18
  loading rack 25
  overview 24–27
  specifications 277
tips for use 27
cytometer
  See also maintenance
event indicator 17
fluid bottles 21
fluidics components 20–22
lasers 20
optical components 19
optical filters 20
overview 14, 16–22
pumps 22
restarting after storage 219
sample stage 17
shutdown 43–45
SIP 17, 22
specifications 274–276
startup 41–42
startup workflow 36

cytometer power
  button 17
  connector 18
  indicator 17
D
daily
  maintenance 194
  QC workflow 48
  shutdown 43–45
  startup 41–42
  startup workflow 36
data
  acquisition, auto collect 112–115
  acquisition, CSampler Plus 93–96
  acquisition, manual 81–83
  adding more to files 83, 96
  manually saving 187
detergent solution
  bottle 21
  filling 38
downloading CS&T RUO bead lot 51
E
eventing waste 39
enlarging plots 56
entering CS&T RUO bead lot 51
event indicator 17
exporting
data 190
  from batch analysis tab 145
extended flow cell clean 200–201
F
FACSClean
  bottle 21
  filling 38
files
  exporting 190
importing 191
managing 184–185
sample analysis file 123
saving 187
workspace 186–188
filter
fluid bottle, replacing 203–204
in-line sheath 22, 204–206
optical 20
fluid bottles
emptying waste 39
filling 38
fluid sensing line 204
overview 21
replacing filters 203–204
fluidics
cleaning 200
components, overview 20–22
harness 18
tubing, replacing 206–209
fluidics rate
customizing 76
setting 75
fluids required 37
fluorescence spillover
See also compensation
about 146–147
correcting 149–153
G

gates
See also regions
applying to plot 164
color gating 172–174
creating 161
deleting 164
live 166
nested 168–170
types 160–164
H
histogram overlay 127–129
I
importing data 191
indicator
event 17
power 17
in-line sheath filter
overview 22
replacing 204–206
installing
CS&T RUO bead lot 51
sample tube 22
selectable lasers module 237
user tracking module 250
K
keywords
custom 270
standard 268
L
lasers 20
Levey-Jennings report
printing 65
viewing 63
live gates 166
loading
24-tube rack 25
sample tube 22
M
maintenance
See also cleaning
aligning CSampler Plus 217–218
Clean Fluidics cycle 200
daily 194
extended flow cell clean  200–201
replacing fluid bottle filters  203–204
replacing in-line sheath filter  204–206
replacing pump tubing  206–209
scheduled  194–195
SIP clean  198–199
unclogging SIP  211–214
unscheduled  195
wiping instrument  196
managing user accounts  See user tracking module

O
optical  
  components  19
  filters  20
  selectable lasers filters  236
overview
  CSampler Plus  24–27
  cytometer  16–22
  fluid bottles  21
  QC  48
  software  28–34

P
parameters, changing plot  176
PC  
  overview  15
  specifications  276
plot tools  156
plots  
  changing number of events  175
  changing parameter  176
  copying and printing  181
  creating new  127, 157
  format for drag/drop  181
  histogram overlay  127–129
  printing  182
QC  59
  renaming  160
  renaming axes  177
  setting up for analysis  124–125
  specifications, changing  158
  viewing data in  125
  zooming  56, 179
  zooming in  177
port, USB  18
power  
  button  17
  connector  18
  indicator  17
printing  
  Levey-Jennings report  65
  plots  182
  QC report  62
  statistics  182
pump  
  sheath  22
  tubing, replacing  206–209
  waste  22

Q
QC  
  failed result  57
  messages  60
  module  48
  overview  48
  results  58–61
  running  49–51
  troubleshooting  231
  workflow  48
QC report  
  adding comments  61
  adjusting markers  54–56
  deleting from history list  184
  plots  59
  printing  62
  results table  59
viewing previous 61
zooming plots 56

R
rack
  loading 25
map 26
specifications 24
reagents 15
regions
  adjusting QC 54–56
  coloring 172–174
  moving/resizing 171
  renaming 174
replacing
  fluid bottle filters 203–204
  in-line sheath filter 204–206
  peristaltic pump tubing 206–209
report
  Levey-Jennings 63
  QC 58–61
results
  QC 58–61
run direction, setting 109
run limits, setting 73–74

S
sample analysis file 123
sample injection probe
  See SIP
sample sets
  creating for auto collect 103–105
sample stage
  adjusting height 23
  cleaning 43
  loading tubes 22
  overview 17
sample stream
  adjusting core size 76
sample tube
  loading 22
  specifications 15
saving
  workspace files 187
selectable lasers
  about 236
  annotating files 238
  application examples 243–246
  components 236
  configurations 240
  installing 237
  proper filter placement 240
setting
  acquisition parameters 72
  fluidics rate 75
  run direction 109
  run limits 73–74
  threshold 80
sheath
  bottle 21
  filling 38
  filter, in-line 22, 204–206
  pump 22
shutting down 43–45
SIP 17, 22
  backflushing 197
  clean cycle 198–199
  unclogging 211–214
software
  overview 28–34
  troubleshooting 227
starting up 36, 41–42
statistics
  master table 131
  previewing plots in tab 132
  tab 130
stopping criteria, setting 73–74
T
  template, workspace 189
  threshold
    about 79
    setting 80
  troubleshooting
    acquisition 229
    hardware 222
    QC 231
    software 227
  tube rack
    loading 25
    map 26
    specifications 24
  tubes
    loading 22
    specifications 15
  tubing, replacing 206–209

U
  USB port 18
  user tracking module
    installing 250
    managing user accounts 253
    monitoring user activity 256
    signing in 252

V
  VirtualGain
    applying 135–140
    changing views 141
    purpose 134
    removing 142
    viewing 140

W
  waste
    bottle 21
    emptying 39
    pump 22
  workflow
    auto collect 102
    CSampler Plus acquisition 92
    manual acquisition 72
    QC 48
    startup 36
  workspace
    C6 Plus 29–30
    creating templates 189
    CSampler Plus 30–31
    files 186–188
    opening new 188
  workstation
    overview 15
    specifications 276

Z
  zooming plots 56, 179